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Highlights  
New easy ways to put GIS data, maps, and applications on the Web  

ArcGIS Server 9.3 provides an innovative new ArcGIS JavaScript™ API that makes it easy to add your maps to web 
pages or develop complete web applications. You can easily combine your maps, data, and geoprocessing services 
with others like the ArcGIS Online Services basemaps. ArcGIS JavaScript extensions allow you to mashup your 
content with Google Maps™ and Microsoft® Virtual Earth™. A new ArcGIS API for Adobe® Flex™ lets you create web 
applications with rich, dynamic user interfaces. The new, open REST API enables web development in additional 
environments such as Microsoft Silverlight™. These freely available ArcGIS APIs let you unleash a new generation of 
web-based GIS incorporating trusted GIS content, popular web basemaps, and professional grade GIS analysis. 
 

Easier to serve high performance web map services 
ArcGIS Server 9.3 makes it easier to create fast drawing, cached web map services and gives you more control 

over how your cache gets built and updated. Caching your map services for display with ArcGIS Online, Google Maps, 
and Microsoft Virtual Earth is much easier as those tiling schemes are now built into the caching tools.  
 

Improved support for creating KML 
The ability to export GIS data to KML files is now included in ArcGIS Desktop 9.3 at all license levels and no longer 

requires the 3D Analyst extension. A new HTML Popup tool makes it easy to specify popup content for the features in 
your KML. People can use the KML files you export from ArcGIS Desktop in Google Earth™, the Google Maps 'My 
Maps' tab, Microsoft Virtual Earth 'Collections', etc. Map services you publish with ArcGIS Server 9.3 can now be 
accessed directly via a URL in clients like Google Earth. Server can also return the results of geoprocessing, queries & 
geocoding to clients as KML. People can use search engines like Google® to discover maps and other services you 
publish, and launch them directly in a variety of clients for easy integration with other web content. 
 

Many Desktop enhancements 
ArcMap™ 9.3 lets you convert graphics to features so you can create data without the editor. You can temporarily 

pause labeling to speed up drawing. Legends are automatically drawn with lighter colors to match layer transparency. 
Field aliases are retained when you join tables & you can sort tables on multiple fields. Geoprocessing error messages 
have hyperlinks to full descriptions. Also, Microsoft Virtual Earth is now supported as a data source in ArcMap.  
 

Better web security 
ArcGIS Server's new role-based security at 9.3 lets you manage access to your web services and applications for 

different users. You configure users and roles using the new Security tab in the Server Manager. 9.3 also introduces 
the option to use token-based security for web services and applications. 
 

New options for deploying enterprise geodatabases  
You can now implement multi-user ArcSDE® geodatabases in the PostgreSQL open source RDBMS. Both the ESRI 

spatial type and the PostGIS spatial type are supported. ArcGIS 9.3 users can make direct connections to 9.2, 9.1 and 
9.0 ArcSDE geodatabases. There is also a new viewer for comparing versions, and new conflict resolution options. 
 

Easier to deploy mobile GIS 
At 9.3 ArcGIS Mobile introduces a new out-of-the-box mobile application making it easy for you to put mobile 

devices into action in your GIS. Data, maps, tasks and services are configured and managed centrally using ArcGIS 
Server, and mobile devices are synchronized automatically with your GIS over wired or wireless networks. 
 

New resource centers and improved documentation 
Each ArcGIS product now has its own resource center website bringing together various online resources including 

documentation, support pages, forums, blogs, key web data, and more! Start at the Resource Centers gateway: 
http://resources.esri.com. We have also made major additions to the documentation, especially for publishing content 
and services on the Web, administering servers, and developing applications, including many new code samples. 
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Overview  

General 
 

 New resource centers make it easier to find help, forums, support, blogs, etc for the product you are using. 
 Full support for Microsoft Windows Vista® in all products. 
 Upgraded License Manager with Vista, Remote Desktop, and 64-bit support. 
 Support for 64-bit processors. ArcGIS is now certified to run on the Intel® and AMD™ 64-bit processor families. 
 Many documentation improvements particularly in the area of publishing your GIS resources on the Web.. 
 New crash reporting mechanism sends error reports to us so we can track down and fix crashes faster. 

 

Data management 
The geodatabase 

 The open source RDBMS PostgreSQL is now supported by Enterprise ArcSDE. PostGIS spatial type supported. 
 DB2® z/OS® support in Enterprise ArcSDE. 
 Support for text search in DataBlade® module products and other enhancements to Informix® support. 
 Oracle 11g database support and many other enhancements to Oracle support. 
 Support for the two new spatial types in Microsoft SQL Server 2008. 
 Microsoft SQL Server® Express support includes Advanced Services with full-text search. 
 Additional compatibility for direct connections. 
 New Version Changes viewer lets you review changes without reconciling versions or being in edit session. 
 New conflict resolution option to merge geometries of separate versions if same feature edited by two editors. 
 One-way replication now supports file geodatabases and personal geodatabases. 

Editing 

Easier to place points in sketches without switching to the Sketch tool. 
Support for entering XY coordinates locations in DD, DDM or DMS irrespective of your data's map units. 
Ability to pause while digitizing in stream mode. 
Better on-screen feedback for the Split tool and Fillet tool. 
Status bar feedback for Sketch tool now includes total line length and ability to see current area of polygon.  
New keyboard shortcuts make it quicker to work with errors in the topology error inspector. 
Improved functionality for capturing and editing the z values of features via new developer interfaces. 

Tables, joins and relates 

 Field properties such as aliases are now retained when you join tables or create definition queries on joined tables. 
 Definition queries in tables are now respected when you join tables. 
 You can now view the properties of joins and relates, such as the name and location of joined tables. 
 New Advanced Sorting dialog lets you sort tables on up to four fields. Sorting is now persisted as a table property. 
 New command and keyboard shortcuts lets you quickly toggle table between showing field aliases or actual names. 
 You can now define joins and relates directly from the table window. 
 Calculate Geometry dialog lets you calculate the coordinates of the start and end points of lines. 
 Reselect Highlighted command makes it easier to refine selections when working in Show Selected Records mode. 
 Delete Highlighted command lets you delete subsets in Show Selected Records mode when in edit session. 
 Identify window respects field properties like primary display field and field aliases when you follow relates.  
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Raster data 

 Better handling of NITF and HDF imagery with full support of subdatasets. 
 Support for ENVI imagery. 
 Full integration of ArcGIS Server image services (imagery served using the ArcGIS Image Server extension). 
 Support for OGC® (Open Geospatial Consortium, Inc®) WCS (Web Coverage Services) as raster data sources. 
 Better tools for creating raster mosaics from raster catalogs. 
 New options for color balancing and matching make it easier to create seamless raster mosaics. 
 New 'clip to graphics' option makes it easy to clip rasters to any shape when exporting them. 
 New tools for repairing unmanaged raster catalogs when the referenced raster datasets are moved. 
 New Export Raster World File tool lets you export a standard world file for use in a non-ArcGIS application. 
 New Get Cell Value geoprocessing tool lets you retrieve the pixel value of a specific location in models & scripts. 
 New discrete color renderer provides a similar look to the unique values renderer but displays much faster. 
 The unique values renderer now supports floating point data. 

 

Mapping 
Graphics  

 New Convert Graphics To Features dialog lets you create features without editing. 
 Improved graphics property dialogs make it easier to get the coordinates and dimensions of graphics. 
 The ArcMap status bar can now show lengths & areas of graphics in different units than the XY coordinate readout. 
 Option to keep drawing tool active after drawing a graphic exposed in Tools > Options dialog. 

Bookmarks 

 Enhanced Bookmarks Manager dialog lets you sort, reorder, update, import and export bookmarks. 

Scale  

 Scales can be entered and displayed in relative format (such as 1in = 100 miles) throughout ArcMap. 

Layouts 

 Default scale text styles have been improved and it is easier to customize these to show relative scale. 
 Symbols in legends and in Table Of Contents automatically drawn with lighter colors to reflect layer transparency. 

Accessing attributes and hyperlinks from features 

 Attributes and web content can be displayed in HTML popup windows accessed by new HTML popup tool. 
 Launch a layer's properties and table window directly from the Identify dialog after identifying a feature. 
 Hyperlinks can now reference specific pages in PDFs and other documents that support application parameters. 

Labeling 

 New Pause Labeling command lets you temporarily turn off all labeling to speed up drawing. 
 Many enhancements in the Maplex® for ArcGIS extension (see the Maplex section later in this overview). 

Cartographic representations 

 WYSIWYG feedback when editing representations makes it easier to get the exact symbology you want. 
 New shortcut keys to switch between tools. 
 More control over how rules are displayed in the Table of Contents.  
 New geometric effects: Move, Regular Polygon, Rotate, Scale, Tapered Polygon, and Wave. 
 New marker placement style: On Vertices. 
 New Disperse Markers geoprocessing tool automatically spreads out coincident markers so they are all visible. 
 New Set Representation Control Points At Intersect geoprocessing tool synchronizes line patterns at shared edges. 
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Geocoding 

 New Address Inspector tool lets you click on the map and get the address at that location (reverse geocoding). 
 Easier to review and rematch geocoding results with improved Interactive Review dialog. 

Working with layer files 

 You can now add layer files into your maps by launching them from Windows Explorer, Outlook, web pages, etc. 

Adding web data into your maps 

 Easy to add free ArcGIS Online & other useful web services into your maps via ArcGIS Desktop Resource Center. 
 New subscription-based ArcGIS Online Premium Services including Microsoft Virtual Earth imagery & street maps. 
 Improved content for free ArcGIS Online services and ability to purchase imagery & topo maps as local raster files. 
 Cached ArcGIS map services look better when drawn in ArcMap and new options for saving cache locally. 
 Improved OGC WMS support including browsing of contents in ArcCatalog™ & better support for legends & styles. 
 New tool for importing WFS data as feature classes in the geodatabase at ArcEditor™ license level. 

Navigating and viewing maps 

 Easy viewing of mutually exclusive layers: ALT + click a layer's check box to turn it on and all other layers off. 
 Create Viewer Window tool added into Tools toolbar lets you work at multiple scales or compare data frames. 
 Zoom To Layer command respects definition queries and actual contents of selection layers (added in 9.2 SP4). 
 Option for rolling the mouse wheel to zoom centered on the cursor location instead of on the center of display. 

Exporting maps to PDF and KML 

 Improved layer list in exported PDFs: group layer hierarchy shown and layers are grouped by data frame. 
 Option to save attributes in exported PDFs so they can be accessed with the Object Data tool in Adobe Reader®. 
 Support for the new PDF capabilities in Acrobat® 9 including coordinate readout, find XY, measurement & markup. 
 Desktop users at all license levels can export layers & maps to KML with the 'Layer to KML' & 'Map to KML' tools.  
 The new HTML popup functionality in ArcMap, ArcGlobe™ and ArcScene™ lets you define popup content for KML.  

Other 

 New option to prevent Add Data dialog returning to last used location when opened the first time in a session. 
 

Visualization & analysis 
Selecting features 

 Clementini 'Contain' and 'Within' operators added to Select By Location dialog and geoprocessing tool. 
 Big performance improvement of Get Unique Values button on Select By Attributes dialog. 

Graphs 

 New scatter plot matrix graph lets you explore the relationships between sets of related variables. 

Spatial statistics 

 New tools to create spatial weights matrices showing spatial relationships in feature classes & network datasets. 
 New advanced regression tools: Ordinary Least Squares Regression and Geographically Weighted Regression. 
 Many improvements to the other tools improve accuracy and ease of use. 

Proximity analysis 

 Near tool now works with points, lines, and polygons and can also find multiple feature classes. 
 New Generate Near Table tool works like the Near tool but creates a separate output table. 
 Buffer tool improvements include support for geodesic buffers and better performance. 
 Improved Spatial Join tool: New option for joining to the closest feature makes it easier to merge attributes. 
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Geoprocessing & analysis 
General improvements 

 New geoprocessing resource center website lets you share tools, models and scripts with other users. 
 New Start ModelBuilder™ button on the Standard toolbar makes it easier to create new models. 
 All error messages have been overhauled with links to new 'Tool errors and warnings' section in Desktop Help. 

Model and script tool enhancements 

 Python® scripts can be run in-process, significantly reducing execution time. 
 More options for specifying model and script tool parameters including filters controlling the set of allowable inputs. 
 Script tools can have custom validation logic. This allows your script tools to behave just like system tools. 
 Better access to Python data structures with version number argument to the arcgisscripting.create method. 

Server enhancements 

 Feature Set and Record Set data types allow you to input feature classes and tables. 
 Better error checking when publishing tools. 
 Raster rendering information can be provided for raster results returned from geoprocessing services. 

Other 

 Summary Statistics supports multiple case fields. 
 Calculate Field supports unit conversion. 

 

Desktop application development 
.NET SDKs (Desktop & Engine) 

 Visual Studio® 2008 support. 
 Improved documentation, including new Snippet Finder. 

Java SDKs 

 Support for Java™ Developer Kit 6, Suse® Linux® 10, 64-bit Red Hat® Linux (with 32-bit JVM) and Windows Vista. 
 Improved IDE Integration: Supports Eclipse™ 3.3 (Engine and Server) and NetBeans™ (Server). 
 Four times more help topics and samples for Java developers, and improved ArcObjects™ Library Overview topics. 
 New MXDEditor Tool lets you inspect and fix broken layers in MXD files. 

ArcGIS Engine 

 Further enhancements to dynamic display support including feature selection and better zoom, pan and roam. 
 Editing enhancements include creation of edit tasks, set target layer, access sketch geometry, and digitizing rules. 
 Engine Add Data dialog supports connections to ArcSDE geodatabases (added in 9.2 SP2). 

 

Mobile GIS 
ArcGIS Mobile 

 New out-of-the-box ArcGIS Mobile application makes it easier and quicker to put mobile GIS into action. 
 Improved ArcGIS Mobile SDK has better map control and projection support, new sketch-based editing tools, etc. 

ArcPad 7.1 

View and edit geodatabase data in the field, including related tables, using the new AXF format. 
 New ArcPad® Data Manager toolbar in ArcMap and new ArcPad geoprocessing tools. 
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Putting GIS on the Web  
ArcGIS Server Manager enhancements 

 Improved look and feel makes the Server Manager easier to use, including new Security tab. 
 Administrator privileges no longer required to login to the Server Manager for the Microsoft .NET Framework. 
 More options for layers you deploy in Web applications, such as field alias settings. 
 New configurable Print task enables printing from the Web Mapping Application. 
 Improved messages in server log files make troubleshooting and optimization easier. 

Web Mapping Application 

 New look for the Web Mapping Application and enhanced map navigation and tools. 
 Ability to print the map and task results. Many new symbols available for displaying task results. 

GIS services 

 Image services provided by ArcGIS Image Server extension enable image processing & analysis over the Web. 
 New geometry services allow applications to invoke sophisticated geometric operations.  
 Map services are now automatically KML enabled for easy discovery and access in clients like Google Earth. 
 New options for caching map services: cache specific areas only and cache on demand as the service is used. 
 Built in support for caching map services for display with ArcGIS Online, Microsoft Virtual Earth and Google Maps. 
 Better workflows, performance and documentation for geoprocessing services. 
 Support for Schematics and Geostatistical extensions. 

Security 

 New role-based security model makes it easy to manage access to your services & applications for different users. 
 Ability to provide token-based security for services and applications. 

Interoperability 

 More options for authoring KML enabled services, and KML services can be accessed directly via URLs. 
 Cached map services are now supported when you serve OGC WMS. Support added for OGC WFS and WCS. 

.NET 

 Support for Microsoft Vista, Visual Studio 2008, Microsoft .NET Framework 3.0 & 3.5, and APS.NET AJAX. 
 The Web ADF JavaScript library is now fully documented. 

Java 

 Developer IDE Support: Developer plug-ins support for Eclipse 3.3.x and NetBeans 6.x. 
 Takes full advantage of new features in Java EE 5.  

JavaScript 

 New ArcGIS JavaScript API makes it very easy to embed maps in web pages and create GIS applications. 
 New ArcGIS JavaScript Extension for Microsoft Virtual Earth lets mashup your GIS data with Virtual Earth. 
 New ArcGIS JavaScript Extension for Google Maps API lets you mashup your GIS data with Google Maps. 

Flex 

 Develop rich, dynamic web applications using the Adobe Flex framework. (Currently in public beta) 

REST (Representational State Transfer) API 

 Provides a simple, powerful and open Web interface to GIS services hosted by ArcGIS Server. 
 People can browse and discover the contents of your ArcGIS server with new Services Directory web pages. 
 Enables web development in additional environments such as Microsoft Silverlight. 
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Enhancements to ArcGIS Extensions 
ArcGIS 3D Analyst™ (includes ArcGlobe and ArcScene) 

 Default globe can now be the same globe used in ArcGIS Explorer using free ArcGIS Online globe services. 
 Easy to add free ArcGIS Online globe services into your globes via ArcGIS Desktop Resource Center. 
 New subscription-based ArcGIS Online Premium Services including Microsoft Virtual Earth imagery & street maps. 
 Images can be used as billboarded marker symbols in ArcGlobe and ArcScene. New 3D Billboards style. 
 Improved support for KML 2.1 includes screen overlays, auto-refresh of KML network links, etc. 
 Support for 3D models defined in COLLADA (Collaborative Design Activity) files. 
 Perimeter-based extrusion for lines and polygons where the line is extruded on a per-vertex basis. 
 Better support for graphics in ArcGlobe including pin graphics to globe surface and drape/billboard text graphics. 
 Tracking Analyst extension supported in ArcGlobe. 
 Interpolate Shape and Line Of Sight tools now support terrain datasets. 
 New Point File Information tool performs mass point QA/QC before loading points into geodatabase. 
 LIDAR intensity attribute now supported in ASCII 3D To Feature Class geoprocessing tool. 
 Profile Graph tool can now profile multiple lines in one graphical plot and graph line of sight results. 
 New Contour with Barriers tool provides many advantages over the existing Contour tool. (Also in Spatial Analyst). 
 New 3D analysis/geometry operators for developers. 

ArcGIS Data Interoperability 

 Updated to use FME 2007 engine which includes new rich geometry model and 35+ additional transformers. 
 Adds support for FDO Providers (Open Source), GeoRSS, Trimble® JobXML and Autodesk® 2007 (DWG™/DXF™). 
 Many enhancements to ETL Workbench including overview window and customizable transformer gallery. 

ArcGIS Geostatistical Analyst 

New Gaussian Geostatistical Simulation tool creates surfaces that show local variability better than kriged surfaces. 
Takes advantage of multiple CPUs to increase performance for calculation and export of geostatistical layers. 
Geostatistical Analyst available in ArcGIS Server and ArcGIS Engine. 

Maplex for ArcGIS  

 Better support for strike and dip labeling in geology maps. 
 Improved placement options along streets to account for missing address numbers and odd/even sides. 
 Contour labels can be placed in ladders along the contour slopes aligned to the page and in uphill direction. 
 River labels can now be curved multiple times to fit meanders and curved along centerlines of river polygons. 
 More control over where labels are placed inside and around polygons, and along coincident polygon boundaries. 
 Control over where the anchor point for leader lines or callouts are snapped to the feature. 
 You can now choose the order in which the label fitting strategies are applied. 
 East Asian language vertical text placement. 

ArcGIS Network Analyst 

 New vehicle routing problem (VRP) solver provides the ability to generate routes for a fleet of vehicles. 
 New evaluators for network dataset attributes: Function Evaluator and Global Turn Delay Evaluator. 
 New query builder for finding network locations. 
 The origin-destination (OD) cost matrix solver is an order of magnitude faster. 

ArcGIS Publisher and ArcReader 

 Ink markups created in ArcReader™ can be exported and loaded into ArcMap as a guide for editing data. 
 ArcReader's Find dialog now supports standard address locators (file-based and in stored in geodatabases). 
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ArcGIS Schematics 

 New Expand Links rule. Enhanced Square Links layout task.  
 Better schematic label placement with new Label Placement Optimizer algorithm. 
 New geoprocessing tools for creating, updating and converting schematic diagrams. 
 New Find Related Diagrams tool lets you select a feature on a map and find diagrams that contain that feature. 
 New XML Builder lets you generate diagrams from XML, improving interoperability with other systems. 
 New Geo-Partial Overlapping Link algorithm & Geo-Linear Dispatch layout algorithm improved (added in 9.2 SP3). 
 ArcMap viewer window lets you work with schematics & geography side-by-side on-screen (added in 9.2 SP2). 

ArcGIS Spatial Analyst 

 New Zonal Histogram lets you investigate frequency/distribution of one dataset within classes of another dataset. 
 New Contour with Barriers tool provides many advantages over the existing Contour tool. (Also in 3D Analyst). 
 New Snap Raster environment and improved Extent parameter. 
 Performance improvements: Combine tool is 40x faster (9.2 SP2). Fill tool is 45x faster. 
 Improvements in large data processing for Viewshed, IDW and Combine.  
 Improved error messages and status report in the core geoprocessing environment facilitates spatial analysis work. 

ArcGIS Survey Analyst 

 New Cadastral Editor and cadastral fabric data model added in 9.2 SP3 continues to be enhanced. 
 Point Reporting tool provides reports on the cadastral fabric points while working within a cadastral fabric. 
 Improved support for representing unclosed parcels in the cadastral fabric. 
 Improved performance in feature adjustment and when finishing a job. 
 Support for domains and subtypes in the cadastral editing environment. 
 New planarize method in Parcel Construction toolbar & ability to import traverse files from Editor Traverse utility. 

ArcGIS Tracking Analyst 

 Support for Tracking Analyst in ArcGlobe.  
 New purge rule defines how real-time data is stored in the geodatabase. 
 Support for dynamic display and real-time statistics in the Tracking Analyst API. 
 Actions on tracking servers can now be accessed, edited and defined. 

Server extension: ArcGIS Image Server 

 The ArcGIS Image Server is now available as an extension to ArcGIS Server.  
 ArcGIS image services can be accessed via ArcGIS Server connections in ArcCatalog. 
 Image services are full raster data sources & can be used in geoprocessing tools, used as surfaces, exported, etc. 
 Additional client application support now includes AutoCAD® version 2008 and Microstation® XM. 
 Support for tiled rasters referenced by a single record in source tables speeds up data addition and management. 
 Raster type support added for JPEG 2000, QuickBird & BAE Systems® Socet Set®.  
 Improved support for Intergraph® ISAT. 
 Raster format support added for TIFF12 and JPEG 2000 raster format speed has been substantially improved. 
 Image service authoring improved with revised toolbar and new features for recomputing footprints and seamlines. 
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General 

Resource centers 

At 9.3 we have introduced resource centers for each product. These websites provide convenient access to the 
various online resources available for the particular product you use, in one easy-to-find location. The resource centers 
include links to the online help for the product, blogs, forums, support pages, online data you can use in your maps, 
code samples, galleries etc.  
 
There are also specialized cross-product resource centers for particular areas of interest including geoprocessing, 
mapping and visualization (the Mapping Center), geodatabases & ArcSDE, and imagery & raster data.  
 
To access any of these resource centers, start at the ESRI Resource Centers gateway: http://resources.esri.com. 
 
You can also launch the resource centers from inside the products. For example, the Help pulldown menu in ArcMap 
has a command to launch the ArcGIS Desktop Resource Center.  
 
Here are some screenshots of the resource centers, but we encourage you to explore them for yourself! 
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Full support for Microsoft Windows Vista 

Starting at 9.2 Service Pack 4, we added support for Vista in the following products: ArcReader, ArcView®, 
ArcEditor, ArcInfo® Desktop, ArcGIS Desktop Extensions, ArcInfo Workstation, and ArcGIS Engine. ArcGIS 9.3 adds 
Vista support for the remaining products that were not supported in Service Pack 4: ArcGIS Server including ArcSDE, 
ArcGIS Image Server, ArcIMS®, and ArcGIS Explorer. 
 
For complete information about Vista support, please see ESRI Knowledge Base article 34020: 
http://support.esri.com/index.cfm?fa=knowledgebase.techArticles.articleShow&d=34020  
 

The ArcGIS 9.3 License Manager now fully supports Windows Vista (see next section). 
 
 
 

Upgraded License Manager 

The ArcGIS License Manager has been upgraded from Macrovision's FLEXlm® v7.0d to Macrovision's FLEXnet® 
Publisher v11.4. This upgraded License Manager: 
 
-  Supports Microsoft Windows Vista. 
 
- Supports 64-bit Windows. 
 
-  Solves the issue with the ArcGIS 9.2 License Manager not working correctly via Remote Desktop in Windows. In that 

environment the communication between the hardware key and the hardware key drive could break. 
 
-  Lets you use the MAX option in the license options file to correctly restrict usage. Previously, to restrict usage to n 

users, the MAX option would have to be set to n+1 users and setting the MAX option to 1 would not immediately 
prevent a user from opening an ArcMap session. With this release, if you need to restrict usage to n users, they can 
directly specify n instead of n+1 in the options file. 

 
You will no longer be able to use your existing license server for the ArcGIS Desktop 9.3 and ArcInfo Workstation 9.3 
products. The License Manager that shipped with ArcGIS Desktop 9.2 and ArcInfo Workstation 9.2 products can only 
be used for 9.2, and prior 9.x products. The license manager that ships with ArcGIS 9.3 can be used for 9.3 as well as 
for prior 9.x products. You can continue to use your existing hardware keys and license files.  
 

For more information, see 'Installing the License Manager' in the ArcGIS Installation Guide.  
 

Also in the Desktop Help, see 'Licensing and desktop administration > Setting up license managers for ArcGIS 9.3 
concurrent use products': 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Setting_up_license_managers_for_ArcGIS_93_conc
urrent_use_products
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Support for 64-bit processors 

Starting with 9.2 Service Pack 3, ArcGIS was certified to run on the Intel® and Advanced Micro Devices® 64-bit 
processors, such as the 64-bit Intel Xeon®  Processor. Note that the Intel Itanium® processor is not supported. At 9.3 
we have performed additional certification testing. Here are the details about 64-bit support in 9.3: 
 

ArcGIS Desktop (ArcInfo, ArcEditor, ArcView) on 64-bit  
ArcGIS Desktop is a native 32-bit application and runs as a 32-bit application on 64-bit Microsoft Windows and so 
can take advantage of some of the performance benefits of the 64-bit environment.  
 
ArcReader on 64-bit  
ArcReader is a native 32-bit application and runs as a 32-bit application on 64-bit Windows, 64-bit Solaris™ and 64-
bit Linux.  
 
ArcGIS Server and ArcIMS on 64-bit  
ArcGIS Server and ArcIMS are native 32-bit applications. They have both been certified running as a 32-bit 
application on 64-bit Microsoft Windows. Web server support is based on the web server vendor’s support of 64-bit 
Microsoft Windows. Check with your web server vendor if your web server is supported on 64-bit Microsoft Windows. 
ArcGIS Server and ArcIMS support Solaris 64-bit. ArcGIS Server and ArcIMS are not supported on 64-bit Linux. 
ArcIMS does not support 64-bit IBM® AIX® or 64-bit HP HP-UX®.  
 
ArcGIS Engine on 64-bit  
ArcGIS Engine is a native 32-bit application and has been certified running as a 32-bit application on 64-bit Microsoft 
Windows, 64-bit Solaris and 64-bit Linux. 
 
ArcSDE on 64-bit  
ArcSDE is available as a native 64-bit application for Sun™ Solaris (Oracle and DB2), HP HP-UX (Oracle and DB2), 
HP Itanium (Oracle), and IBM AIX (Oracle and DB2). On Windows, ArcSDE is a native 32-bit application and runs as 
a 32-bit application on 64-bit Microsoft Windows. Check with your DBMS vendor if your DBMS is supported on 64-bit 
Microsoft Windows. ArcSDE is a 32-bit application on Linux for both Oracle and DB2. When running ArcSDE for 
Oracle on Red Hat Linux, the Oracle DBMS and Red Hat Linux OS must both be 32 bit, even if the server on which 
they are installed is a 64-bit server. ArcSDE for DB2 has not been certified on a 64-bit Linux environment. 

 
The ArcGIS 9.3 License Manager now fully supports 64-bit Windows environments.  

 
 
 

Documentation improvements 

The overview topics in the ArcGIS Desktop Help have been improved, there are additional animated tutorials, and 
lots of new content has been added. The Desktop Help index has also been completely overhauled at 9.3 to make it 
easier and faster to get to key topics. New index entries have also been added such as 'overview', 'lists' and 'FAQ' to 
give you fast access to particularly useful types of topics in the help.  
 
You can launch the Web version of the Desktop Help ( http://webhelp.esri.com/arcgisdesktop/9.3 ) from the Web Help 
link in the new ArcGIS Desktop Resource Center ( http://resources.esri.com/arcgisdesktop ), or by choosing the Help > 
ArcGIS Desktop Help command in any Desktop application and clicking the Web Help button at the top of the window 
that appears.  
 
At 9.3 the ArcGIS Desktop Resource Center is the gateway to online documentation and other resources for the 
product, so in the Help pulldown menu in the Desktop applications and in the Windows Start menu >  ArcGIS group we 
have replaced the link to the Web version of the Desktop Help with a link to the Resource Center. We have also 
simplified the contents of the Help pulldown menu in the Desktop applications: 
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(The command to launch the Web Help directly from the Desktop applications is still available via the Tools > 
Customize dialog > Commands tab > Help category if you want to have this command in a pulldown menu or toolbar). 
 

ArcGIS Server 9.2 was released with comparatively basic documentation, particularly for developers. Improving the 
ArcGIS Server documentation has been a major priority at 9.3. Since the release of ArcGIS Server 9.2, our goal has 
been to incrementally release more web-based help content. At 9.3 we have made a large number of improvements 
and many additions to the web-based ArcGIS Server help and the SDK documentation. Look out for blogs from the 
Server team too. The ArcGIS Server Resource Center ( http://resources.esri.com/arcgisserver ) provides easy access 
to all these resources. 
 
 
 

ArcGIS Desktop and Crystal Reports 

Starting at 9.3 the full Crystal Reports® product from Business Objects™, which provides an advanced report authoring 
application, is no longer included with ArcGIS Desktop.  
 
ArcGIS Desktop 9.1 and 9.2 included Crystal Reports XI Release 1. If you are upgrading to ArcGIS Desktop 9.3 from 
9.1 or 9.2, you can continue to use your Crystal Reports XI software with 9.3. In order to enable the Tools > Reports > 
Crystal Reports Wizard in ArcMap 9.3, you need to install the Crystal Reports XI Release 2 runtime. This install is 
included on the Desktop 9.3 release media: on the ArcGIS Desktop Install DVD menu, it's the choice called 'ArcGIS 
Crystal Reports Wizard'. The Desktop Setup no longer prompts you to install Crystal Reports. (You do not need to 
install the Crystal Reports XI Release 2 runtime to enable the Crystal Reports Wizard if you upgraded your Crystal 
Reports XI software to release 2). 
 
Business Objects has released a new version of Crystal Reports: Crystal Reports 2008. If you have Crystal Reports XI, 
you can upgrade to Crystal Reports 2008 directly from Business Objects. See this page on the Business Objects 
website for how to upgrade: http://businessobjects.auc.com/ESRI2008/cd/index.html (Some international ESRI 
distributors may also be Business Objects resellers) Technical support for Crystal Reports 2008 is provided by 
Business Objects and may require an additional fee.  
 
If you are a new user of ArcGIS Desktop and you wish to use Crystal Reports 2008, you can buy it directly from 
Business Objects at the web page mentioned above. To enable the Crystal Reports Wizard in ArcMap 9.3 to work with 
Crystal Reports 2008, you will need to install the Crystal Reports XI Release 2 runtime mentioned above.  
 
If you do not have any version of Crystal Reports installed, you can still enable the Crystal Reports Wizard in ArcMap 
9.3 by installing the Crystal Reports XI Release 2 runtime mentioned above. This lets you to create, export and print 
basic Crystal reports, and also open existing reports saved as .rpt files. However you won't be able to perform the 
range of formatting and authoring functionality available in the full Crystal Reports product. 
 
Note: ArcMap 9.3 continues to include the current simple report capability accessed using the Tools > Reports > 
Create Report command. These simple reports can be saved to PDF, RTF, text, or printed. This simple report 
capability does not use Crystal Reports.  
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Crash handling 

ESRI is committed to improving the quality of ArcGIS and the most important issue with quality is eliminating 
situations where an application crashes. Some crashes are caused by third party extensions and DLLs that do not 
work correctly with the latest version of the software or particular new types of data. Some crashes occur unexpectedly 
when the system is overloaded or when a specific hardware limitation is reached, and are hard to reproduce or repeat. 
Other crashes occur when a particular sequence of steps is performed on a particular dataset because of a flaw in our 
software, and can be reproduced by simply repeating the same steps on the same data. We investigate all reports of 
crashes as fully as we can to try and determine the cause and fix the problem in the next release or service pack.  
 
To help us with this effort, at 9.3 all the Desktop applications (with the exception of ArcReader) now have a crash 
report mechanism that automatically captures information about the crash in an error report that will enable us to 
investigate and fix the issue. If a crash occurs, you will see the new dialog below that lets you automatically send the 
error report to ESRI. Simply press the 'Send Error Report' button and the report will get sent to us via the Internet:  
 

 
 
If you are not on the Internet when the crash occurs, or if our web service that receives crash reports is temporarily 
unavailable, or if your machine doesn't have the .Net Framework 2.0 installed, the dialog that appears lets you save 
the crash report into a folder and gives you an email address to send the report to manually. 
 
If you encounter a crash that you can easily reproduce by repeating the same sequence of steps or using a particular 
dataset, it is especially useful to us if you can contact ESRI Technical Support about the issue, in addition to using the 
error report dialog shown above. Tell your tech support contact the sequence of steps and type of data you are 
working with. You can also provide your tech support contact with the error report for the crash. When a crash 
happens, the error report is automatically saved to the application data location on your local hard drive in this folder: 
C:\Documents and Settings\<User Name>\Application Data\ESRI\ErrorReports, so you can find the most recent report 
and send it to your tech support contact. That folder holds the last 10 error reports that the system has saved (but of 
course we hope you never have that many crashes!). 
 
Advanced users and system administrators can also configure how error reporting operates. For more information, see 
the 'Licensing and desktop administration > Error reporting for ArcGIS software crash data' topic and associated FAQ 
topic in the Desktop Help: 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Error_reporting_for_ArcGIS_software_crash_data
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Frequently_asked_questions_about_error_reporting
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Compatibility 

ArcGIS Desktop files 

Once you open and then save an existing ArcMap .mxd document, ArcGlobe .3dd document or ArcScene .sxd 
document in ArcGIS 9.3, it can no longer be opened with earlier versions of the software. Similarly, new ArcMap, 
ArcGlobe and ArcScene documents you create with 9.3 can also not be opened in earlier versions of the software.  
 
To save a copy of a document that has been created or edited in 9.3 so it can be opened in version 8.3, 9.0, 9.1 or 9.2, 
use the File > Save A Copy command and choose the version you want to save to from the Save As Type dropdown 
list in the dialog that appears. Saving a document back to a previous version removes functionality from the document 
that depends on the version it is being saved out from.  

For more information about map document compatibility, see the 'Mapping and visualization > Using ArcMap > 
Saving to previous versions of ArcGIS' topic in the Desktop Help: 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Saving_to_previous_versions_of_ArcGIS
 

Layer files (.lyr) that you save to disk with 9.3 cannot be opened with earlier versions of the software. To create a 
layer file using 9.3 that can be opened in an earlier version, right-click the layer in the Table Of Contents, choose the 
Save As Layer File command from the context menu, and choose the version you want to save to from the Save As 
Type dropdown list in the dialog that appears. Functionality that is not available in the version of ArcGIS you are saving 
the layer file for use with will be automatically removed from the layer file that gets saved. 

For more information about saving layer files, see the 'Mapping and visualization > Working with layers > Saving a 
layer to disk' topic in the Desktop Help: 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Saving_a_layer_to_disk
 

ArcReader .pmf files that you publish with the ArcGIS Publisher extension at 9.3 can't be opened with earlier 
versions of ArcReader. 
 

Once you make a change to a file-based toolbox (.tbx file) in 9.3, it can no longer be opened in a 9.0, 9.1 or 9.2. 
However, you can save a toolbox as a file-based toolbox that can be opened in earlier versions by right-clicking it in 
the ArcToolbox window and choosing the Save As > 9.0/9.1 Toolbox or Save As > 9.2 Toolbox command. The 
contents of the file-based toolbox that is created by these command are not automatically modified to remove 
functionality that is not available in the version you are saving the file to. So if the toolbox contains models or scripts 
include functions added at 9.3, these models or scripts can be opened in 9.2 but they will need to be modified 
manually in 9.2 to skip or remove those 9.3-specific steps. For compatibility rules for toolboxes stored in 
geodatabases, see the information in the next section on geodatabase compatibility. 

For more information about toolbox compatibility, see the 'Geoprocessing > Using geoprocessing tools > Managing 
toolboxes > Saving toolboxes to earlier versions' topic in the Desktop Help: 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Saving_toolboxes_to_earlier_versions
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Geodatabases 

Existing geodatabases created using previous releases can be opened, used, and saved in 9.3 without being 
upgraded to 9.3. You only need to upgrade geodatabases to 9.3 if you want to take advantage of the following new 
geodatabase functionality introduced at 9.3 related to terrains and network datasets (these enhancements are 
described later in this document): 
 
- Creating a terrain with the new Window Size pyramid format. 
 
- Creating a network dataset with an attribute that uses the new Global Turn Delay and Network Function evaluators. 
 
If you want to upgrade your Geodatabase to ArcGIS 9.3, use the Upgrade Geodatabase button on the geodatabase 
properties tab: 
   

 
 
This works with all geodatabases except for Enterprise ArcSDE geodatabases (i.e., those licensed through ArcGIS 
Server Enterprise). To upgrade an Enterprise ArcSDE geodatabase, see your ArcSDE installation guide. Upgrading an 
Enterprise ArcSDE geodatabase can only be performed by the administrator of that database. 
 
Tip: In the Tools > Customize dialog in ArcCatalog, the 'Geodatabase tools' category contains a command called 
Upgrade Geodatabase that you can add into any pulldown menu or toolbar in ArcCatalog. This command does the 
same thing as the Upgrade Geodatabase button but can save time if you have a lot of geodatabases to upgrade. This 
command becomes enabled when you select a geodatabase in ArcCatalog that needs upgrading. 
 
Once a geodatabase has been upgraded, it can no longer be accessed from an older version of ArcGIS. The 
exception to this rule is ArcGIS 9.2 Service Pack 5 or a more recent 9.2 service pack, which can connect to 9.3 
geodatabases but will not be able to open, edit or create terrains and network datasets containing the new functionality 
available with ArcGIS 9.3 mentioned earlier.  
 
To be able to make a direct connection from ArcGIS 9.2 Service Pack 5 or a more recent 9.2 service pack to an 
ArcSDE 9.3 geodatabase, you must separately install the direct connect drivers. If any of your users need to connect 
to the geodatabase using 9.2 Service Pack 4 or earlier clients, do not upgrade the geodatabase to 9.3.  As long as you 
install the 9.2 direct connect drivers on the ArcGIS 9.3 clients, any ArcGIS 9.3 clients you have will still be able to 
access and edit your 9.2 geodatabase; however, ArcGIS 9.3 will prevent you from creating terrains with the new 
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Window Size pyramid option in a 9.2 geodatabase, and from creating a network dataset that uses the new Global Turn 
Delay evaluator in a 9.2 geodatabase.  
 
Note: If you do not install the Pre-9.3 geodatabase direct connect drivers, you must upgrade your ArcSDE for SQL 
Server Express (i.e. Personal ArcSDE and Workgroup ArcSDE) geodatabases before you can connect to them. 
 

The default installation location for ArcSDE on Windows has changed from ArcGIS\ArcSDE to Program 
Files\ArcGIS\ArcSDE. This is especially important if you will be upgrading your geodatabases using scripts or batch 
files that contain the path to SDEHOME. 
 

ArcGIS 9.3 introduces additional compatibility for direct connections. Please see the section about this in the next 
chapter of this document (the 'Data Management' chapter), along with the following two help topics: 
 

For more information about geodatabase compatibility, please see the 'Geodatabases and ArcSDE > An overview 
of the geodatabase > Client and geodatabase compatibility' topic in the Desktop Help: 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Client_and_geodatabase_compatibility
 

For more information about the compatibility of connections to ArcSDE geodatabases, please see the 
'Geodatabases and ArcSDE > Administering ArcSDE geodatabases > Connecting to an ArcSDE geodatabase > 
Compatibility between clients and geodatabases' topic in the Desktop Help: 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Compatibility_between_clients_and_geodatabases
 
 
 

ArcGIS Server web services and applications 

For information about moving from ArcGIS Server 9.2 to 9.3, see the 'Introducing ArcGIS Server > Moving to 
ArcGIS Server 9.3' topic in the ArcGIS Server Help: http://webhelp.esri.com/arcgisserver/9.3/dotNet/moving_to_93.htm
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Data management 

Enterprise ArcSDE enhancements 

PostgreSQL support in Enterprise ArcSDE 
 

Enterprise ArcSDE now supports the open source RDBMS PostgreSQL 8.3. This gives you the ability to store and 
manage spatial information in this open source database system. The ArcGIS Server Enterprise for PostgreSQL 
installation includes the installation files for PostgreSQL as well as the ArcSDE 9.3 component. 
 

ArcSDE geodatabases in PostgreSQL use the ST_Geometry ESRI spatial type for vector data by default. Users can 
also install PostGIS 1.3.2. and use the PostGIS storage type, needing only to alter their GEOMETRY_STORAGE 
DBTUNE parameter. 
 

ArcSDE for PostgreSQL geodatabases offer all the same functionality as other Enterprise ArcSDE geodatabases. 
 
 
DB2 z/OS support in Enterprise ArcSDE 
 

At 9.3, you can create ArcSDE geodatabases in DB2 for the IBM Z series main frame operating system (referred to 
as DB2 for z/OS®). DB2 for z/OS offers tighter security and increased availability than DB2 on Windows, Unix®, or 
Linux and is, therefore, often used by the banking, insurance, and brokerage industries. Version 9 of DB2 z/OS, 
released in March of 2007, is the first version of DB2 for z/OS to include spatial data support.  
 
Having the ability to create ArcSDE geodatabases in a DB2 database on the z/OS platform allows users of this 
database type to add a spatial component to their applications that takes advantage of the rich functionality of ArcGIS 
software. At this release, direct connections to the database are supported but ArcSDE service connections are not. 
DB2 for z/OS does not support the use of Net Search Extender at this time, so the creation of ArcSDE XML columns is 
not supported at this ArcGIS release. Note also that database administrative tasks such as updating indexes must be 
performed using the tools provided by DB2. 
 
 
Enhancements to Informix support 
 

You can now create ArcSDE XML columns using the text search DataBlade module products available for Informix 
Dynamic Server. These include the Excalibur Text Search (ETX) DataBlade module in Informix version 10 and above 
and the Basic Text Search (BTS) DataBlade module available with Informix version 11. 
 
The ability to create ArcSDE XML columns allows users to perform full-text searches on the contents of the XML 
column and makes the use of ArcIMS metadata services and the ArcGIS Portal Toolkit possible for ArcSDE for 
Informix users. 
 

Improved raster storage—A new DBTUNE configuration parameter allows users to specify a BLOBspace for the 
storage of raster block data. This parameter can be set under the DEFAULTS configuration keyword to specify a 
location for all raster block data or users can create their own configuration keywords that include this parameter, 
which they can specify when creating certain raster datasets. For example, the parameter could be set to store raster 
data in a BLOBspace named rasterblobspace, as shown below. 
 
BLK_LOB_STORAGE "IN rasterblobspace" 
 
This helps avoid reaching the space limitation on Informix DBspaces of 16,775,134 data pages per table fragment. 
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Edit versioned data through multiversioned views using the SQL API—In previous ArcGIS releases, ArcSDE for 
Informix users could create multiversioned views to read versioned data, but they could not edit the data using SQL 
through these views. At 9.3, the necessary database triggers are implemented that allow users to edit versioned data 
through multiversioned views. 
 
 
Enhancements to Oracle support 
 

Starting at 9.2 Service Pack 1, the ST_Transform function has been implemented for the spatial type for Oracle. 
ST_Transform lets you change the ST_Geometry of a layer into a different spatial reference using SQL by specifying a 
Spatial Reference ID. 
 

Other functions newly supported at 9.3 are ST_PointFromWKB, ST_LineFromWKB, ST_PolyFromWKB, 
ST_MPointFromWKB, ST_MLineFromWKB, and ST_MPolyFromWKB. These functions allow you to create points, 
linestrings, polygons, multipoints, multilinestrings, and multipolygons from a well-known binary representation. 
 

ArcSDE 9.3 geodatabases are supported on Oracle 11g databases. 
 

New installations of the ArcSDE component for Oracle use ST_Geometry as the default vector data storage type. 
 

To allow current users to migrate the geometry storage of existing datasets to the ST_Geometry type, a new 
operation—migrate—has been added to the sdelayer command. Users can specify this command along with the 
ST_GEOMETRY configuration keyword to convert feature classes from LONG RAW (SDEBINARY), 
SDO_GEOMETRY, or BLOB (SDELOB) storage to ST_GEOMETRY storage: 
 
sdelayer -o migrate -l divisions,shape -k ST_GEOMETRY 
 

A migrate operation has also been added to the sdetable command to allow users to migrate Oracle LONG RAW 
attribute fields to BLOB. The keyword specified must contain an ATTRIBUTE_BINARY parameter set to BLOB. 
 
sdetable –o migrate –t distribution –k DEFAULTS 

 
For details on using the sdelayer or sdetable commands, consult the ArcSDE Administration Command Reference 
provided with the ArcSDE component of ArcGIS Server Enterprise edition. 
 
Additionally, a new geoprocessing tool—Migrate Storage—has been added to the Database toolset in the Data 
Management toolbox that allows you to migrate LONG RAW columns to the supported data types mentioned above. 
 

 
 

An operation has been added to the sdesetup command to allow for the deletion of geodatabases created in the 
schema of user’s other than SDE. Syntax for the sdesetup command with the delete operation is as follows: 
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sdesetup -o delete -d {ORACLE9I|ORACLE10G|ORACLE11G} [-H <sde_directory>] [-u 
<ArcSDE_admin_user>] [-p <ArcSDE_admin_password>] [-i 
<master_geodatabase_service>:<user_schema>] [-N] [-q] 
 
The following rules apply to using this operation: 
 
- When you delete a geodatabase, there can be no other users connected to any of the geodatabases—the master 

SDE geodatabase or any user-schema geodatabase. 
 
- There can be no data registered to ArcSDE in the geodatabase. That means that prior to deleting the geodatabase, 

you must remove any of the data that has been registered with ArcSDE (in other words, has an entry in the 
TABLE_REGISTRY system table and related system tables). This includes data in other schemas that is registered 
to the geodatabase that will be deleted. For example, if the SDE user owned a table that was registered to a 
geodatabase owned by user x, it would also have to be unregistered or removed from the geodatabase owned by x. 

 
Database event triggers have been added to ArcSDE for Oracle geodatabases to clean up the 

ST_GEOMETRY_COLUMNS and ST_GEOMETRY_INDEX metadata tables when a user executes a DROP, ALTER, 
or RENAME statement in SQL against a table containing a ST_Geometry column. To create these triggers, the 
ArcSDE administrator user (SDE) must have the permission ADMINISTER DATABASE TRIGGER granted to it when 
creating or upgrading an ArcSDE geodatabase for Oracle. If this permission is not granted to the SDE user, the 
geodatabase setup or upgrade will fail. This permission can be revoked after installation or upgrade. 
 

With new installations of ArcSDE 9.3 for Oracle, SQL functions and operators executed against the geodatabase 
must be qualified with “sde”. In the following example, a table is created using SQL and a record is inserted into the 
table. Notice that in each statement, the functions are prefaced with sde. 

CREATE TABLE mytable (id integer, shape sde.st_geometry) 
INSERT INTO mytable VALUES (1, sde.st_linefromtext(‘linestring (10 15, 20 22, 30 
36)’, 2)); 

 
Enhancements to Microsoft SQL Server support 
 

ArcGIS 9.3 supports the two new spatial types in Microsoft SQL Server 2008. See the following Microsoft web page 
for information about these new spatial types: http://www.microsoft.com/sqlserver/2008/en/us/spatial-data.aspx. A 
geodatabase implemented on SQL Server 2008 can store vector geometry in either spatial type (Geography or 
Geometry). This will enable users to perform SQL queries and operations on spatial data within SQL Server. For more 
information about this support, please see: http://www.esri.com/software/arcgis/geodatabase/about/sqlserver2008.html
 
 
Changes to ArcSDE administration commands 
 

Because multiple spatial types are now supported in ArcSDE geodatabases, it is now required to specify the data 
type of the geometry column when registering a spatial table with ArcSDE using the sdelayer command. In the 
following example, a spatial table (sites) with an ST_Geometry column (geometry) that was created using SQL in a 
PostgreSQL database (mydb) is being registered with ArcSDE as a feature class. 

sdelayer –o register –l sites,geometry –e p+ –R 12 –C id,SDE –t ST_GEOMETRY –i 2100 
–D mydb –u erna –p my.pw 

Be sure to update any scripts or batch files that contain sdelayer –o register to include the –t option. 
 

The sdesetup command includes the option to install or upgrade on an Oracle 11g database. 

sdesetup –o install –d ORACLE11G –u sde 

The shp2sde, tbl2sde, and sde2tbl commands can accept a file with column definitions to import NSTRING data to 
an ArcSDE geodatabase in Oracle or SQL Server. The file is specified using the –a option. In this example, a feature 
class is created from the shapefile roads with a column definition file, road_def.txt: 
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shp2sde –o create –l roads,geom. –f c:\shapefiles\roads.shp –a 
file=c:\data\road_def.txt –i 4000 –u Roberto 

As mentioned in the Oracle enhancement section, a new operation has been added to sdetable and sdelayer to 
migrate geometry storage in Oracle databases. A new operation has also been added to sdesetup to delete 
geodatabases from user-schemas. 
 

For details on ArcSDE administration commands, consult the Command Reference installed with the ArcSDE 
component of ArcGIS Server Enterprise. 
 
 

ArcSDE for Microsoft SQL Server Express 

Terminology change 
 
As a result of user feedback after 9.2, it was determined the terms used in 9.2 for the geodatabases created and 
administered through the ArcSDE database server folder in ArcCatalog—Personal ArcSDE and Workgroup ArcSDE —
were rather confusing. To simplify things at 9.3, we refer to this technology generically as ArcSDE for SQL Server 
Express. This name follows the same naming convention that has been used for ArcSDE geodatabases at previous 
releases of the software. For example, when you create a geodatabase in a DB2 DBMS, it is referred to as ArcSDE for 
DB2. The same is now true when you use the ArcSDE technology included in your client application to create 
geodatabases in SQL Server Express; it is referred to as ArcSDE for SQL Server Express. At ArcGIS 9.3, when you 
purchase ArcGIS Desktop at the ArcEditor or ArcInfo license level, ArcGIS Engine, or ArcGIS Server Workgroup, it 
includes an installation of Microsoft SQL Server Express Edition. You can install this edition of the SQL Server Express 
DBMS and run a post installation setup to enable the instance to store ArcSDE geodatabases. The licensing 
agreement included with the product you purchase (ArcGIS Desktop, ArcGIS Engine, or ArcGIS Server Workgroup) 
will indicate connection and storage limitations for the geodatabases created on your SQL Server Express instance. 
Therefore, throughout the documentation, you will notice terms have changed from Personal ArcSDE and Workgroup 
ArcSDE to ArcSDE for SQL Server Express.  
 
The term 'ArcSDE database server' is still used in documentation to refer to an SQL Server Express instance, and that 
term is still used for the location in the ArcCatalog tree where you create connections to SQL Server Express 
instances. 
 
In the ESRI marketing literature (http://www.esri.com/software/arcgis/geodatabase/index.html and 
http://www.esri.com/software/arcgis/geodatabase/about/scaleable.html) you may see the terms 'Workgroup 
geodatabase' and 'Desktop geodatabase' used to refer to what used to be called Workgroup ArcSDE and Personal 
ArcSDE, to distinguish these geodatabases from Enterprise ArcSDE geodatabases. However, we don't use the terms 
Workgroup geodatabase or Desktop geodatabase directly in the ArcGIS documentation or user interface. 
 
 
Microsoft SQL Server Express with Advanced Services 
 

ArcEditor, ArcInfo, ArcGIS Engine, and ArcGIS Server Workgroup 9.3 ship with the installation for Microsoft SQL 
Server Express 2005 with Advanced Services SP2. Existing ArcSDE database server users can upgrade their SQL 
Server Express instances. SQL Server Express with Advanced Services includes the full-text search component. This 
will allow users to create new geodatabases on their ArcSDE database servers that can be used with ArcIMS 
Metadata Services. The previous version of SQL Server Express that shipped with ArcGIS did not include the Full Text 
Search component and therefore couldn't be used with ArcIMS Metadata Services. 
 
 
ArcSDE for SQL Server Express included in the Engine developer kit 
 

As mentioned above, the ArcGIS Engine Developer Kit at 9.3 includes the SQL Server Express installation to allow 
ArcGIS Engine developers to use geodatabases stored in SQL Server Express as a data source. 
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Additional compatibility for direct connections 

Beginning with ArcGIS 9.3, you can make a direct connection from any ArcGIS or ArcIMS 9.3 client to a 9.3, 9.2, 
9.1, or 9.0 ArcSDE geodatabase. This will allow users to utilize direct connections to the geodatabase without having 
to upgrade the geodatabase at the same time as the clients are upgraded. To take advantage of this, you must install 
the Pre-9.3 GDB direct connect drivers, which are a separate installation on your software media. You must also 
upgrade to the latest service pack or patch any ArcSDE 9.0 or 9.1 geodatabases you will be connecting to using these 
drivers. Any service pack level for your ArcSDE 9.2 geodatabase is supported. Note: Interoperable direct connections 
between client and geodatabase versions does not apply to ArcSDE for Informix due to differences in the client SDK 
necessary to make direct connections. 
 
As has always been the case when connecting from a newer client to an older release ArcSDE geodatabase using an 
ArcSDE service (application server) connection, when you make a direct connection from a 9.3 client to an older 
ArcSDE geodatabase, you will only have access to the functionality that is available for the release of your 
geodatabase. For example, you cannot connect from an ArcGIS 9.3 client to an ArcSDE 9.1 geodatabase on Oracle 
and create a feature class using ST_Geometry storage because this storage type was implemented beginning with 
ArcSDE 9.2.  
 
In addition, files will be made available from the ESRI support site to allow you to connect from ArcGIS 9.2 SP 5 (or 
more recent 9.2 SP) clients to ArcSDE 9.3 geodatabases using either a direct connection or an application server 
connection. When you connect from an ArcGIS 9.2 SP5 (or more recent 9.2 SP) client to an ArcSDE 9.3 geodatabase, 
you do not have access to functionality that was newly implemented at 9.3. For example, you cannot connect from an 
ArcGIS 9.2 SP5 client to an ArcSDE 9.3 geodatabase on PostgreSQL. You also will not be able to use the new 
Windows Size pyramid types for Terrains that are available in 3D Analyst for ArcGIS 9.3 or create a network dataset 
that uses Global Turn Delay or Network Function evaluators, which are available in Network Analyst for ArcGIS 9.3. 
 
The following shows which versions of the client software can make a direct connection to which versions of the 
ArcSDE geodatabase: 
 

 
 
Because support is no longer available from Oracle for Oracle8i databases, connections from 9.3 clients to ArcSDE 
9.1 or 9.0 geodatabases stored in Oracle8i are not supported. 
 

For more information about geodatabase compatibility, please see the following two topics in the Desktop Help: 

'Geodatabases and ArcSDE > An overview of the geodatabase > Client and geodatabase compatibility': 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Client_and_geodatabase_compatibility  

'Geodatabases and ArcSDE > Administering ArcSDE geodatabases > Connecting to an ArcSDE geodatabase > 
Compatibility between clients and geodatabases': 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Compatibility_between_clients_and_geodatabases
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Versioning  

New Version Changes viewer 
 

A highly requested enhancement for conflict and change detection management has been for a way to determine 
changes between a version and its ancestor, or another version, without having to do a reconcile or be in an edit 
session. With this in mind a new button has been added to the Versioning Toolbar called Version Changes which 
opens the Version Changes viewer. 
 

 
 
When opening the Version Changes viewer you choose another version to compare changes with. The Version 
Changes viewer (shown in the graphic below) lists all inserts, updates, and deletes made to the version since the last 
time it and the version you chose were identical. It allows you to view and compare these changes in a similar fashion 
to the interactive Conflicts dialog box. You do not have to be in an edit session to open the Version Changes viewer 
and changes can be viewed before versions are reconciled. 
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New conflict resolution option 
 

A new option available in the conflict dialog allows you to merge the geometries of separate versions if two editors 
have edited the same feature. The option to merge geometries is available when there is a conflict concerning the 
Shape field. If two editors both edit the geometry of the same feature, but do not edit the same area of that feature (as 
seen in the graphic below) then they have the option to resolve the conflict by merging geometries and accepting both 
edits. This improves the overall conflict management experience, especially for large polygon and polyline features 
such as water mains or coastlines, or when editing across administrative boundaries. 
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Replication 

At 9.3 the one way geodatabase replication model has been extended to include file geodatabases and personal 
geodatabases. Now when creating one way replicas, the destination may be an ArcSDE geodatabase, a file 
geodatabase, or a personal geodatabase. 
 
This allows you to leverage one way replication implementations such as production-publication scenarios or those 
that require mobile users in the field. A broader range of scenarios can be accommodated with this model since the 
child replica does not need to be versioned or have SDE technology. 
 
 

Geodatabase resource center 

At 9.3 we have also introduced a new resource center for geodatabase users that brings together various useful 
resources from ESRI: http://resources.esri.com/geodatabase
 
 

Editing  

Editing tool enhancements 
 
Shortcuts 
 

The shortcut menu for all sketch construction tools on the Editor toolbar tool palette now contains the Snap To 
Feature, Absolute XY, Delta XY, and Direction/Length commands. This enhancement allows you to place a point in the 
sketch using these commands without having to switch to the Sketch tool. The keyboard shortcuts used to invoke 
these commands are also available to all sketch tools: 

 
 
The Arc and Tangent sketch tools allow you to enter a fixed radius value when constructing a curve. You can press R 
to set the radius value, then press Tab to cycle through the possible curve solutions. 
 
You can pan to selected features using the shortcut menu for the Edit tool and in the Attributes dialog box. You can 
also identify any selected feature by right-clicking it with the Edit tool and clicking Identify: 
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Clip 
 

The Clip command on the Editor menu now allows you to clip polygon features that touch, or are within a buffered 
distance of, a selected feature. This command has been enhanced to use any selected feature, including a CAD 
feature, to clip your polygons. Previously, the selected feature had to be editable and in the same workspace as the 
features being clipped.  
 
Units support 
 

The ability to enter a distance units abbreviation to specify units different from the map units has been added to 
more editing tools. For example, if your map units are meters, but you want to type a measurement in feet, simply type 
the ft abbreviation after the value: to enter 10 feet, type 10ft. In addition to the many tools and commands that already 
allow distance units abbreviations, you can now use them when: 
 

- Setting the snapping and stream tolerances on Editing Options dialog box > General tab. 
 
- Typing a value for the radius using the Circle tool on the Advanced Editing toolbar (press the R key to type a 

radius). 
 
- Setting an offset value for the Advanced Editing toolbar’s Smooth and Generalize commands. 

 
Support for decimal degrees, degrees minutes seconds, and degrees decimal minutes 
 

Decimal degrees, degrees minutes seconds, or degrees decimal minutes can now be used to specify an XY 
coordinate while editing, such as when placing a vertex or point with Absolute XY or Delta XY or when moving a 
feature, vertex, or topology element to an exact XY location. (In previous ArcGIS releases, entering degrees minutes 
seconds or degrees decimal minutes was not supported at all, and entering values in decimal degrees was only 
possible when using a projection that had decimal degrees as its map units.) 
 
Similar to other measurements entered when editing, XY coordinates are specified in map units by default. When your 
data frame uses a geographic coordinate system, such as WGS 1984, the map units are typically decimal degrees. In 
that case, you can enter an XY coordinate in decimal degrees, degrees minutes seconds, or degrees decimal minutes 
by simply typing the coordinate. However, to enter a coordinate in those formats when your data frame uses a 
projected coordinate system, you must also type a unit abbreviation: either dd (decimal degrees), dms (degrees 
minutes seconds), or ddm (degrees decimal minutes). An abbreviation is required because the map units of a 
projected coordinate system are likely linear, such as kilometers or feet. For example, if the map units are kilometers 
and you enter an XY coordinate of 45 dd, the dd abbreviation tells ArcMap that these measurements are in degrees, 
not kilometers (the map units).  
 
You can include the abbreviation in either the x or y box, but it must be appended after the value. Here is an example 
of using the dd abbreviation in the Absolute XY command on the Sketch tool shortcut menu: 
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These dialog boxes support any decimal degree coordinate formats valid for the Go To XY command on the Tools 
toolbar. 
 
Digitizing in stream mode 
 

When sketching in stream mode (streaming), you can temporarily suspend streaming just by clicking the map. This 
allows you to click buttons, menus, and other user interface elements without having to exit from stream mode entirely. 
This means you can right-click to access the Sketch tool's shortcut menu, enabling you to place a vertex using 
Absolute XY, Delta XY, or any of the other commands on that menu. Click the map again to start streaming.  
 
Feedback 
 

The Split tool on the Editor toolbar now provides feedback to indicate where a line will be split. As you move your 
pointer near the line, you will see a marker on the line (shown in black in the graphic below) at the place where it will 
be split. In addition, your pointer must be within the snapping tolerance distance for the split to be performed. 
Previously, you could click anywhere on the screen to split a feature when the Split tool was active, possibly resulting 
in splitting the feature in the incorrect spot. The snapping tolerance is defined on the General tab of the Editing Options 
dialog box. 

 
The on-screen feedback for the Fillet tool on the Advanced Editing toolbar has been improved, making it easier to 

see and construct the fillet line. The Fillet tool is used to create a curved line that is tangent to two line features. In the 
graphics below, the black line is the new fillet curve to be created between the red lines. 
 
ArcGIS 9.2:     ArcGIS 9.3: 

  
When constructing an edit sketch with the Sketch tool, the sketch’s segment length, total length, direction, 

perimeter, and area (depending on the type of feature) are shown in map units in the status bar at the bottom of the 
ArcMap window, along with a units abbreviation so it is clear what units these values are in. You need to hold down the 
A key to see the area when sketching a polygon, since area is not calculated automatically to maintain performance. 
Similar information is now shown in the status bar when creating features with the Circle and Rectangle tools on the 
Advanced Editing toolbar. 
 

 
 

When you click a row in the Snapping Environment window, the entire line is highlighted rather than just the layer’s 
name.  
 
ArcGIS 9.2:      ArcGIS 9.3: 
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In layout view, the onscreen feedback you see when you show a feature’s vertices by pressing the V key, or when 
you select or move features, now appears at an appropriate size. In some cases, such as when you have a reference 
scale set and zoom the layout page, vertices or feedback lines may have appeared too large on-screen in previous 
releases. 
 
 
Topology 
 

New keyboard shortcuts have been added to the Error Inspector dialog box. You can now navigate the list of errors 
and access commands on the shortcut menu using just your keyboard. Below are the new shortcuts: 
 

Up and Down arrows: Move up and down through the rows 
Z or Spacebar: Zoom to the selected error 
P: Pan to the selected error 
F: Select the parent features causing the error 
D: See a description of the topology rule 
X: Mark the error as an exception 
E: Mark the exception as an error. 

 
The Split Topology error fix respects the split policies that have been set up for the feature class and assigns 

attributes accordingly. 
 

You can now hold down CTRL and click any check box to check or uncheck all the boxes in the Show Shared 
Features dialog box. 
 

When you hover over a feature with the Topology Edit tool active, pressing V will now display its vertices. Seeing 
the vertices enables you to use snapping more effectively when editing topology. In addition, the search tolerance 
used by the topology tools has been increased, making it easier to select topology elements and errors. 
 

The number of selected topology elements is displayed in the status bar when using the Topology Edit tool. This is 
particularly helpful if you are zoomed out and multiple selected topology elements appear visually as a single element 
at that scale. 
 

 
 
 
Editing features that have z-values 
 

Z-values are maintained and assigned more logically when editing features in ArcMap. For example, extending a 
line will now extrapolate the z-value for the new vertex. In previous releases of ArcGIS, the z-value was assigned 0 by 
default.  
 

For more information on how ArcMap assigns z-values when editing, see the ArcGIS Desktop Help topic, 'Editing 
and data compilation > Getting started with editing > Editing features that have z-values.' 
 
In addition to the out-of-the-box z-editing enhancements, developers can enable a z-editing experience in ArcMap that 
includes additional methods of assigning and manipulating z-values. This allows you to capture z-values directly from 
an elevation surface such as a TIN or terrain. This functionality is available by writing your own code or installing a 
developer sample from the ArcGIS Desktop SDK.  
 

To learn more, see the document 'How to work with z-values in the editor on the ESRI Developer Network (EDNsm): 
http://edndoc.esri.com/arcobjects/9.3/NET/be988544-4964-4b55-9586-b7d499c6ed10.htm
At the time of writing, the EDN content was being modified. If that link does not work for you, please look in the 'For 
Developers' tab in the ArcGIS Desktop Resource Center at: http://resources.esri.com/arcgisdesktop
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Tables, joins and relates 

Better handling of field properties when you join tables 
 

When you join tables, field properties (field aliases, on/off state and numeric settings) are no longer dropped. These 
field properties are also preserved when a join is removed. Previously, field properties specified for layers and 
standalone tables were lost when joins were created or removed.  
 

When you define a definition query on a layer or standalone table that contains a join, field properties (field aliases, 
on/off state and numeric settings) are also no longer dropped. Field properties are also preserved when you remove a 
definition query from a layer or standalone table that contains a join. 
 
 
Definition queries respected by joins 
 

We have fixed the issue where definition queries on layers or standalone tables that you joined into another layer or 
standalone table were not respected. In 9.3 definition queries are handled correctly when joining. 
 
 
Properties of joins and relates shown in layer properties 
 

In the Joins and Relates tab in the Layer Properties dialog and the Table Properties dialogs, you can now review 
the properties of joins and relates, so it is easy to see the name, location and type of any tables that are joined or 
related to your table. These properties are read-only: 
 

 
 
 
Improved sorting functionality 
 

A new Advanced Table Sorting dialog lets you designate sorting on up to four fields at once. To access this dialog, 
right-click any field in the table window and choose the new Advanced Sorting command: 
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Shortcut to open this dialog: SHIFT + double-click any field name in the table window, or press CTRL + SHIFT + S. 
 

To unsort a sorted table, you can press CTRL + SHIFT + U, or open the Advanced Sorting dialog and select (none) 
for all the sorting criteria. 
 

ArcMap now remembers how you sort tables that you have opened, so that you do not have to re-sort them when 
you open them. Sorting a table window is persisted with the map document. Sorting is retained when you switch 
between Show All Records and Show Selected Records view. 
 
 
Toggle tables between showing field aliases or field names 
 

A new Show Field Aliases command in the table window Options menu let you choose whether the table will show 
fields with their aliases or the actual field names. This setting is stored as a property of each table so you can set it 
individually for each table as desired. By default this command is checked, so there is no change to the existing 
behavior you are used to.  
 

 
 
This command is particularly useful if you want to quickly toggle between field aliases and field names, so we have 
added two shortcuts to access it: hold down CTRL & right-click any field name, or press CTRL + SHIFT + N.  
 
Tip: To get a list of all the shortcuts available in the table window, click inside the window to give it keyboard focus and 
then press F1. To find out whether a particular command you access regularly via a menu in the table window has a 
shortcut, highlight the command in the menu and press SHIFT + F1 to get context sensitive help about it. (You can 
also find a list of tips and shortcuts in the ArcGIS Desktop Help and at the end of this document). 
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Other enhancements to joins and relates 
 

You can now create or remove joins and relates from the Options menu in the Attribute Table. Previously if you 
were working in a table window, you had to right-click the layer or standalone table in the Table Of Contents to access 
that functionality: 
 

 
 

The Advanced Options dialog launched from the Join dialog has been removed and the two options it contained: 
'Keep all records' and 'Keep only matching records' have been moved onto the Join dialog itself to make them easier 
and more obvious to access. You can still access the diagrams illustrating the difference between these options by 
clicking on them with the ? tool in the title bar of the dialog: 
 

 
 

The dropdown lists of fields in the Join dialog and the Relate dialog now respect field aliases specified for the layer 
or standalone table you are working with. Previously field aliases were not shown in those dialogs. 
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Calculate Geometry dialog supports more properties 
 

When you are working with line features, the Calculate Geometry dialog now gives you the option of calculating the 
XY coordinates of the start and end points of the lines. Right-click a field in the table window to access this dialog. 
 

 
 

You can now use the Calculate Geometry dialog to calculate a field to be an X or Y location in latitude/longitude if 
the target coordinate system is a projected coordinate system (PCS). This was not possible in 9.2. 
 
 
New commands for working with highlighted records in Show Selected mode 
 

Two new commands have been added into the context menu you get if you click the space to the left of any row in 
the table window. These commands becomes enabled when you are working in Show Selected records mode and you 
have highlighted a subset of records (shown in yellow by default) from the selected set (shown in light blue by default): 
 
- The Reselect Highlighted command selects the highlighted records and unselects all the other records. This 

enables you to refine the selected set by limiting it to the records you have highlighted. First highlight the records in 
the selection you want to keep. Then choose this command to reselect them. Shortcut: Press CTRL + SHIFT + R. 

 
- The Delete Highlighted command deletes the highlighted records. It only becomes enabled when you are in an edit 

session and have highlighted some records in Show Selected records mode. Shortcut: Press CTRL + DELETE. 
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Tip: Want to make your table wrap long field names and cell values around like in the screenshot above? In the table 
window, click the Options menu button, choose Table Appearance, and then set the Column Header Height and Cell 
Height to be, for example, 225%. 
 
 
Quick access to Field Properties dialog 
 

You can access the properties of a field in the table window by right-clicking its name and choosing the Properties 
command added in 9.2. The Field Properties dialog is useful because it lets you define an alias for the field, set the 
field's number properties, etc without leaving the table window. The following new shortcuts have been introduced in 
9.3 for that command so you can get to the Field Properties dialog more rapidly: 
 

ALT + Double-click field name  Open Field Properties dialog for field you clicked. 
CTRL + SHIFT + P  Open Field Properties dialog for the selected field. 

 
 
Microsoft Excel 2007 worksheets are now directly supported in ArcGIS. 
 

You can now access worksheets and Named Ranges defined in Microsoft Excel® 2007 directly in ArcMap or 
ArcCatalog. One particular advantage of this is that you are no longer limited to ~65,000 records as you were in Excel 
2003. Excel 2007 worksheets can support 1,000,000 rows. 
 
 
Identify dialog respects field properties when used to access related records 
 
When you right-click an entry in the left hand side of the Identify dialog in ArcMap, ArcGlobe, ArcReader and ArcGIS 
Engine applications, you will see a new checkable command that lets you choose whether or not the Identify dialog will 
show related data using the field properties (primary display field, field aliases, field visibility and number formatting) of 
the table or layer that represents that related data in your data frame. This is a long requested enhancement because 
previously you could not control how related data accessed via the Identify window was displayed. You can find the 
new option in the context menu you get if you right-click any entry in the tree on the left-hand side of the Identify dialog: 
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The new option is checked by default, so you will see this new behavior immediately. To return to the 9.2 behavior, 
uncheck this option. The setting is stored in the registry for the application.  
 
If you access related data while this option is checked on, and the related data is not represented in your map by a 
table or a layer, the fields are listed in the usual way because there are no field properties available for Identify to use. 
If multiple layers represent the related data when the option is turned on, an entry appears in the Identify dialog's tree 
under the relate for each of these layers so you can choose which one to use to view the related data. (Note: Definition 
queries in the table or layer providing the field properties are still not respected by the Identify dialog whether or not 
this setting is on or off). 
 
 
Other table window enhancements 
 

In 9.2 if you use the Field Calculator to calculate a text field and truncation occurs because the field length is too 
small to hold the calculated values, we added a warning message to let you know the situation and truncated values 
are flagged with a trailing asterisk * so you can easily find and fix them if necessary: 
 

 
 
At 9.3 we have added the ability for you to suppress the addition of the trailing asterisk. If you do not want the asterisk 
to be applied when truncation occurs, change the value for this DWORD registry key from 1 to 0: 
HKEY_CURRENT_USER\Software\ESRI\ArcMap\TableWindow\Flag truncated values with an Asterisk 
 
When this key is set to 1, you will still get the same warning message shown above when truncation occurs, but the 
asterisk won't actually be added. 
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Raster data 

Supported raster file formats  
 

ArcGIS 9.3 introduces better support for NITF and HDF formats by supporting subdatasets. Hierarchical Data 
Format (HDF) and National Imagery Transmission Format (NITF) both have the capacity to store multiple images 
(subdatasets) within one file. These subdatasets represent images taken in different bands, or at different times and 
angles, or photographs of objects.  
 
ArcGIS 9.3 supports these formats and allows you to display the subdatasets and also extract subdatasets from the 
file to create standalone raster datasets. When adding an HDF or NITF file that contains subdatasets into ArcMap, you 
will be prompted with the following dialog box:  
 

 
 
From this dialog box you can choose to select one subdataset to display as a raster layer, or select multiple 
subdatasets to display as a group of raster layers. A standalone raster dataset can be created from any of the 
subdatasets by adding it to the map and using the Export Data command.  
 
The new Extract Subdataset geoprocessing tool lets you create standalone raster datasets from HDF or NITF 
subdatasets. This is useful for scripting or batch processing purposes. An NITF file may also contain Computer 
Graphics Metafile (CGM), these CGM graphics will be added as graphics layers when the NITF raster dataset is added 
into ArcMap. 
 

ArcGIS 9.3 now supports the ENVI format. ENVI is read-only in the ArcGIS user interface. Writing to ENVI format is 
available for developers.  
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Support for ArcGIS Server image services 
 

In 9.3, the ArcGIS Image Server has been more tightly integrated with ArcGIS Desktop and ArcGIS Server. ArcGIS 
Image Server is an extension to ArcGIS Server that enables raster data to be served over the web in a format that 
allows full image processing and manipulation in client applications. When you connect to an ArcGIS Server in 
ArcCatalog, you will see any image services available on that server shown as icons like other services. 
 

Raster geoprocessing tools and Spatial Analyst tools now support layers based on ArcGIS Server image services 
as inputs. You can use the new Make Image Server Layer tool in the Data Management Tools > Layers and Table 
Views toolset to create an ArcGIS Server image service layer in a script or model for input into tools. 
 

You can export from an ArcGIS image service to a raster dataset using the Export Raster Data dialog. 
 
See the 'ArcGIS Image Server' chapter of this document for more information. 
 
 
Support added for OGC WCS  
 

The OGC WCS (Web Coverage Service) standard for distributing raster data collections on the Internet is now 
supported in ArcGIS. When you add a WCS service into ArcMap or ArcGlobe it is treated like any other raster data 
source. The layer properties dialog for a layer referencing a WCS service is the standard one used for all rasters. 
Raster geoprocessing tools and Spatial Analyst tools support WCS layers as inputs. You can use the new Make WCS 
Layer tool in the Data Management Tools > Layers and Table Views toolset to create a WCS layer in a script or model 
for input into geoprocessing tools and functions. You can also export from an OGC WCS service to a raster dataset 
using the Export Raster Data dialog.  
 
An Add WCS Server command has been added into the GIS Servers folder in ArcCatalog. WCS Server connections 
are shown with a green server icon in ArcCatalog and you can expand the server to see all the individual WCS 
services it contains. For example, you can connect to the Atlas of the Cryosphere WCS being served by the US 
National Snow and Ice Data Center (NSIDC) by entering the following URL in the Add WCS Server dialog: 
http://nsidc.org/cgi-bin/atlas_north?service=WCS&request=GetCapabilities&?  
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Creating a raster mosaic from a raster catalog 
 

A new geoprocessing tool has been added to aid in creating raster mosaics. The Raster Catalog to Raster Dataset 
tool in the Raster Dataset toolset allows you to create a new raster dataset by mosaicking all or a selection of items 
from a raster catalog. For creating a file based raster mosaic, the recommended workflow is to first create an 
unmanaged raster catalog containing the rasters you wish to mosaic. Then use the Raster Catalog to Raster Dataset 
tool to mosaic that raster catalog to a new raster dataset. This workflow is more efficient than using the pre-existing 
Mosaic to New Raster tool. The existing workflow is to create an empty raster dataset and then use the Workspace to 
Raster Dataset tool to fill that empty dataset with a mosaic. This is still the recommended method for creating a raster 
dataset in an ArcSDE or file geodatabase if the inputs are raster datasets. 
 

A new command has been added to the context menu of the raster catalog layer called Mosaic Raster Catalog. This 
command opens a dialog box similar to the Export Data dialog box, from which you choose mosaicking and output 
options to create a new raster dataset. The new dataset can be a mosaic of the entire raster catalog or of selected 
rasters. The dialog also supports clipping the output with the current data frame or a selected graphic, offering an easy 
method to clip a portion of a raster catalog: 
 

 
 

 

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 38 



Image color balancing and matching 
 

In order to create a seamless mosaic, ArcGIS 9.3 provides color balancing and color matching capabilities. A Color 
Correction tab has been added to the Properties page of the raster catalog layer. You can perform color balancing and 
color matching of the raster catalog on the fly to explore the color correction options and choose one that works best 
for your data. Once the color correction parameters are decided, you can mosaic images using the Mosaic Raster 
Catalog command from the raster catalog layer context menu, or the new Raster Catalog to Raster Dataset 
geoprocessing tool. 
 

 
 

The Workspace to Raster Dataset tool and Mosaic tool include the new color matching options. 
 
 
Clipping rasters 
 

A new option on the Export Raster Data dialog box allows you to define the extent of your exported data by using 
the currently selected graphic(s) drawn on your map to clip the raster. This is very convenient as you can draw any 
shape and use it as the extent for clipping a raster dataset. We have also added a NoData input box. When clipping 
graphics using an irregular shape, pixels outside of the clipping geometry will be filled with a NoData value. When 
exporting your data via selected graphic to a file-based raster dataset, it is recommended that you enter a NoData 
value. When a graphic is used to clip your data, NoData pixels will most likely exist in the output. Specifying the 
NoData value will allow you to control the pixel depth and the value that will store NoData. If a NoData value is not 
specified, the program will find an empty value to use as the NoData placeholder, which may not be desired: 
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The raster Clip tool has been enhanced with an Enable Clipping Geometry check box. This box becomes available 
when an existing feature class is chosen as the Output Extent. If the Enable Clipping Geometry box is checked, then 
the actual geometry of that feature class will be used to clip the raster instead of using the feature class’s extent: 
 

 
 
 
New tools for unmanaged raster catalogs 
 
For an unmanaged raster catalog, when referenced raster datasets are moved, the associated raster catalog items will 
become invalid because the links to the referenced raster datasets are broken. In order to repair the unmanaged raster 
catalog without reloading data, 9.3 provides two new geoprocessing tools: 
 
- The Export Raster Catalog Path tool will output the paths of the referenced raster dataset to a .dbf file. You can 

choose to export paths for all the raster catalog items or to export only those that have broken links. 
 
- The Repair Raster Catalog Path tool allows you to update the path for the invalid raster catalog items or remove the 

invalid raster catalog items.  
 
 
Export Raster World File tool 
 

A new tool called the Export Raster World File lets you export world files that can be used in non-ArcGIS 
applications. This tool will export a standard world file if the transformation in the raster dataset is a first order 
polynomial transformation, but since a world file cannot store a 2nd or 3rd order polynomial, or a non-polynomial 
transformation, the tool will instead export what is called an “approximate world file” signified by adding an x to the file 
extension. These approximate world files can be used in non-ArcGIS applications by removing the x from the 
extension name.  
 
 
Get Cell Value tool 
 

A new tool called Get Pixel Value lets you retrieve a pixel value at the specified XY coordinate. For a multiple band 
raster dataset, you can retrieve the pixel value for a specific set of bands, or for all the bands. This allows you to 
retrieve a pixel value via geoprocessing, which can be helpful if it is needed in a geoprocessing model.  
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Discrete color renderer 
 
A discrete color renderer has been added to the Symbology tab of the Layer Properties dialog. The discrete color 
renderer uses a set of colors to display any integer type of raster dataset. When using the discrete color renderer you 
can specify the number of colors you wish to use in the rendering as opposed to having the unique values renderer 
calculate the total number of unique values in the raster dataset. The discrete color renderer will repeatedly cycle 
through the selected color scheme for the amount of colors specified. Since the discrete color renderer uses a set of 
colors repetitively instead of a single color for each unique value, the raster will be displayed with a similar look as 
when using the unique values renderer, but will display much faster: 
 

 
 
 
Other  
 

The Unique Values renderer now supports floating point data at ArcGIS 9.3. Since floating point raster datasets do 
not have a raster attribute table, a dialog will prompt you to compute unique values when the Unique Values renderer 
is selected. 
 

 A Switch To dropdown list been added next to the Source Type property on the Raster Dataset Properties dialog 
ArcCatalog allowing you to change the data source type for rasters saved in a file-based format. For most file-based 
raster formats, the resampling method used in building pyramids is based on the data source type. If a raster dataset 
has only a few unique values, the nearest neighbor resampling method should be used to build pyramids. Therefore, if 
your dataset only has a few unique values it is recommended that you click the Switch to button to change the data 
source type to discrete before you build pyramids: 
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A check box has been added to the Tools > Options dialog Raster tab to control the default stretch behavior for the 
raster stretch renderer. This box is checked by default but it can be turned off if you do not want to use the standard 
deviation stretch as the default stretch type: 
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The tools in the Data Management Tools > Raster toolset have been organized into four toolsets to make it easier 
to access them: 
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Mapping 

Graphics 

New Convert Graphics To Features command lets you create features without editing 
 

A new command lets you convert graphics drawn on your map into features, making it easy to quickly create simple 
datasets, study areas, clipping extents, etc, without having to go to ArcCatalog to create a new a shapefile or feature 
class and start an edit session to add new features to it. You can access this command by right-clicking a data frame 
in the Table Of Contents or in the Drawing pulldown menu on the Draw toolbar. The dialog lets you convert point, line, 
polygon graphics drawn on your map into a new shapefile or feature class. It also lets you convert text graphics into an 
annotation feature class in a geodatabase: 
 

 
 

The dialog supports all the graphic types you can draw with the tools in the graphics palette in the Draw toolbar, 
including circles, curved lines and freehand lines.  
 
When you convert text graphics to annotation with this dialog, you also get the option to convert the currently selected 
point, line and polygon graphics into the annotation feature class. This enables you to create one annotation feature 
class containing text and associated graphics. 
 
Convert Graphics To Features also supports 3D graphics, such as contour lines drawn on the map using the Contour 
tool in the 3D Analyst extension's toolbar: If any of the graphics you convert are 3D, the output shapefile or feature 
class is automatically 3D (i.e. Z values are enabled).  
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When you convert points, lines or polygons with the Convert Graphics To Features dialog, it automatically adds a 
field called Name into the shapefile or feature class it creates. It also automatically populates this field with the Element 
Name in the Graphics Properties Size and Position tab for each graphic that it converts. This is useful because it 
enables you to assign names to the features you generate without having to start an edit session on the output feature 
class.  
 
For example, imagine you want to define a feature class containing three rectangular study areas, A, B and C: 
 
1. Using the Rectangle tool in the Drawing toolbar, draw the three study areas on your map. When you use the 
drawing tools, remember you can also enter coordinates by pressing SHIFT + F6 and typing them in instead of 
clicking. (To find the keyboard options available for a drawing tool, choose the tool in the drawing palette and then click 
the tool with the Whats This ? Help tool in the Standard toolbar). 
 
2. After you have drawn each study area, double-click it to open its Properties dialog. In the Properties dialog, go to the 
Size and Position tab and type in the name of the study area in the Element Name field. 
 
3. If there are other polygon graphics in your map that you do not want to convert, select the three study areas you 
have just drawn and choose Drawing > Convert Graphics To Features. Specify the destination shapefile or feature 
class you want to create and press OK. 
 
The Name field of the output you create will automatically contain the names you specified for each graphic. 
 
In addition, dialogs and tools that add graphics to ArcMap now automatically populate the Element Name. So when 
you find an address using the Find dialog and add a graphic point onto your map to represent that address, the 
address is automatically used as the Element Name of the point graphic. Similarly if you use the Go To XY dialog to 
type in a coordinate location and add a point graphic onto the map to show the location, the coordinates you typed in 
are automatically used as the Element Name of the point. In this way, if you then convert those point graphics to 
features using Convert Graphics To Features, the information you typed into the dialog to locate the points is 
automatically used to populate the Name field of the output shapefile or feature class. For example, if you use the Find 
dialog to locate four addresses, you can then convert the resulting four point graphics into a feature class, and each 
point in the feature class will automatically have a Name attribute showing you the address that you originally typed in. 
See below in this section for a complete list of dialogs that automatically populate the Element Name when graphics 
are created. 
 

The Convert Graphics To Features dialog makes it easy to quickly add transparent shapes to your map in Data 
view. ArcMap does not support transparent graphics, but now you can easily draw a graphic, use Convert Graphics To 
Features, then make the resulting layer transparent. 
 

 
Easier to get the coordinates and geometry of graphics you draw 
 

When you draw a line graphic on a map or use a tool or dialog that adds a line graphic to your map (such as the 
Contour tool in the Spatial Analyst extension toolbar or the Find Steepest Slope in the 3D Analyst extension toolbar) 
you can now easily get its length, start point coordinates and end point coordinates in the units of your choice. This is 
supported for all line graphics types (straight lines, curves, freehand, etc).  
 
As you can see from the screenshot below, you can choose the units for each value shown, including the XY 
coordinates, which can be viewed in units like US National Grid (USNG) and Military Grid Reference System (MGRS). 
(If the graphic is drawn on the layout page the units choices will be in page units). Also at 9.3 these dialogs remember 
the units you have chosen between sessions, so you can set them once and those units will always be used. 
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You can now find the coordinates of any point graphic drawn on your map in the units of your choice by opening its 
properties dialog and looking in the new Location tab. 
 

 
 
If the point graphic is a 3D point, you will also see the height of the point shown in the Location tab. In the example 
shown above, the point graphic was added to the map with the Interpolate Point tool in the 3D Analyst extension 
toolbar, so the Height field shows the height at that point's location derived from the active surface layer in the map. 
 

In the Size and Position tab for new graphic points drawn in 9.3, the anchor point now defaults to be the center 
anchor point instead of the bottom right anchor point. This enhancement has no impact on existing point graphics. 
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The existing Area tab in the properties dialog for a polygon graphic has also been enhanced to provide the same 
functionality as the similar tabs in the line and point graphic properties dialog: 
 
 

 
 
 

If your data frame is unprojected, i.e. it is using a geographic coordinate system (GCS) rather than a projected 
coordinate system (PCS), the line lengths displayed in the status bar and in the new Length tab listed above is 
calculated in true geodesic distance on the spheroid. This is also true for perimeters when you are working with 
polygon graphics. In other words, when your map is not projected, the lengths and perimeters graphics are the correct 
length on the surface of the earth.  
 

When you draw a line graphic, the length of each segment is now displayed in the status bar in addition to the total 
length of the line.  
 

You can now customize the ArcMap status bar so that the XY coordinate display uses different units than the units 
used to report the length, perimeter and area of graphics as you draw them with the drawing tools. Previously the 
same units - the Display units specified for the data frame - were always used for both the XY coordinate display and 
the length, perimeter and area report. This was sometimes inconvenient because if you wanted, say, line lengths to be 
reported in miles as you draw line graphics, the XY display was therefore also in miles, and if you wanted the XY 
display be in Decimal Degrees, the line length was therefore reported in Decimal Degrees too. At 9.3 there is a new 
option in the Tools > Options dialog Data View tab that lets you override the Display units for the XY display and use 
the units of your choice instead. This setting is turned off by default so there is no change to the existing behavior of 
unless you turn this setting on. The setting is stored as a property of the map document: 
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In the example below, the data frame's Display units are set to miles so that you can draw lines and see their length 
reported in miles, but DMS is being used for the XY display so you can see the cursor location in spherical 
coordinates: 
 

 
 
Note: This option does not affect the units used to report the length, etc of features you create or edit using the Editor 
tools. When you edit features, their dimensions are reported in the map units of the data you are editing.  
 
 
More use made of the Element Name property of a graphic 
 

In 9.2 we exposed the Element Name property of graphics in the Size and Position tab in the graphic properties 
dialog. At 9.3 we now take more advantage of this property to store names for graphics you draw on the map: 
 
- If you use the Find dialog to add a point to your map showing the location of a place or an address, the Element 

Name property of that point graphic is now automatically populated with the place name or address that you 
specified. In this way for example you can easily find out which address a particular point graphic represents after 
you added it to a map simply by opening the properties dialog of the point: The Element Name property of a graphic 
is automatically shown in the title bar of its properties dialog in addition to being shown in the Size and Position tab. 
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- If you use the Go To XY dialog to add a point to your map at a particular coordinate location, the Element Name 

property of that point graphic is now automatically populated with the coordinates you entered, giving you a record of 
the exact coordinates that were specified. 

 
- If you use the Contour tool on the Spatial Analyst extension toolbar or the 3D Analyst toolbar, the Element Name 

property of that point graphic is now automatically populated with the height of this contour. Similarly if you use the 
Interpolate Point tool on the 3D Analyst extension toolbar, the height of the resulting 3D point graphic is entered into 
its Element Name property. 

 
- If you add places from the Tools > My Places dialog onto the map as graphics, the Element Name property of each 

of the graphics is now automatically populated with the name of the place as it appeared in your My Places dialog. 
 
- If you add a graphic from your map into the Tools > My Places dialog as a place, the name of that place is 

automatically obtained from the Element Name of the graphic. If the graphic's Element Name is not populated, the 
new place defaults to being called 'My Place'.  

 
These additional uses of the name property for graphics are especially useful in these scenarios: 
 
-  When you use the new Convert Graphics To Features dialog, the Element Name of each graphic is used to 

automatically populate a name field in the resulting shapefile or feature class.  
 
- If you have added a point graphic to a map showing, say, a particular address, and you decide you would like to 

label this point with its address, you can simply open its properties dialog, copy its Element Name property, close the 
properties dialog, click with the Text tool and paste the text onto the map. 

 
 
Other graphics enhancements 
 

When you create a new, empty map at 9.3 the default point graphic symbol is now a small green simple marker with 
a black outline. Previously the default was a larger solid black symbol. This didn't look very good, especially when 
drawing point graphics on top of dark backgrounds or dense street networks. As in previous releases, you can change 
the default symbols used for graphics in a map document by using the Drawing > Default Symbol Properties dialog: 
 

 
 
Each map document has its own set of default symbol properties for graphics and so this change has no effect on your 
existing maps, or on new maps you create with your own templates. 
 

The option to keep the graphic drawing tools in the Draw toolbar active after you use them is now exposed in the 
ArcMap Tools > Options dialog General tab. When this option is unchecked (which is the default, the same as in 9.2) 
the Select Elements tool is automatically selected after you have drawn a graphic so that you can immediately move or 
manipulate it. When this box is checked a drawing tool remains active so you can draw multiple graphics with the tool 
until you manually change to a different tool. Note: this setting applies to all your ArcMap sessions, not only your 
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current map document. You will also find this option in the ArcGlobe and ArcScene Tools > Options dialog General 
tab. This setting was previously made in the arcgis/utilities/AdvancedArcMapSettings utility.  
 

 
 
 

Bookmarks 

Easier to access bookmarks 
 

Spatial bookmarks have a number of uses, from making it easy for people to navigate maps that you publish, to 
helping you give presentations and demos using the software. Previously, bookmarks were accessed via the 
Bookmarks pullright in the View pulldown menu. This pullright has been removed and turned into a Bookmarks 
pulldown menu, making it much easier and quicker to access bookmarks. This new Bookmarks pulldown menu is also 
in ArcGlobe, ArcScene and ArcReader. 
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Note: In previous releases, you could customize ArcMap to move the Bookmarks pullright out of the View menu and 
into the main toolbar. If you have done that and you find that you now have two Bookmarks pulldown menus in your 
main menu bar after installing 9.3, simply choose Tools > Customize and then right-click one of the Bookmarks menus 
in the main menu bar and choose Delete. 
  
 
Better bookmark management 
 

The Bookmarks Manager dialog now lets you sort bookmarks and also reorder them manually. You can also import 
and export bookmarks to share them with other people, copy them between different data frames in the same map 
document, or copy them between different ArcMap, ArcGlobe and ArcScene documents. You can also now use the 
Bookmark Manager to pan to bookmarks (i.e. recenter the map on the center of a bookmark without changing the 
scale of the map): 
 

 
 

The Bookmarks Manager is now 'non-modal', so you can keep it open while you work on your map to provide easy 
access to bookmarks. You can double-click a bookmark in the Bookmarks Manager to zoom to it on the map. 
 

In the Bookmarks Manager, you can right-click a bookmark and choose Update Extent to update its extent to match 
the current extent of your map. Previously if you wanted to update a bookmark's extent you had to delete it and 
recreate it: 
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The file used for saving and loading bookmarks is the same file format used for saving and loading places in the 

Tools > My Places dialog. This makes it easy to copy bookmarks into the My Places dialog so that they are available 
irrespective of which map document you are using. The My Places dialog was introduced in 9.2 to enable you to 
access a useful set of spatial extents, locations, addresses, etc at any time irrespective of which document you are 
using. Unlike bookmarks, the places in the My Places dialog are stored centrally, not in the map document you are 
using. When you load bookmarks into the My Places dialog they become spatial extent places.  
 
You can go the other way too: you can save one or more places from your My Places dialog and load them into the 
Bookmark Manager. For example, you may have created a set of places and now you want to add them into the map 
as bookmarks so that they can be used by the people you share the map document with. When you load line or 
polygon places into the Bookmark Manager, their envelope extent becomes the bookmark. When you load point 
places into the Bookmark Manager, an extent is automatically generated for the resulting bookmark. 
 

Tip: This functionality makes it easy to create bookmarks from features. For example, you may have a number of 
counties in your map and want to create a bookmark for each county: 
 
1. Select the county features in ArcMap using any selection method. 
 
2. Open Tools > My Places and add the counties into the dialog by choosing Add From > Selected Features 
 
3. If desired, rename the places that were added (their name defaults to their value for their primary display field).  
 
4. Choose Save > Save Selected and save the places you just created to a file. 
 
5. Choose Bookmarks > Manage and in the Bookmarks Manager dialog load the places in as bookmarks. Each 
county becomes a bookmark. You can sort or reorder the bookmarks in any way you like. 
 

Tip: You can also use this functionality to add graphic rectangles to your map showing the location of bookmarks, 
which can also be converted into polygon features: 
 
1. Choose Bookmarks > Manage and save the bookmarks you want to draw on the map to a file. 
 
2. Choose Tools > My Places and load the bookmarks in that you just saved. 
 
3. In the My Places dialog, select the bookmarks and then choose Add To Map > As Graphics. They are drawn on 
your map using the current polygon symbology specified in Drawing > Default Symbol Properties. 
 
4. To convert the graphics you have added to features, choose Drawing > Convert Graphics To Features. 
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Scale  

Full support for entering and displaying scale in relative format throughout ArcMap 
 

At 9.2 we introduced the ability to enter scale in relative format (e.g. 1 inch = 100 miles) wherever scale is specified 
in ArcMap's user interface. Relative scales entered into scale controls anywhere in the ArcMap 9.2 user interface were 
automatically converted to the equivalent absolute scale. At 9.3 we have added the ability for ArcMap to report scales 
in relative format. You can customize the scale control throughout ArcMap's user interface to use relative format 
instead of absolute format. In the Scale dropdown, choose the Customize This List command: 
 

 
 
The Scale Format tab lets you choose from a set of pre-defined formats, and you can edit these and define new ones: 
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Remember that you can enter scale into the scale controls in ArcMap's user interface in any format irrespective of what 
scale format is currently being used to display scales. The scale you enter will automatically be converted into your 
current scale format. So you can still enter scales in relative format, in any units, even if you prefer to keep the scale 
displayed in the scale controls in absolute format. When you type or paste in scales, a variety of unit abbreviations and 
characters are supported with the aim of making it easy to type or paste in scales directly without having to reformat or 
recalculate them. 9.3 adds support for using the characters ' and " to indicate inches or feet, and those characters are 
supported in both 'straight' and 'curly' format to better support copying and pasting scales from Word documents and 
PDF files. To see a list of supported formatting, click the scale control in the Standard toolbar with the What's This? 
Help tool , or click a scale control in any dialog with the ? tool accessed from the title bar of the dialog. 
 
Note that customizations you make to the list of pre-defined scales and how scale is displayed are stored as ArcMap 
settings on your computer. These settings are not stored in the map document itself, and so will not be in effect if the 
map document is opened on a different machine. 
 
At 9.2 it was possible to make ArcMap display scales in relative format by using a registry setting to define the format. 
If you did specify a relative format using the system registry in 9.2, the format you specified will automatically appear in 
the Scale Settings dialog Scale Format tab (unless it matches one of the standard formats already provided in that 
dialog). 
 

When a scale control is disabled, such as the two scales in the example below which shows the layer properties 
dialog for a sublayer in an ArcIMS image service accessed in ArcMap, we have enhanced the control so that you can 
drag over the scale and copy it for pasting elsewhere, such as into the main scale control in the Standard toolbar. In 
9.2 when a scale control was disabled it was not possible to copy the scale out of the control for pasting elsewhere. 
 

 
 

Absolute scales have been hardwired now to always use two decimal places when their value drops below 1:100. 
Previously ArcMap would show up to 6 decimal places when the value dropped below 1:100, an unnecessary level of 
precision for an absolute scale ratio.  
 

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 54 



Layouts 

In the Scale Text map element you can now specify the text used to separate the different sides of the scale text as 
a property of the element. Previously if you added scale text to your map in relative format, the separator text always 
said 'equals' and so if you wanted the text to say '1 inch = 100 miles' instead of '1 inch equals 100 miles' you had to 
convert the scale text element to graphics. In Scale Text elements, the separator used for both relative scales and 
absolute scales can now be specified: the default separator is '=' for relative scales and ':' for absolute scales. We have 
also updated the default set of scale text styles so that most of them use the '=' separator. 
 

 
 
 
Control whether elements like scale bars will be scaled to fit the page when you add them 
 

In order that map element styles can be utilized in a variety of different maps and page sizes, ArcMap has always 
automatically scaled the font size and some other size properties of north arrows, scale bars and scale text elements 
when you add them into a map according to the size of the page. This is useful because it means that different styles 
do not have to be stored for every possible size and the same style can be used on different size maps. For example it 
allows the same style to be used on a poster-sized page and on a smaller map. However, it can be annoying that the 
font size you specify for the map element can change size depending on the size of the map. At 9.3 we now allow you 
to control this via a new 'Scale to fit page' check box in the Selector dialog you see when you add a north arrow, scale 
bar or scale text element into a map. This new option is checked by default, to match the 9.2 behavior. Uncheck this 
box if you want the size properties of the map element you are adding to be respected irrespective of the page size. In 
this way you can be sure that the north arrow, scale bar, or scale text you are adding will be the exact size on the map 
as they are specified in the style you are using: 
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This setting is not a property of the map element you add to your map. It just controls how the size specified in the map 
element's style will be handled at the time you add it into your map. So if you add a map element and look in its 
properties dialog, you won't see this option in there. 

Note: If you change the size of the page used by your map document, the elements in your map may be scaled to fit 
the new size. This depends on whether or not the 'Scale map elements proportionally to changes in page size' check 
box is checked or unchecked in the File > Page and Print Setup dialog. If that box is checked, then map elements will 
be scaled when you change page size irrespective of whether or not the 'scale to fit page' option was checked or 
unchecked when you added the elements. 

 
Symbols in legends now automatically reflect layer transparency 
 

Symbols in legend on the map, and in the Table Of Contents, are automatically drawn with lighter colors if you 
make the layer partially transparent, so they look more like the actual symbols drawn on the map. 
 
This is a new setting in the Data Frame Properties dialog General tab. It is turned on by default for new data frames 
you create in 9.3. It is turned off for existing data frames (so the legends of your existing maps look the same until you 
manually choose to use this option): 
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Easier to reorder legend items 
 

New buttons have been added next to the legend items list in the Legend Properties dialog and Legend Wizard that 
let you move the currently selected item(s) to the top or bottom of the list with one click. The buttons for moving items 
up and down have also been enhanced so that they now work when multiple items are selected in the list: 
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Option for setting the amount of densification for graticules  
 

Graticule lines have vertices added every 1 degree by default to allow the lines to bend to better fit the curvature of 
the graticule. In some cases, such as large scale maps or precise data the amount of densification needs to be 
increased to better fit the graticule to the data. Starting at 9.2 Service Pack 4, we have therefore introduced a new 
registry setting that you can specify to increase the amount of densification. You won't see this setting in the registry 
after installing the service pack. You have to create the registry setting manually: 
 
HKEY_CURRENT_USER\Software\ESRI\ArcMap\Settings\Graticule\DensificationDistanceInDegrees 
 
Giving this REG_SZ registry key a value of 0.1, for example, tells ArcMap to place vertices every 10th of a degree. 
Valid values are from 0.01 to 5. 0.01 means the graticule gets vertices placed every 100th of a degree and can 
seriously impact performance when working with a map that covers a large area, such as a world map. For this reason 
we recommend that you use finer levels of densification only when you can see on the map that the graticule does not 
quite line up with your data. When this registry setting has not been specified, or when it has a value of 1, graticules 
will appear the same as they do in 9.2.  
 
 
 

Accessing attributes and hyperlinks from features 

New HTML Popup tool 
 

HTML popups are small windows containing HTML and web content, allowing you to take advantage of HTML 
formatting, links and multimedia to display the attributes of geographic features and related information. An HTML 
popup has a leader line pointing to the feature it is linked to.  
 
In 9.3 you can define HTML popups for any feature layer and access them using the new HTML Popup tool  in the 
Tools toolbar: 
 

 
  
To enable HTML popups for a feature layer, double-click the layer to open its properties, go to the new HTML Popup 
tab in its Layer Properties dialog, and check the box at the top of the tab. Any HTML formatting stored in text fields in 
the feature's attributes is respected in the HTML popup window, and any attribute containing complete URLs are 
displayed as clickable links in the popup window. HTML popups can also be defined to display the contents of URLs 
accessed over the Internet, in which any part of the URL can be a value supplied from one of the layer's attributes.: 
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The default HTML popup for a feature layer is a simple HTML table of the feature's attributes: 
 

 
 
In the example below, this option has been used to specify that the popups will contain the Wikipedia entry for the 
place name supplied by one of the layer's fields: This is similar to a hyperlink except that the context is displayed inside 
an HTML popup instead of launching a web browser. It can also be more convenient than a hyperlink because the 
prefix and suffix parts of the URL are specified as layer properties and the whole URL definition is contained within the 
layer if it is saved to a layer file and loaded into another map: 
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Customized HTML popups can also be defined using an XSL template specified in the Layer Properties dialog HTML 
Popup tab. HTML formatting stored as attributes in the layer is respected when the values from the attribute are 
displayed in the popup. For examples of XSL templates and possible customizations, refer to the HTML Popup folder 
in your \ArcGIS\Styles directory. This folder also contains the popup.xsl file used for the default HTML table option. 
 
Like the Hyperlink tools, when you select the HTML Popup tool, any features in the map that have HTML popups 
defined for them are shown in blue or outlined in blue in the case of polygons. To specify that a different color be used 
or to prevent features with HTML popups changing color, use the option in the Tools > Options dialog General tab.  
The HTML Popup tool also uses the selection tolerance specified in pixels in the Selection > Selection Options dialog. 
HTML popups remain open as long as the HTML Popup tool is selected. You can have multiple HTML popups open at 
the same time.  
 
Defining HTML popups is particularly useful if you will be converting feature layers and maps to KML files or serving 
maps in KML format using ArcGIS Server, as the popups are accessible via KML clients. HTML popups are also 
supported in ArcGlobe and ArcScene. 
 
 
Identify tool enhancements 
 

The Identify dialog now respects field properties when used to access related records. For details, please see the 
'Tables, joins, and relates' section in the Data Management chapter above. 
 

When you have identified a feature in the Identify dialog you can now launch the properties dialog and attribute 
table of the layer it belongs to directly from the Identify window without having to go and find the layer it belongs to in 
the Table Of Contents: 
 

 
 

This can speed up your work when your map contains a large number of layers. For example, if you see a feature on 
the map that you would like to change the symbology, labeling or attribution for, you can simply identify it to find out 
what layer it belongs to, and then right-click the layer to open the layer properties dialog or attribute table in order to 
make any desired changes to the layer. These commands are not available in ArcReader or ArcGIS Engine 
applications. 
 

The way you sort the attributes listing in the right-hand side of the Identify dialog is now persisted between your 
sessions so, for example, if you sort the fields in alphabetical order, then the Identify dialog will use that sort order until 
you use a different sorting. 
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Hyperlink tool enhancements 
 

Hyperlinks can now contain parameters that tell the document how to open. For example, if linking to an Adobe 
PDF, a specific page can be specified. The parameter for a PDF is:  
 
\test.pdf?<space>/A<space>”Page=<Page#>=OpenActions” 
 
The ‘?’ serves as the parameter delimiter. The actual parameters depends on the software that launches the linked 
document. Hyperlinks that contain application parameters are generally not backwards compatible and so can only be 
reliably accessed in 9.3. 
 
 

Labeling 

New Pause Labeling command 
 

You can now temporarily turn labeling off with the new Pause Labeling command. While this command is turned on, 
labeling is suspended in ArcMap. While labeling is suspended, you can continue to work with the program, but the 
labels are not redrawn, so panning, zooming or any other operation that involves redrawing the map can be much 
faster. This command works in both Data View and Layout View. The Pause Labeling command is in the Labeling 
toolbar and in the Labeling pullright accessed by right-clicking a data frame in the Table Of Contents. 
 

 
 
Better halos 
 

The drawing performance and quality of text halos has been improved. Users of annotation and the Maplex or 
Standard labeling engine will benefit from this change. (Originally introduced in 9.2 Service Pack 4). 
 
See the 'Maplex For ArcGIS' chapter of this document for the advanced labeling enhancements at 9.3. 
 
 

Symbology 

Two new line symbols have been added to the ESRI style and serverstyle. They are: Arrow Right Middle and Arrow 
Left Middle. The arrows will always be placed in the center of the line segment regardless of length, excluding those 
lines that are too short for the decoration. While you will not be able to change the position of the marker on the line, 
other common properties such as the marker symbol, marker color, marker angle, marker size, line color, line width 
and dash template can still be edited. 
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Cartographic representations 

The improvements to cartographic representations are found in four areas of functionality: editing, display, 
geoprocessing, and geodatabase. 
 
 
New representation editing functionality 
 

The representation editing tools on the Representation toolbar now provide WYSIWYG feedback for all 
representation editing tool operations with all representation symbol layers. Now, when editing feature representations 
on a map, you see the symbology of the feature instead of the wireframe outline to see how the edit will impact your 
map. The new Representation Options dialog box lets you change the mode of visual feedback when performing 
editing operations with representation editing tools. The default setting is WYSIWYG. 
 

  
 

The size of vertices and selection handles for selected feature representations can now be larger than the behavior 
provided in ArcGIS 9.2. The vertices of the selected feature representation will be the same size as those seen with 
the Editor Select tool when the Edit Task is set to Modify Feature. The new Representation Options dialog box lets you 
change the mode of visual feedback when selecting features with representation selection tools. The large size is the 
default. Small vertices and selection handles are useful when the representation symbology should not be obscured 
during editing. 
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Vertices – Large   Vertices – Small  Vertices – Editor Selection 

 
All representation dialog boxes now accept entry of measurements in the following page units: millimeters, 

centimeters, inches, and points. Map units are not supported. You can enter values in a different unit of measurement 
than that specified by the feature class representation property. The dialog will convert the entered value and unit of 
measurement into the equivalent value in the unit of measurement specified by the property. 
 

There are new shortcut keys to switch between individual representation tools, to switch amongst the variations of 
the activate representation tool, to access the context menu of the active representation tool, and to open the 
Representation Properties dialog box. Pressing the shortcut key activates the primary tool; pressing a second time 
activates the secondary tool or the context menu for the primary tool: 

• Press G to switch to the Select tool. Press G again to switch to the Direct Select tool. 
• Press L to switch to the Lasso Select tool. Press L again to switch to the Lasso Direct Select tool. 
• Press I to switch to the Insert Vertex tool. Press I again to switch to the Delete Vertex tool. 
• Press U to switch to the Insert Bezier tool. Press U again to switch to the Delete Bezier tool. 
• Press Y to switch to the Insert Control Point tool. Press Y again to switch to the Delete Control Point tool. 
• Press W to switch to the Warp tool. 
• Press P to switch to the Move Parallel tool. 
• Press E to switch to the Erase tool. 
• Press K to switch to the Mask tool. 
• Press R to switch to the Rotate tool. Press R again to open the Angle dialog. 
• Press O to switch to the Orient tool. Press O again to open the Angle dialog. 
• Press S to switch to the Resize tool. Press S again to open the Ratio dialog. 
• Press M to switch to the Move tool. Press M again to open the Offsets dialog. 
• Press F to switch to the Offset tool. Press F again to open the Offset dialog. 
• Press D to open the Drawing tab of the Representation Properties dialog. 
• Press T to open the Tools tab of the Representation Properties dialog. 

 
There are now context menu items in the Representation Marker Editor for adjusting the size and shape of selected 

symbol elements. This provides the capability of creating symbol elements to exact specification. Typically this 
involves dimensions, locations and spacing between multiple elements. 
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There is now a context menu for deleting multiple representation vertices, representation Bezier points, and 
representation control points. Given a selected set obtained with either the Direct Select tool or the Direct Select Lasso 
tool, a right-click with the tool will provide the option to remove the specified type of representation vertex. 
 

 
 
 
 New representation display functionality 
 

There are times when you have more representation rules in a feature class than you want to show in the table of 
contents and in a legend. To address this, there is a new Legend Options dialog box to control the display of rules in 
the Table of Contents. This dialog is used to select the rules for the Table of Contents and the order in which they 
appear. When a legend is enabled to receive automatic updates from the Table of Contents, the changes made in this 
dialog will be seen in the legend. This dialog is accessible through the Layer Properties dialog of a specified feature 
layer in ArcMap. The dialog is listed in the Layer Options menu on the Symbology tab for Representations. 
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At ArcGIS 9.2 there were a number of developer samples provided for representations which indicated different 
ways to create geometric effects. Some of these samples are now included as standard parts of ArcGIS 9.3. The new 
geometric effects are Move, Rotate, Scale, Regular Polygon, Tapered Polygon and Wave. These effects are designed 
to replace the manual creation methods that were previously required to make a visual effect such as a drop shadow. 
Like all geometric effects, these new effects work by dynamically adjusting the shape and location of a symbol. 
 
-  Use the Move effect to dynamically move a symbol layer to a new location. Useful for creating a drop shadow: 

   
 
- Use the Rotate effect to dynamically rotate a symbol layer to a new orientation. This is useful for rotating stroke and 

fill layers in the same way that the angle property rotates markers. This is also useful as a global geometric effect for 
rotating all symbol layers in a rule together: 

   
 
- Use the Scale effect to dynamically change the size of a symbol layer. This is useful for controlling the size of a 

feature representation in either dimension without any editing: 

   
 
- Use the Regular Polygon effect to generate a dynamic fill symbol from point feature input. This is useful for adding 

a uniform polygonal shape around a marker other than a halo or buffer: 

   
 
- Use the Tapered Polygon effect to generate a dynamic fill symbol from line feature input. This is useful for gradually 

changing the width of a stroke symbol along a specified section of a line: 

   
 
- Use the Wave effect to generate a dynamic stroke symbol to create a natural or organic shape from straight 

geometry segments. This is useful for creating hydrographic features like rivers and streams that resemble the 
naturally occurring features in the real world: 
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With ArcGIS 9.3, there is one new marker placement style called On Vertices which provides further control over 
the location where markers will be located relative to lines and the outlines of polygons. Use this marker placement 
style to place a marker at specific vertices along linear features and polygon outlines. This is useful for placing a 
marker at a location when the exact distance from the beginning or end of the linear feature or the closing point of a 
polygon is unknown: 

  
 
 
New geoprocessing tools for representations 
. 

When faced with a situation where multiple incidents occur at the same location, a point feature is created for each 
occurrence. When the points are symbolized, they overlap each other and it appears as though there is only one 
feature. By using representation symbology for the point features, the new Disperse Markers geoprocessing tool 
spreads marker symbols apart if they are coincident or nearly coincident. The result will display the true number of 
incidents at a single location. For example, this geoprocessing tool is useful for displaying crime figures or 911 calls. 
You can find this tool in ArcToolbox under Cartography > Symbolization Refinement. It requires an ArcInfo license. 
 

  
 
The Minimum Spacing parameter is the distance from the edge of one marker symbol to the edge of another marker 
symbol. When a marker symbol is found within that distance, it is considered to be part of a group. A group of markers 
is then spread apart until each marker in the group has the minimum spacing between it and other markers in the 
group. There are eight different methods provided for arranging the results of the tool process. 
 

 
 

Dashed lines or other repeating stroke symbols can obscure one another when they symbolize shared polygon 
edges because their patterns go out of phase. With representation symbology for your features, the Set 
Representation Control Points At Intersect geoprocessing tool will add a control point to every location where 
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coincident features share one or more vertices to ensure the patterns start and stop in the same place. This 
geoprocessing tool is useful for displaying coincident boundaries with a synchronized pattern. You can find this tool in 
ArcToolbox under Cartography > Symbolization Refinement. It requires an ArcInfo license. 
 

 
 
The Input Secondary Features parameter specifies the features which are used to determine the locations where 
features from one feature layer are intersecting features from another feature layer. To detect self intersecting 
features, the Secondary Features parameter must be blank. The secondary features can be point features, features 
with no representations as well as non-geodatabase features like shapefiles and coverages. 

 
 
 
Better export of representations 
 

At ArcGIS 9.3, when you export data to an XML workspace, additional information is available about the 
representations in a feature class. Specifically, the definition of each representation rule is now provided. The 
description details the geometric effects and marker placement styles along with their respective default parameter 
values as well as the symbol layer types and their respective characteristics, like size and color. 
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Geocoding and StreetMap data 

New reverse geocoding tool and Geocoding toolbar 
 

The new Address Inspector tool  lets you click on a location on the map to find the nearest street address or 
intersection at that location. You can find this new tool on the new Geocoding toolbar. We have added this toolbar as a 
convenience to assemble all the geocoding commands and tools in one place in the user interface: 
 
 

 
 
The Address Inspector tool is enabled if there is an address locator referenced in your map. If there is more than one 
address locator referenced in your map, the Address Inspector tool uses the active locator specified in the Address 
Locator Manager. The active address locator is shown with an asterisk in the Manager: 
 

 
 
After selecting this tool, hover over the map and hold down the left mouse button. If you are near a street, the address 
will appear in a popup tip. You can move the mouse around while holding the left mouse button down to see the 
address of the current location.  
 

 
 
Right-click for additional commands such as toggle between inspecting street addresses (the default) or intersections 
and set the search distance used by the tool. To get help about the commands in the context menu for this tool (or any 
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other), highlight any command in the context menu and press SHIFT+F1. You can also use the following keyboard 
commands while the address of a location is displayed to perform additional tasks (these keyboard commands are 
also listed in the status bar while you are using the tool): 
 
K = Copy the address to the clipboard 
 
P = Add a graphic point to the map at this location 
 
L = Add a graphic point to the map at this location labeled with the address 
 
O = Add a callout with the address pointing at this location. 
 
The commands that add text and graphics draw them using the current graphic symbol environment specified in the 
Draw toolbar. In this example, a graphic point and a callout have been added at three locations: 
 

 
 
Graphic points added to the map with this tool are named after the address that they represent (see the Element Name 
field in their Size and Position tab) so that if you use the new Drawing > Convert Graphics To Features command to 
turn them into a shapefile or feature class, the point features that are created automatically have a name attribute 
containing the address. 
 
 
Improved progress reporting when geocoding 
 

 When you geocode it is now easier to see the progress, and the new progress dialog also shows you the results 
more clearly: 
 

 
 
 
New user interface for rematching geocoding results 
 

 The Rematch dialog has been completely reworked to make it easier to use. It is now a modeless dialog so you 
can keep working on the map while it is open. You can also hide/show different parts of the dialog to make it more 
compact. You can create and store your own result set definitions to filter which results are listed for rematching. A 
new Pick Address From Map tool on the dialog lets you click on the map to choose the address location directly. This 
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tool works the same as the Address Inspector tool described above. When you are over the address you want to pick, 
you can right-click and choose Pick Address, or press SPACE or ENTER on your keyboard: 
 

 
 
In the example below, the top portion of the window has been hidden. You can work through the addresses that will be 
rematched by using the controls in the top left hand corner: 
 

 
 
 
StreetMap data  
 

The StreetMap™ USA dataset with TIGER-based streets has been replaced by the new StreetMap North America 
dataset with Tele Atlas® 2003 streets. 
 

For the StreetMap North America dataset, new ArcGIS street address and postal code locators are provided for 
both the U.S. and Canada.  Composite locators that combine the functions of the individual locators, are also included. 
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Working with layer files 

Layer files (.lyr files) are now shown with yellow icons in Windows Explorer, Windows Desktop, Outlook messages, 
etc. Previously .lyr files were not registered to ArcGIS applications at all and weren't shown with their own icon:  
 

 
 
Note: The same generic yellow icon is used for all .lyr files in Windows: the icon does not show you the type of data 
the layer contains like the .lyr file icons do that you see in ArcCatalog and the Add Data dialog.  
 

Double-clicking a layer file in Windows Explorer, Outlook, Windows Desktop, etc will automatically launch ArcMap 
and show you the layer if ArcMap is not already open. If ArcMap is already open, the layer is automatically added into 
that session. If the layer file contains content that can only be displayed in ArcGlobe, then ArcGlobe will be launched 
when you double-click the layer file. You can also now drag and drop layer files from Outlook into ArcMap, ArcGlobe or 
ArcScene. This makes it much easier to send layer files that reference web content to people by email. They can 
immediately add the layers from your email into their map. 
 

You can now launch layer files directly from web pages. Clicking a layer file on a web page will add it into your 
current ArcMap session, or will launch ArcMap if it is not currently running. Layers with ArcGlobe-only 3D content 
automatically launch ArcGlobe if it is not currently running. You can see this approach in action in the layers page of 
the new ArcGIS Desktop Resource Center: http://resources.esri.com/arcgisdesktop/layers. In order to make it easy for 
you to add ArcGIS Online services and other useful web services into your maps and globes, we created layer files 
referencing these services and put these onto that web page. People using 9.2 can access these layer files too, but 
they have to right-click a layer file and save it to disk in order to use it. See the next section of this chapter for more 
information about accessing web data via the Resource Center.  
 

Behind the scenes, at 9.3 layer files are actually registered to a small utility program called 
ArcGISAppLauncher.exe. This program determines how ArcGIS Desktop should handle a layer file when it is 
launched, and makes sure that if you have ArcMap and ArcGlobe installed, the layer file gets sent to the correct 
application. This is why if you look at the LYR file type in the Windows File Types list, you'll see it is registered to 
ArcGISAppLauncher.exe not ArcMap.exe. 
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Adding web data into your maps 

Easier to add free ArcGIS Online services & other useful web services into your maps 
 

ArcGIS Online provides a set of high performance, ready-to-use basemaps and globes you can use for free in 
ArcGIS Desktop, including imagery, streets, relief, and topographic maps. It is easy to work with these services 
because they are web-based and seamless, so there is no data to download or manage locally. You can think of 
ArcGIS Online as supplementing and extending the free datasets provided on the ESRI 'Data and Maps' DVD that 
comes with the ArcGIS product. ArcGIS Online services can also be used as basemaps for web applications you 
create with ArcGIS Server (see the 'Putting GIS on the Web' chapter in this document).  
 
The ArcGIS Online services have been available to ArcGIS Desktop users for a year or so as a beta release. In 
conjunction with the release of ArcGIS 9.3, ArcGIS Online will go into full release and will no longer be in beta. A large 
number of improvements have been made to the content of the services, such as better shaded relief and the inclusion 
of parks and protected areas in the streets service, and more detailed international place labeling in the boundaries 
and places overlay for the imagery service. Unlike the ArcGIS Online beta, no registration, user name or password is 
required to access and use the free ArcGIS Online services.  
 

At 9.3 we have made it much easier to add ArcGIS Online services into your maps and globes with just a couple of 
clicks. In ArcMap simply choose the new File > Add Data From Resource Center command. This launches the Layers 
page of the new ArcGIS Desktop Resource Center: http://resources.esri.com/arcgisdesktop/layers. You can then click 
on the layer you want to add into your map. The four layers in the World section, and the 'US Topo Maps' layer in the 
United States section, reference ArcGIS Online services: 
 

 
 
The same File > Add Data From Resource Center command in ArcGlobe launches the Globe Layers page containing 
3D layers referencing ArcGIS Online globe services. 
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You can also visit the Maps page of the Resource Center directly http://resources.esri.com/arcgisdesktop/maps to 
launch ready-to-use map documents containing ArcGIS Online services. There is also a Globes page with globe 
documents containing ArcGIS Online globe services. 
 

In addition to ArcGIS Online services, the ArcGIS Desktop Resource Center content pages also contain maps and 
layers referencing some of the most useful third-party services being served by government agencies, universities, and 
public organizations, such as services from the National Map and National Atlas made available by US federal 
agencies and hosted by the USGS and others. Some US State GIS clearinghouses have also provided basemaps 
containing web-based layers for their state.  
 
The third-party content on the Desktop Resource Center is chosen for inclusion by ESRI to provide additional useful 
web-based data that ArcGIS Desktop users can make use of, to highlight interesting and innovative work by ArcGIS 
users, and illustrate some best practices and different approaches to designing and providing web-based data. These 
third party services are not part of ArcGIS Online and ESRI is not responsible for the content, accuracy and availability 
of these services. We welcome comments and suggestions about the third party data provided on the Desktop 
Resource Center, especially if there are useful free services you think should be added that would be of particular use 
to GIS professionals, either published by your organization or that you have discovered on the Web. You'll find a 
feedback link at the bottom of each page in the Resource Center. There's also a new 'Resource Center' discussion 
thread in the ArcGIS Desktop Discussion Forum so you can discuss the Desktop Resource Center. 
 

You don't need to upgrade to ArcGIS Desktop 9.3 in order to use the free ArcGIS Online services. If you are using 
ArcGIS Desktop 9.2 with at least Service Pack 1 installed you can access them. You can go to the Desktop Resource 
Center Content pages described above and access any of the maps, globes and layers. If you are using 9.2 SP4 or 
earlier you can't launch maps or globes directly from those pages but you can simply right-click them and save them to 
a local folder, and then launch them from there. Similarly, if you aren't using 9.3 you have to right-click layer files and 
save them locally in order to use them. If you are using ArcGIS 9.1 and earlier, you can't use maps, globes and layers 
containing ArcGIS Online services. In the Desktop Resource Center content pages, click the Description link 
underneath a particular map, globe or layer to see which version of ArcGIS Desktop the file supports. 
 

If you are already using ArcGIS Online services in your maps or globes, these services will continue to work 
correctly whether or not you upgrade to 9.3, with the exception of a) some services that are being retired in August 
2008, and b) the USA Prime Imagery service map service (I3_Imagery_Prime_World) and globe service 
I3_Imagery_Prime_World_2D) that includes sub 1 meter imagery for certain urban areas in the US, that will become 
subscription-only premium services in August 2008 and therefore will no longer be available for free in ArcGIS 
Desktop. See below for more information about premium services. For information about service retirements see the 
ArcGIS Online Services News and Alerts page: http://resources.esri.com/arcgisonlineservices/index.cfm?fa=news.  
 
If you have already been using ArcGIS Online services in your maps or globes, we also recommend that you now clear 
the local cache for the ArcGIS Online-based layers. The local cache is stored on your machine by ArcMap and 
ArcGlobe when you access cached map services to increase performance by not requesting map tiles for services 
from the server if you have already accessed them. Clearing your local cache is not required but will ensure that when 
you draw your existing maps, you get the most recent map tiles from the ArcGIS Online server reflecting the 
improvements we have made to the services recently. Clearing the local cache is easiest if you upgrade to 9.3, 
because in 9.3 you can clear the entire local cache for all cached map services you have accessed in a couple of 
clicks by going to the ArcCatalog Tools > Options dialog > GIS Servers tab and clicking 'Clear Local Cache Now'. 
Alternatively, in 9.2 and 9.3 you can go to the Cache tab in the Layer Properties dialog for each ArcGIS Online layer 
you have in your map and clear the cache for that layer's service. See below for pictures of these dialogs. 
 

The free ArcGIS Online services are cached services published with ArcGIS Server: they have been cached on the 
server to maximize performance. At 9.3 we have made several enhancements in ArcMap to improve the speed and 
appearance of ArcGIS Server cached map services. You can read about these enhancements below. Working with 
ArcGIS Server globe services has also been enhanced in ArcGlobe, and you can read about that in the 'ArcGIS 3D 
Analyst' chapter of this document.  
 
 

For more information about ArcGIS Online Services please see the product description page on esri.com: 
http://www.esri.com/software/arcgis/arcgisonline-services/index.html and the ArcGIS Online Services Resource 
Center: http://resources.esri.com/arcgisonlineservices. 
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New ArcGIS Online Premium Services including Microsoft Virtual Earth 
 
In addition to the free ArcGIS Online services, a range of subscription-based ArcGIS Online Premium Services will be 
launched in mid-August 2008. ArcGIS Online Premium Services provide convenient, fast access to the most recent 
imagery, street maps, etc, from popular commercial data providers, many with global coverage that is continuously 
updated and enhanced.  
 
The Premium Services that will be made available initially are the Microsoft Virtual Earth service (which includes the 
Aerial, Roads, and Hybrid map layers) and the USA Prime Imagery from i-cubed. Additional services will become 
available later in the year. 
 
The screenshot below shows the Microsoft Virtual Earth service in ArcMap. The service is provided in the form of a 
group layer containing the three Virtual Earth layers. You can then break this group layer apart if you wish depending 
on how you want to work with the service: 
 

 
 
ArcGIS Desktop 9.3 is required to access ArcGIS Online Premium Services. They are not supported in earlier 
versions. 
 
Premium services that ESRI is serving using ArcGIS Server, such as the USA Prime Imagery service, use the new 
token-based security introduced in ArcGIS Server 9.3, which is not supported by ArcGIS Desktop 9.2. These services 
are supported in all ArcGIS Desktop applications. 
 
Premium services being served by third parties like Microsoft Virtual Earth are accessed directly using a new 
mechanism in ArcGIS Desktop for accessing tile-based internet web services. This mechanism requires ArcGIS 
Desktop 9.3 along with a Desktop patch that will be available for download in mid-August. These third-party services 
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like Virtual Earth are supported in ArcMap, ArcGlobe, and ArcGIS Explorer. These services are provided as layers 
created by ESRI and distributed in ready-to-use map, layer and globe files. There is no interface in ArcCatalog or the 
Add Data dialog to connect to this type of third party server like Virtual Earth. Note: At the time of writing, Virtual Earth 
support in ArcGlobe support is still being tested, and Virtual Earth is not supported in ArcReader via ArcGIS Publisher,  
so please check the website below for the latest information for support in those applications..  
 
You can preview the premium services, and compare them to the free ArcGIS Online services, using the web 
application in the ArcGIS Online Services Resource Center: http://resources.esri.com/arcgisonlineservices. Free 14-
day evaluations of the ArcGIS Online Premium Services for use in ArcGIS Desktop will be available in mid-August 
2008.  
 

For more information about ArcGIS Online Premium Services and subscription fees, please see: 
http://www.esri.com/software/arcgis/arcgisonline-services/agol-premium/index.html. 
 
 
Option to purchase source data used in some ArcGIS Online services for local offline use 
 
In addition to using ArcGIS Online services over the Internet as web-based services, ArcGIS Online also now 
introduces the ability to purchase the data used in some of the services for the areas of your choice as downloadable 
raster files for local offline use. The services for which data can be purchased for local use includes the World Imagery, 
US Topo Maps, and USA Prime Imagery. ArcGIS Online provides a web application called DataDoors™ For ArcGIS 
that makes it quick and easy to purchase data. 
 
Data from Microsoft Virtual Earth is not available for purchase via this program, but the imagery used in Microsoft 
Virtual Earth may be available separately directly from the source data providers, depending on location and 
resolution.  
 

For more information purchasing ArcGIS Online data for local offline use, please see: 
http://resources.esri.com/arcgisonlineservices/index.cfm?fa=datadoors. 
 
 
Make it easy for other ArcGIS users to access the services that you publish 
 

If your organization is publishing web-based services with ArcIMS or ArcGIS Server, you can make map, globe and 
layer files available on the web that reference these services to make it easy for people using ArcGIS Desktop (.MXD, 
.LYR, .3DD files), ArcGIS Explorer (.NMF files) or ArcReader (.PMF files) to access them. Putting files on web pages 
that users can click to launch makes your services easily accessible because in this way ArcGIS software users don't 
have to make connections to servers in ArcCatalog or the Add Data dialog and deal with often cryptic service names in 
order to use your services. Another advantage to creating map, globe or layer files containing your services is that you 
can also easily include other third party services in the file you create. For example, you could create an MXD file 
containing a layer referencing the data you are serving and a layer referencing an ArcGIS Online service to provide the 
background. Depending on your needs and how many services you are publishing, you could create a web page that 
looks similar to the ArcGIS Desktop Resource Center which contains a set of maps, layers, etc, or you could simply 
add individual files to your existing web pages.  
 

For tips about putting files made with ArcGIS Desktop on the web, please see the 'GIS servers and services > 
Creating and publishing web maps > Distributing maps, globes, and layers on the Web' topic in the ArcGIS Desktop 
Help: http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Distributing_maps,_globes,_and_layers_on_the_Web
 
 
Working with ArcGIS Server map services 
 

In ArcMap 9.3 you'll find you get much better results when you add cached ArcGIS Server map services into your 
map, such as the ArcGIS Online services. The algorithm used to resample cached map services in ArcMap has been 
improved in 9.3. ArcMap resamples cached map services so that it can display them at any resolution. In ArcMap 9.2, 
text or linework in cached map services often appeared distorted or broken when they were resampled. This 
enhancement greatly improves the appearance of cached map services in ArcMap. Drawing performance has also 
been substantially improved.  
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As part of this work, we have also modified the resampling logic so that in 9.3 you will no longer see the 'Map Data Not 
Available' image in ArcMap if you zoom on an area in which detailed data is not available in a cached service. In 9.3, 
ArcMap always resamples from the nearest available cached resolution, so the experience is similar to zooming in 
closely on a raster. As the map maker, you can decide whether or not the resolution that you see is acceptable for the 
map you are making. 
 

9.3 gives you control over how cached map services are cached locally on your machine by ArcMap when you 
access them. In the new Cache tab in the layer properties dialog for a cached map service, you can choose to either 
keep the local cache between sessions (the default, the same as 9.2), clear the local cache when the session ends, or 
have no data cached locally: 
 

 
 
Keeping a local cache is recommended for the best performance when drawing layers representing cached map 
services. However if the data you are accessing is likely to change frequently on the server, or if it is mission-critical 
that your map or application has the most up-to-date data from the server, it is better to choose one of the other 
caching options. Another reason to choose one of the other caching options is if you only have a limited amount of disk 
space available and you want to minimize the amount of temporary data that is stored on your machine. When no data 
is cached locally, a cached map service will still perform better in ArcMap than a map service that isn't cached (a 
'dynamic' service) because ArcMap just has to fetch the cached image tiles from ArcGIS Server, rather than wait for 
ArcGIS Server to render the map as an image. 
 
The new Cache tab also shows you the current disk space used by the cache for the particular cached map service 
you are working with, and the location of this cache in your Windows temporary directory. The local cache on your 
machine is always stored in a folder called esrimapcache and like all temporary data this folder is stored in your 
Windows temporary folder. Inside the esrimapcache folder, a separate subfolder is maintained for each cached map 
service, and this is the last part of the path you see here. 
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At 9.3 people publishing cached map services with ArcGIS Server can specify that client applications such as ArcMap 
accessing their map service cannot cache any data locally. This option is likely to be used if the data changes 
frequently or contains sensitive information. When a cached map service prohibits local caching on the client 
computer, the first two caching options in the Cache tab are disabled: 
 

 
 

In addition to being able to clear the local disk caches for individual layers representing cached map services, you 
can also clear the entire local cache by going to the new GIS Servers tab in the ArcCatalog Tools > Options dialog. 
Press the Get Size button to get an updated statement of the current size of the cache (getting the size can take some 
time so the statement isn't updated automatically when you visit this tab: 
 

 
 
The cache location in your Windows temporary folder is shown in the tab too. The location of the Windows temporary 
folder is determined by Windows as defined by the TMP system environment variable. You can relocate your Windows 
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temporary folder to a different location, such as another disk with more available disk space, by specifying the desired 
path in your own TMP user variable. In Windows XP you set your own TMP user variable in the Control Panel > 
System > Advanced > Environment Variables dialog. In the example above, TMP has been set to D:\TEMP.  
 

When you work with cached map services in ArcMap, you normally do not have to worry about the cache 
resolutions available in the service: you just work with the cache service in your map and ArcMap automatically selects 
and resamples the appropriate cache resolution from the service to display on your map. This is very similar to how 
you work with raster data in ArcMap.  
 
There are some situations when you may want to zoom your map to one of the resolutions at which the service has 
been cached in order to view the optimal resolution available in the service for the map you are making. Just like you 
can right-click a raster layer and choose the Zoom To Raster Resolution command, you can now right-click a cached 
map service and choose the new Zoom To Nearest Cache Resolution command. This automatically zooms your map 
to the cached resolution that is closest to your current scale. (Cached map services are cached at different resolutions, 
defined on the server as a scale + a Dots Per Inch (DPI) setting). In other words, use this command if you want to view 
a cached map service at its native resolution without any resampling occurring in ArcMap.  
 

 
 
For example, you might use this command if the map service you are using appears somewhat 'fuzzy' at your current 
map scale and you want to compare the current display with how the map service appears when there is no 
resampling. So you can think of this command as 'sharpening up' your map. It is also useful if you are reviewing a 
cached map service to assess its quality or usefulness, or inspecting a cached map service you have published. 
 
This command is disabled if you are working with an ArcGIS map service that has not been cached, also known as a 
'dynamic' service. 
 
The Zoom To Nearest Cache Resolution command is also available in ArcCatalog. In Preview mode, right-click a 
cached map service in the Catalog tree. In addition, if you are publishing or reviewing cached map services and often 
want to quickly browse through the different cache resolutions they contain, you will find the new Cached Scales 
dropdown control in the ArcGIS Server Tools toolbar in ArcCatalog useful. This dropdown lists each of the cached 
scales supported by the cached map service you are currently previewing, making it easy to switch between them. It 
also includes the Nearest Cache Resolution option that will take you back to a cached scale if you zoom in or out 
manually to a scale at which the service is resampled: 
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The ArcGIS Server login dialog in ArcMap now has a 'Save Username/Password check box, so that when you add 
a map service that requires authentication into a map or globe document, you can choose to save the user name and 
password you specify into the document. You will also see this login dialog if you open an existing map globe 
containing a map service that requires authentication, or if you add a layer containing such a service into your map or 
globe:  
 

 
 
 

When you add ArcGIS Server map services into your map you can now specify the datum transformation that will 
occur. If a datum transformation is recommended, you will see the usual prompt dialog appear in ArcMap. 

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 79 



Enhanced support for OGC WMS 
 

We have made it much easier to access specific layers in WMS services containing large numbers of layers. In 
ArcCatalog you can now expand WMS services to access the layers and layer collections they contain. This lets you 
drill down to the layer or layer collections you want to work with and drag them directly into your map or globes: 
 

 
 

The legends of some WMS services do not appear in ArcMap's Table Of Contents because of their size and format. 
To handle this situation, a new command has been added into the context menu in ArcMap for layers in a WMS 
service that enables you to still add such legends into your map as a graphic: 
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Some WMS layers contain alternative symbology styles specified by the service publisher using the Styled Layer 
Descriptor (SLD) specification. When you access such a service in 9.3, you can select the appropriate legend style via 
a new Styles tab in the property dialog for layers in a WMS service: 
 

 
 
Note: This doesn't provide full SLD support in ArcMap: you can't point to an external file to provide the style, or specify 
your own style. 
 

In ArcGIS Desktop, support has been added for accessing WMS 1.3.0 services.  
 

When you identify features in WMS services, you can now drag over the data returned in the Identify window and 
choose Copy so you can paste it into the map as text or into another application. 
 

When you add a WMS service containing multiple layers into a map, the number of these layers that ArcMap turns 
on by default has been decreased from 20 to 10. 
 
 
Enhanced support for OGC WFS 
 

At ArcGIS 9.2, we introduced free support for the 'GML Simple Features' level in OGC WFS in ArcGIS Desktop. 
This requires that you have installed the Data Interoperability extension but does not require that you have a license 
for that extension or that the extension is enabled in the Tools > Extension dialog. To use other application schemas of 
GML, a license for the extension is required. That support continues in 9.3. At 9.3 we also introduce a new 'WFS to 
Feature Class' geoprocessing tool that lets you load features from WFS directly into the geodatabase, and incorporate 
these steps into geoprocessing models and scripts. You can find this tool in the Conversion toolbox. It requires an 
ArcEditor or ArcInfo license. This tool does not use the Data Interoperability extension, and so does not require that 
the Data Interoperability extension is installed or licensed:  
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Improved documentation for working with web data 
 

For information about working with the different sources of live data available on the web, including ArcGIS Server, 
ArcIMS, and ArcGIS Online, see the new 'Mapping and Visualization > Working with web maps in ArcGIS' 
section in the Desktop Help: 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=An_overview_of_GIS_web_map_layers
 

For general information about interoperability and how standards like OGC WMS, WCS, WFS and KML are 
supported in ArcGIS, see the 'Interoperability and standards support' section in the Desktop Help: 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Overview_of_interoperability
 
 
Other enhancements related to using web data in ArcMap 
 

A transparency control has been added into the Advanced tab of the layer properties dialog for a layer representing 
an ArcIMS image service. Transparency has always been supported for ArcIMS image service layers but you have not 
been able to set transparency directly from the properties dialog before. 
 

The Refresh button (keyboard shortcut F5) in the horizontal scroll bar has been enhanced so that when you press it, 
any map service layer (ArcIMS, ArcGIS Server, WMS) is redrawn by requesting new imagery from the server. This 
enhancement makes map services consistent with how other data sources are handled when you press the Refresh 
button. Previously when you pressed Refresh, layers such as ArcIMS image service layers were not redrawn from the 
server but from the local temporary file maintained by ArcMap for your session, so you didn't automatically see 
changes made to the data on the server. The only exception to this enhancement is if you are working with a cached 
ArcGIS Server map service and there is a local cache, in which case Refresh redraws the service from that local 
cache. To ensure that a cached map service contains the latest data on the server you can double-click the layer, go 
to the Cache tab in its property dialog, and clear the local cache. 
 
 
 

Navigating and viewing maps 

Mutually exclusive viewing shortcut for layers 
 

In the ArcMap Table Of Contents, if you hold down ALT and click on the check box next to a layer, that layer will be 
turned on (if it is not already on) and all the other layers at that level in the Table Of Contents hierarchy will be turned 
off. It doesn't matter whether the check box you click is currently checked or not: that layer will alone will be turned on. 
 
This is useful, for example, if you are comparing a number of different data sources, such as different sources of 
imagery, to see which one best meets your needs because it lets you quickly turn one layer on and all the others off. 
You can also use it in demos and presentations to step through the contents of your map or a particular group layer 
viewing one layer at a time. 
 
For example, if you have a group layer containing mutually exclusive basemaps like the ArcGIS Online basemaps 
shown below, you can hold down ALT and click the check box next to the particular basemap you want to view, and 
that one will be turned on exclusively. You can think of this as being the same as switching between Streets, Aerial, etc 
in a web mapping program. Previously in ArcMap you had to click twice: once to turn the current layer off and once to 
turn the desired layer on. 
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Viewer window enhancements 
 

At 9.2 a new tool called the Create Viewer Window tool  was introduced in the Data Frame tools toolbar. At 9.3 
we have added this tool into the Tools toolbar. This tool makes it easy to open a viewer window showing you a specific 
area on your map. Select the tool and then drag over the area on your map you would like to view in more detail. A 
viewer window will be launched displaying that extent: 
 
 

 
 
Viewer windows were introduced in 9.2 to make it easier to work with maps at multiple scales at the same time. Like 
the Window > Magnifier command, the Window > Viewer command and the Create Viewer Window tool are disabled in 
Layout view. 
 

You can now work with multiple data frames side-by-side on-screen in the same map document. Previously, if your 
map document contained more than one data frame, the only way to work with the contents of multiple data frames 
simultaneously was to switch to Layout view and arrange the data frames on the layout page, or to open two or more 
map documents on screen. We have enhanced viewer windows so that you can use them to view inactive data 
frames. Now if you activate a different data frame while a viewer window is open, that viewer window remains on-
screen, enabling you to work with multiple data frames side by side. (This enhancement was originally introduced in 
9.2 Service Pack 2). 
 
In this example, a viewer window is being used to compare two data frames showing different data for the same area: 
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When you work with an inactive data frame in a viewer window, you can easily make the viewer show the same 
location that is currently displayed in the active data frame in the main ArcMap window. Similarly, you can update the 
location shown in the active data frame in the main ArcMap window to match the location shown in any of your viewer 
windows. Commands in the viewer window's menu let you pan or zoom the viewer or the main ArcMap window so that 
both displays show the same location: 
 

 
 
There are some restrictions on which operations you can perform inside a viewer window that is displaying an inactive 
data frame. You can generally perform map navigation, query, and selection, but you cannot edit graphics or features. 
If a tool cannot be used on an inactive data frame displayed in a viewer window, the cursor will change when you 
hover over the viewer to show you that the tool is not available. There are no restrictions on the operations that can be 
performed inside a viewer window displaying the active data frame. 
 
The ability to work with multiple data frames side-by-side in ArcMap can be useful for analysis, historical change 
assessment, data evaluation, and other applications where you want to be able to see different datasets for the same 
area side by side, as opposed to working with all the data in one data frame, or working with multiple map documents.  
 
In the photo below, two different map services in separate data frames in a map document are being compared for the 
same location. A viewer window showing the inactive data frame has been maximized on the second monitor: 
 

 
 
 

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 84 



Tip: There are two shortcuts that make it easy to work with multiple data frames:  
 

CTRL + TAB switches between the data frames making each one active in turn. (If you want to be able to do the 
same thing by pressing a button on-screen, add the Activate Next Data Frame command into any toolbar from the 
View category in the Tools > Customize dialog). 
 
ALT + click on the name of a data frame in the Table Of Contents activates that data frame. 

 
If you use the Schematics extension, you can use a viewer window to work with a schematic side-by-side with the 
geography it represents without having to work in Layout view. (See the 'Schematics' section of this document). 
 
 
Easier to share places defined in the My Places dialog in ArcMap, ArcGlobe & ArcReader  
 

In the dialog launched by the My Places command  in the Tools pulldown menu, you now have the option to save 
a subset of your places into a separate file. Starting with 9.2 Service Pack 2, the Save button is now a menu button 
containing two commands, one for saving the currently selected places, and the other for saving all the places: 
 

 
 
By using the option to save just the selected places, you can save a subset of places as a file you can share with 
others or move between different machines. You can load the file that is created into the new Bookmarks Manager 
dialog in 9.3 in order to turn extent places (places shown with yellow rectangle icon in the picture above) into 
bookmarks saved in your map document. When you load a places file into the Bookmarks Manager, any places in the 
file that are not extent places are skipped. Similarly, you can save bookmarks to a file from the Bookmarks Manager 
and load them into the My Places dialog so you can use them to navigate all your maps.  
 
 
Zoom To Layer command now respects definition queries 
 

When you use the Zoom To Layer command on a layer containing a definition query, you now get taken to the 
actual extent of the data defined by that query. Previously Zoom To Layer didn't respect definition queries and always 
took you to the full extent of the layer.  
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Similarly, when you use the Zoom To Layer command on a selection layer, you now get taken to the extent of the data 
in that selection layer. Previously zooming to the extent of a selection layer took you to the full extent of the data 
source referenced by the layer and didn't take into account the subset of features represented by the layer. (These 
enhancements were originally introduced in 9.2 Service Pack 4). 
 
Tip: In the Table Of Contents, hold down ALT and click on the name of any layer in the active data frame to zoom to 
that layer's extent. This shortcut was added in 9.2. 
 
 
Option to center on the cursor location when you roll mouse wheel to zoom 
 

The ability to roll the mouse wheel to zoom in and out was introduced at 9.2. The zoom was centered on the center 
of the display. This is still the default behavior, but at 9.3 a new option is provided in the ArcMap Tools > Options 
dialog General tab that makes the zoom be centered on your current cursor location. Using this new option, if you 
hover the cursor over a location in the corner of your map and roll the wheel, you will zoom in or out on that location 
and it will remain on-screen. Like all the settings on the Tools > Options dialog General tab, this setting applies to all 
your ArcMap sessions, not only your current map document.  
 

 
 
Tip: When rolling the mouse wheel to zoom in or out, hold down CTRL to zoom at a slower rate. 
 
 
Option to make rolling the mouse wheel in ArcMap scroll instead of zoom 
 

By default, rolling the mouse wheel in ArcMap zooms in and out. This behavior makes it easy to zoom irrespective 
of which tool you are currently using. However, some users preferred the pre-9.2 behavior where rolling the mouse 
wheel scrolls the map up and down. For example, some people were using ArcMap 9.1 with a mouse with a 'tilt' wheel 
that can be tilted from side to side in addition to being rolled forward and back, enabling them to pan in four directions. 
Using a tilt wheel mouse to pan does not work as expected in ArcMap at 9.2 because rolling the mouse wheel forward 
and back zooms instead of scrolling up and down. At 9.2 Service Pack 3 we introduced a new registry setting that lets 
you override the default mouse wheel behavior introduced at 9.2. At 9.3 you can now set this via the 
AdvancedArcMapSettings utility in your arcgis/utilities folder. After launching the utility, go to the Miscellaneous tab and 
look in the Panning and Scrolling group box. 
 
Behavior involving single-clicking or holding down the mouse wheel is unaffected by this setting. So irrespective of the 
value of this registry setting, you can still drag with the mouse wheel held down to pan, drag and hold down CTRL to 
zoom to a box, single-click the mouse wheel to re-center, and CTRL+single-click to zoom in. 
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Exporting maps 

New and improved functionality available when you export to PDF 
 

Exporting your maps to PDF is the simplest way to share your GIS work with the rest of the world. 
 
In ArcMap 9.2 the PDF export function was enhanced to include the list of layers from the ArcMap Table Of Contents 
in the output PDF. This allows users of the PDF to turn layers on and off via the Layers panel in Adobe Acrobat 
Reader. So for example, instead of having to create 10 PDFs showing different maps, you can just create one PDF 
that lets the end user choose which layers to show. 
 
At 9.3 this functionality has been enhanced so that the layer list exported into the PDF now represents group layers 
and data frames as a hierarchy. In the Adobe Reader interface users can turn group layers on or off, or turn the 
individual members of group layers on and off. The layers in the list are now automatically grouped based on which 
data frame they belong to. This makes it much easer for people using PDFs containing group layers or multiple data 
frames to customize their appearance.  
 
At 9.3 you also now have the option not to include a layer list in the output PDF. To omit the layer list, look in the new 
Advanced panel in the PDF options in the File > Export Map dialog and choose the 'None' option from the dropdown 
list (see the screenshot below). 
 

ArcMap 9.3 now gives you the option to include feature attributes in the exported PDF. People using your PDF can 
access these attributes using the Object Data tool in Adobe Acrobat Reader. This option is enabled using the new 
Advanced tab in the PDF options panel in the File > Export Map dialog: 
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If you use the option to include feature attributes, we recommend only including one layer's attributes in the map, 
especially if your layers have a large number of features. You can turn the fields off in the Layer Properties dialog 
Fields tab for layers for which you do not want to include attributes in the PDF.  
 
Adobe Reader users access the Object Data Tool via the Tools > Object Data menu. These screenshots show this in 
Adobe Reader 7.0: 
 

 
 
Adobe Reader users can then click on features to see their attributes in the Model Tree panel in Adobe Reader (see 
below). They can also expand a layer in the Model Tree to list its individual features, and click on a feature to see its 
attributes and highlight it on the map: 
 

 
 

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 88 



ArcGIS 9.3 adds support for the new geospatial capabilities in Adobe Acrobat 9. The Adobe Acrobat 9 release 
includes an update to the PDF specification which allows map coordinate system information to be stored in a PDF. 
This allows users of Adobe Acrobat 9 products to perform geographic operations including seeing a coordinate readout 
as they move the cursor over the map, finding specific XY locations, measuring distances in map units, and adding 
markups. ESRI has collaborated with Adobe Systems over the past year to ensure a seamless workflow for taking 
advantage of this new functionality when distributing maps in PDF format. 
 
The geospatial functionality available to Adobe Acrobat users when they use a PDF depends on which Acrobat 9 
product they are using and how the PDF was generated: 
 
- Adobe 9 Reader: Coordinate readout and find XY can be performed on PDFs exported from ArcMap. Measurement 

and markup can also be performed in Adobe 9 Reader if the PDF exported from ArcMap has first been resaved 
using Adobe Acrobat 9 Pro or Pro Extended to enable that functionality. 

 
- Adobe Acrobat 9 Standard or Pro: Coordinate readout, find XY, measurement and markup. 
 
- Acrobat 9 Pro Extended: Coordinate readout, find XY, measurement and markup. Advanced authoring capabilities 

allow shapefiles, GeoTiffs and Jpeg2000 to be added to maps.  
 
For more information about the Adobe Acrobat 9 products, see http://www.adobe.com/products/acrobat
 
Support for creating PDFs with these new geospatial capabilities with ArcGIS is available as a free download that can 
be installed once you have installed ArcGIS 9.3. You can access the download here: 
http://support.esri.com/index.cfm?fa=downloads.patchesServicePacks.viewPatch&PID=80&MetaID=1407
It will also be included in the 9.3 service packs, as they are released. The download supports ArcGIS Desktop, ArcGIS 
Engine and ArcGIS Server, and only works with 9.3. When the download is installed, or if you install a 9.3 service 
pack, you will see the following new check box in ArcMap's File > Export Map dialog when you export a PDF: 
 

 
 

See the new 'Advanced PDF Features' topic in the 'Mapping and visualization > Page Layout and map composition 
>Map output > section' in the Desktop Help for more information about PDF export at 9.3: 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Advanced_PDF_Features
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Better support for exporting layers and maps as KML files 
 

Keyhole Markup Language (KML) is an XML-based language provided by Google for defining the graphic display of 
spatial data in applications such as Google Earth and Google Maps. KML enables these applications to support the 
open integration of custom data layers from many GIS users. KML files have either a .kml file extension or a .kmz file 
extension (for compressed and zipped KML files).  
 
In ArcGIS Desktop 9.3 you can now convert maps and layers to KML at all license levels using the Layer To KML and 
Map to KML tools in the Conversion toolbox. Previously these tools were only available with the 3D Analyst extension.  
 

 
 
The new HTML Popup functionality in ArcMap at 9.3 (see above in this chapter) enables you to define and format how 
the attributes of features and related URLs will appear when layers are accessed as KML. The ability to define HTML 
Popups can also be found in ArcGlobe and ArcScene at 9.3. 
 
You can put the KML files you create with these tools onto the internet so they can be accessed in applications like 
ArcGIS Explorer and Google Earth. You can also load your KML files into web maps like Google Maps (via the 'My 
Maps' tab), and Microsoft Virtual Earth (via the Collections menu). This functionality provides new ways for you to 
share maps and data with others and tell your geographic story. It also provides an easy way for people to combine 
your data with other web-enabled content (the 'Geoweb'). 
 

See the 'Interoperability and standards support' section in the Desktop Help for more information and examples 
about working with KML in ArcGIS: 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=An_overview_of_KML_support_in_ArcGIS
 

Support for serving GIS data in KML format is greatly improved in ArcGIS Server at 9.3. Maps that you serve with 
ArcGIS Server are automatically accessible as KML, and the network links capability in KML enables you to go beyond 
what you can achieve by simply exporting KML as files from ArcMap, ArcGlobe or ArcScene. For example, a Google 
Earth user can access your ArcGIS map service and see all the layers it contains irrespective of their underlying data 
type, see more detail and different data as they zoom in, etc. See the 'Putting GIS on the Web' chapter of this 
document for more information. 
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Other 

Speed up the Add Data dialog the first time you use it in a new session 
 

When you use the Add Data command  in ArcMap for the first time in a new session, it automatically returns to 
the last location you added data from. A new option in the Tools > Options dialog General tab lets you control this 
behavior. By unchecking the new 'Return to last used location' option you can tell ArcMap that you do not want the Add 
Data command to default to the last used location. When this option is unchecked, the dialog will instead default to the 
top level of the ArcCatalog tree.  
 

 
 
This improves the performance of the Add Data command because you do not have to wait while it reconnects to the 
network drive, database location or GIS Server that you accessed in your previous session. It is useful if you typically 
add data from a variety of different data locations, and are not likely to add data from the same location whenever you 
start ArcMap. Another example is that you may be about to give a presentation or demonstration using ArcMap with a 
map containing ArcSDE geodatabase data, and you want to make sure that if you press the Add Data button during 
the demo, you won't have to wait while the Add Data dialog reconnects to the ArcSDE geodatabase that you accessed 
when you created the demo. 
 
This option does not affect the location that the Add Data dialog defaults to if you launch it from a geoprocessing tool 
when you are using the current workspace setting in your geoprocessing environment (Tools > Options dialog > 
Geoprocessing tab). If you have set the current workspace for geoprocessing, then the Add Data dialog will default to 
the location of that workspace the first time you use it in a new ArcMap session, irrespective of whether or not this 
option is checked. It also does not affect the location that the Catalog Browser dialog defaults to when you save or 
export data from ArcMap. 
 
 
Templates 
 

When you open a map document that references a template (.mxt file) that cannot be found, you now see a more 
informative dialog, and you are given the option to browsing to the missing template in another location so that the 
customizations stored in the template, such as VBA macros, will still be accessible in your map. If there were no 
customizations in the missing template and the template just supplied the page layout and/or default content for your 
map, there is no need to browse for the missing template. Whether you choose to browse to the missing template or 
not, once you save your map document you won't get prompted again about the missing template:  
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GPS support 
 

In the GPS toolbar > GPS Connection Setup dialog support has been added for connection baud rates higher than 
9600. Speeds up to 115200 are now supported. 
 
 
AdvancedArcMapSettings utility rearranged and more settings added 
 

The AdvancedArcMapSettings utility in your arcgis/utilities folder has been enhanced to better organize the tabs 
and add some more settings. This utility provides an easy way to specify various registry settings that can be used to 
control how ArcMap behaves, without having to make these settings manually in the Windows registry using RegEdit. 
 
For example, the setting to control the size of the temporary metadata file used when exporting or printing maps is now 
exposed in the AdvancedArcMapSettings utility. Smaller temporary metafile sizes can alleviate "Cannot map metafile 
into memory  - Not enough memory" errors experienced during printing or exporting in ArcMap. In previous releases 
you could control this by manually setting a registry key, but at 9.3 it is much easier to specify using the utility. 
 
If you are an advanced user you should definitely review the settings that can be made using the 
AdvancedArcMapSettings, and read the accompanying 'ArcGIS Desktop Advanced Settings Registry Keys.doc' file 
that you'll find in that folder which describes the settings in more detail. That document also lists some additional 
registry settings that can be set to control the behaviour of ArcMap that are not exposed in the utility. 
 
 
Go To XY command and Measure tool enhancement 
 

The Go To XY command  and the Measure tool  in the Tools toolbar now remember your choice of units 
between sessions so you no longer have to specify your preferred units whenever you use the tool in a new session. 
These enhancements also apply to ArcGlobe, ArcReader and ArcGIS Engine applications that feature these controls. 
(The enhancement to the Measure tool was originally introduced in 9.2 Service Pack 3). 
 
 
Next/Back buttons in ArcCatalog's Geography toolbar 
 

When you view data in ArcCatalog's Preview tab, you can now move back and forward through the extents you 
have visited: 
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Visualization & analysis 

Selecting features 

Select By Location dialog and geoprocessing tool 
 

The spatial operators available for the Select By Location dialog have been reorganized to make them clearer and 
two new Clementini operators have been added: 
 

 
 
The two new operators are: 
 

Contain (Clementini) – This is the same as Contain unless the source feature is entirely on the boundary of the 
target feature, with no part of the source feature inside the target feature. In this case, using this new Contain 
(Clementini) operator would not select the target feature, whereas the Contain operator would.  
 
Are Within (Clementini) - This is the same as Are Within unless the Target feature is entirely on the boundary of the 
Source feature, with no part of the Target feature inside the Source feature. In this case, using this new Are Within 
(Clementini) operator would not select the target feature, whereas the Are Within operator would.  

 
 
Select By Attributes dialog 
 

The performance of the Get Unique Values button on the Selection > Select By Attributes dialog has been greatly 
improved, with a huge performance improvement on very large datasets. 
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Other selection enhancements 
 

If you repair a broken selection layer or use the Set Data Source button in the Layer Properties dialog Source tab to 
point it at a different data source, you will now see the following message reminding you that the selection may not 
work if you choose a different data source, and allowing you to choose whether or not to retain the selection definition 
of the selection layer. (This message isn't shown if you do a bulk repair of layers that includes a selection layer): 
 

 
 
 
 

Graphing 

A new scatterplot matrix graph type has been added via a new wizard launched from the Tools > Graphs > Create 
Scatterplot Matrix command. Scatter plots are already supported, but scatterplot matrix graphs are new. They allow 
you to enter a set of variables to see the relationships between all of them as a matrix of scatterplots.  
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When you click on one of the graphs in scatterplot matrix, it appears in the upper right corner of the graph page as an 
interactive element. Each dot in the scatterplot matrix represents a feature in the dataset positioned in data space for 2 
numeric data variables. You can elect to make all the dots the same color or use the same color scheme as features in 
your map. The diagonal cells in the matrix will optionally contain a histogram (data distribution) for the variable in that 
row/column.   
 
In the Call Volume example below, there is a positive relationship between the number of 911 calls and the number of 
people unemployed (as the number of unemployed people goes up, the number of 911 calls also goes up). There is a 
weak negative relationship between Median Income and Unemployment (as Median Income goes up, the number of 
Unemployed goes down): 
 

 
 
 
The scatterplot matrix graph is particularly useful when you are exploring potential explanatory variables for the 
regression models described in the next section. When a variable exhibits a strong negative/positive relationship with 
the dependent variable (what we are trying to model, like call volume), it is a good explanatory variable candidate. 
When two explanatory variable candidates exhibit a strong negative/positive relationship with each other, we will only 
want to include one of them in our model to avoid problems with multicollinearity. Multicollinearity means that both 
variables are telling the same story, so including both introduces an overcount type of bias to the model. 
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Spatial statistics 

A new toolset called “Modeling Spatial Relationships” has been added to the Spatial Statistics toolbox. The 4 tools 
in this toolset provide new ways to model spatial relationships by constructing spatial weights matrices and performing 
regression analysis: 
 

 
 
-  Generate Network Spatial Weights - Constructs a spatial weights matrix file (.swm) from a network dataset which 

defines spatial relationships among all features in terms of an underlying network structure. (See below for more 
information about the new spatial weights matrix file). This tool requires the Network Analyst extension. 

 
-  Generate Spatial Weights Matrix - Constructs a spatial weights matrix (.swm) file to represent the spatial 

relationships among features in a dataset. 
 
-  Geographically Weighted Regression (GWR) - performs a local form of linear regression used to highlight regional 

variation in spatial relationships and help you understand how processes vary over space. 
 
-  Ordinary Least Squares Regression (OLS) - Performs global Ordinary Least Squares linear regression to 

generate predictions or to model a dependent variable in terms of its relationships to a set of explanatory variables. 
This tool requires either an ArcInfo license or the Spatial Analyst extension. 

 
A spatial weights matrix is a representation of the spatial structure of your data. It is a quantification of the spatial 
relationships that exist among the features in your data set. Prior to 9.3 a user-specified spatial weights matrix file was 
an ASCII file with a specific text format. With 9.3, all of the Spatial Stat tools that accept the ASCII formatted spatial 
weights matrix file, now also accept the new binary spatial weights matrix files (.swm) created by the new Generate 
Spatial Weights Matrix or Generate Network Spatial Weights tools. The .swm file is re-usable, editable, and sharable. 
New ways to model spatial relationships are provided with these tools including Delaunay Triangulation, K nearest 
Neighbors, and Queen’s Case Polygon Contiguity. The spatial statistics tools impacted by this change are: High/Low 
Clustering (Getis-Ord General G), Spatial Autocorrelation (Global Moran’s I), Cluster and Outlier Analysis (Anselin 
Local Moran’s I), and Hot Spot Analysis (Getis-Ord Gi*). When running several analyses on a single dataset (e.g., 
analyzing several different fields) or working with a dataset that has more than 3000 features, constructing the spatial 
weights matrix file prior to analysis is strongly recommended. 
 

The High/Low Clustering (Getis-Ord General G), Spatial Autocorrelation (Global Moran’s I), Cluster and Outlier 
Analysis (Anselin Local Moran’s I), Hot Spot Analysis (Getis-Ord Gi*), and Average Nearest Neighbor tools now report 
P-values (probabilities) in addition to Z scores; both are used to determine statistical significance. 
 

Several tools have now been assigned default rendering. When these tools are run in ArcMap, output is added to 
the Table of Contents already symbolized: Hot Spot Analysis (Getis-Ord Gi*), Cluster and Outlier Analysis (Anselin 
Local Moran’s I), Linear Directional Mean, and Collect Events. With this change, several model tools became obsolete 
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and were moved into a new Rendering toolset within the Spatial Statistics toolbox. You will notice two, instead of four, 
tools in the Mapping Clusters toolset (the Cluster/Outlier Analysis with Rendering and Hot Spot Analysis with 
Rendering tools have been moved from the Mapping Clusters Toolset to the Rendering Toolset). You will also notice a 
different mix of tools in the Utilities toolset (the Collect Events with Rendering, Count Rendering, and Z Score 
Rendering tools have been moved from the Utilities toolset to the Rendering toolset). The Desktop Help topic for the 
new Rendering toolset explains this change. 
 

A new field has been added to the Multi-Distance Spatial Cluster Analysis (Ripleys K Function) output table called 
“DiffK”. The Multi-Distance Spatial Cluster Analysis (Ripleys K Function) tool is often used to identify the distance 
where the spatial processes promoting clustering are most pronounced. It was usually difficult to identify this distance 
visually using the output graphic, so the user would add a field to the table output and compute the difference between 
the ObservedK and ExpectedK values. The DiffK field contains this difference so the user no longer has to do this 
step. 
 

The Cluster and Outlier Analysis (Anselin Local Morans I) tool computes the Local Moran’s Index, Z Score, and P-
value for every feature in the input feature class. High positive Z scores indicate either a clustering of high values (a 
hot spot) or a clustering of low values (a cold spot); low negative Z scores indicate a spatial outlier. With 9.3 a new 
field, COType, has been added to the output feature class to distinguish statistically significant hot spots (“HH”) from 
statistically significant cold spots (“LL”), and to distinguish between statistically significant spatial outliers representing 
a low value surrounded by high values (“LH”) from one representing a high value surrounded by low values (“HL”). 
 

The Central Feature tool has a new “Case Field” parameter. The case field is used to group features for separate 
central feature computations. The case field can be of numeric, date, or string type. 
 

At 9.3, when no value is provided, a default threshold distance is computed for those tools that include the Distance 
Band or Threshold Distance parameter (High/Low Clustering, Spatial Autocorrelation, Cluster and Outlier Analysis, Hot 
Spot Analysis, and Generate Spatial Weights Matrix).  
 

Tools that have the Conceptualization of Spatial Relationships parameter (High/Low Clustering, Spatial 
Autocorrelation, Cluster and Outlier Analysis, and Hot Spot Analysis) will compute Inverse Distance and Inverse 
Distance Squared a little differently at 9.3. Inverse Distance methods become unstable with distances less than 1.0. 
Consequently, at 9.3 all distances less than 1.0 are treated as 1.0 in computations. Projecting data that will be 
analyzed with the spatial statistics tools has always been recommended in order to ensure accurate distance 
measurements. With 9.3, the Geographic Coordinate System projection is not recommended at all when using an 
inverse distance based conceptualization of spatial relationships. 
 

Prior to ArcGIS 9.3, feature geometry was projected to the output coordinate system after all mathematical 
computations were completed. To ensure accurate results, feature geometry is now projected to the output coordinate 
system prior to any mathematical computations. The exception is the Generate Network Spatial Weights tool which will 
always project and base geometry computations on the coordinate system associated with the network dataset used to 
construct spatial weights. 
 

Users will notice significant performance improvements for tools in the Spatial Statistics toolbox with 9.3. This is the 
result of algorithmic improvements, the ability to minimize the number of required computations by using spatial 
weights matrix files, and the ability for script tools to run in-process (which minimizes execution overhead). 
 
 

For more information and an introduction to spatial statistics, see the 'Geoprocessing tool reference > Spatial 
Statistics toolbox section in the Desktop Help: 
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Modeling_spatial_relationships
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Proximity analysis 

Improved Near tool - The Near tool now works with points, lines and polygons. It can also now perform 
calculations to all features (multiple Near feature classes) within the given search radius. 
 

New Generate Near Table tool - This new tool in the Analysis Tools > Proximity toolset works like the existing 
Near tool but the resulting proximity information is output to a separate table. This output table can be joined back to 
the input feature class or any of the near feature classes using the original feature-ids: 
 

 
 

Buffer tool improvements - More robust implementation using the topology engine to clean-up offsets, support for 
geodesic buffers, and improved performance 
 

Improved Spatial Join tool - New option for joining to the closest feature makes it easier to merge attributes. 
  
 

Animation 

A Create Time Layer Animation command has been added to the Animation pulldown menu in the Animation 
toolbar to make it easier to create temporal animations. The dialog takes an input layer or table, a field with time values 
and the interval and units to use to display time slices and creates a time layer animation that can be played 
immediately via the Animation Controls dialog: 
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Geoprocessing 

General improvements 

At 9.3 we introduce a resource center website for geoprocessing users that brings together various useful resources 
from ESRI and lets you share tools, models and scripts with other users: http://resources.esri.com/geoprocessing. 
 

New ”Start ModelBuilder” button on the Standard toolbar lets you open ModelBuilder without having to first create a 
model tool: 

 
 

All error and warning messages have been standardized and given a unique number. When a warning or error 
occurs, you will see this unique number and standardized text: 

 
Each error is documented to give you insights into the cause of the error and possible solutions, as well as links to 
relevant documentation: 
 

 
The progress dialog has been modified so that tools can indicate percentage complete: 
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A new option for automatically controlling the lifespan of tool results is available on the Tools > Options dialog 
Geoprocessing tab of any ArcGIS application. Previously, results were always saved until you explicitly deleted or 
removed them. This new option helps prevent the build-up of unneeded results, which caused desktop applications to 
take longer opening and closing: 

 
The system default is to keep results that are younger than two weeks. A side effect of this is that results that are older 
than two weeks will be removed when any existing document is opened and then saved. If you have older results that 
you want to keep, you must change the default setting or copy your result into a model that can be saved. If you open 
a document containing results older than 2 weeks, the following pop-up message appears: 
 

 
 
 
 

Model and script tool improvements 

Python script tools now have the option of running in-process. Running in-process makes your tools run significantly 
faster: 
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You have more options for model and script tool parameters. For models, you can change optional parameters to 
required parameters and apply various filters for inputs and outputs: 
 

 
 
For scripts, you can also apply various filters and set symbology for output features: 
 

 
Script tools can contain custom validation code. Validation code allows your tool to behave just like a system tool by 

providing you ways to: 
 

 Enable or disable parameters based on values contained in other parameters. 
 Dynamically update a parameter filter. 
 Dynamically update default values for parameters. 
 Customize warning and error messages. 
 Put parameters in categories. 
 Update the description of output datasets for use in ModelBuilder. 
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Within Python, you now have better access to Python data structures. The arcgisscripting method now takes a 
version number argument that tells geoprocessing to return lists instead of enumerators, as illustrated below.  
 

 
 
You can access the new tool progress dialog to show percent complete. Within your script, you have access to the 
new repository of error codes and messages. NumPy (Numerical Python) is included in the ArcGIS install. All tools 
now also return a result object. 
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Server geoprocessing enhancements 

The Feature Set data type now accepts a feature class and the Record Set data type accepts a table. Previously 
you could only enter features and records interactively: 
 

 
Better error checking when publishing a geoprocessing service. At 9.2, toolboxes published even if they had errors. 

At 9.3, toolboxes will not publish if they contain errors and you will receive an error message, as illustrated below: 
 

 
 

Raster rendering information can be provided for raster results returned from geoprocessing services. 
 
 

Other improvements 

You will notice some cosmetic improvements have been made to the geoprocessing tool dialogs. The dialog 
controls are closer together, the ESRI logo background graphic has been removed, and you get help by pressing a 
new Tool Help button at the bottom of the help panel. 
 

Summary Statistics now supports multiple case fields. 
 

ModelBuilder supports TIN layer symbology. 
 

Calculate Field now supports unit conversion. 
 

Toolboxes can be saved in 9.2 format for distribution to 9.2 users. 
 

Null values are excluded from statistical calculations in all Geoprocessing tools such as: Summary Statistics, 
Dissolve, Frequency, Spatial Join, Merge, Table to Table, and Feature Class to Feature Class.  
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Desktop application development 

.NET Engine & Desktop SDKs 

Visual Studio 2008 support 
 

ArcGIS 9.3 supports .NET development using the Visual Studio 2005 SP1 or Visual Studio 2008 integrated 
development environment. ArcGIS 9.3 has been tested with the Beta 2 version of Visual Studio 2008. During our tests, 
all features of the ArcGIS IDE Integration Framework worked as expected in Visual Studio 2008 Beta 2. All samples 
provided with the ArcGIS Desktop SDK for .NET include both Visual Studio 2005 and Visual Studio 2008 solution and 
project files. 
 
Improved documentation, including new Snippet Finder tool 
 

The number one request from developers has been 'better API Help'. Too often you hit F1 and the page that 
appeared offered little or no information. At 9.3 we have continued to add additional help topics to fill these gaps. Over 
100 new samples have been added. We have also made it easier to access relevant samples and topics in other areas 
of the SDK by adding links from the API Help pages to relevant samples, snippets and other help topics. 
 

A new ArcGIS Snippet Finder tool has been introduced that makes it easy to search the 250+ code snippets and 
insert them into your code. Previously you could only browse the list of snippets. (This tool was originally introduced as 
part of 9.2 Service Pack 1, but it has been much improved since then). The tool lets you choose how code will be 
inserted (fully qualified/using statements/commented). If you have local directories of other snippets, written or 
collected by you, you can add a connection to those extra snippets so they can be accessed by the Snipper Finder too. 
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In order to provide you with the information you want without forcing you to install additional SDKs, we now provide 
links between SDK content and the online documentation. In this way when a referenced topic is not available in the 
SDK that you have installed, such as a Desktop topic when you only have ArcGIS Engine installed, we provide a link to 
the equivalent topic on the web. This also allows you to add comments on the topic, ask questions or just see if the 
topic has been updated since the installed SDK was released. 
 
 

Java Engine SDK 

New configurations supported 
At 9.3 support has been added for Java Developer Kit version 6, Suse Linux 10, 64-bit Red Hat Linux (must use 32-bit 
JVM) and Windows Vista. 
 

Improved IDE and debugging experience 
ArcGIS Engine and ArcGIS Server developers can now use the Eclipse 3.3 plug-in to inspect the state of ArcObjects. 
NetBeans are supported on ArcGIS Server. 
 

New topics and samples 
In 9.3 there are four times more help topics and samples for Java developers. We have filled the key gaps in the Java 
SDK documentation that were reported in 9.2. There are also improved ArcObjects Library Overview topics. 
 

New MXD Editor tool 
Mxd Editor is a tool that can be used to inspect and fix broken layers in map documents (.mxd files) on Windows, 
Linux, or Solaris machines that have ArcGIS Engine Java Developer Kit or ArcGIS Server for the Java Platform 
installed. The tools is based on the Eclipse RCP framework and leverages the ArcObjects components provided by 
ArcGIS Engine and ArcGIS Server. 
 

Better memory management 
 
 

What's new in ArcObjects 

See the following link for changes that may impact developers: 
http://edndoc.esri.com/arcobjects/9.3/CPP_VB6_VBA_VCPP_Doc/COM/VBA/new_93.htm
 

See the following link for a list of type changes between 9.2 and 9.3: 
http://edndoc.esri.com/arcobjects/9.3/CPP_VB6_VBA_VCPP_Doc/shared/reference/type_changes_93.htm
 
Note: at the time of writing the content in the ESRI Developer Network (EDN) website is being modified. If these links 
do not work for you, please look in the 'For Developers' tab in the ArcGIS Desktop Resource Center at: 
http://resources.esri.com/arcgisdesktop
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ArcGIS Engine enhancements 

Improved dynamic display capabilities 
 

At 9.3 dynamic display has been further improved with better display caching and handling. Dynamic display now 
also supports feature selection, adds new continuous zoom/pan and roam tools, and has enhanced performance. 
Dynamic display is only available via ArcGIS Engine. It can be used and configured using ArcObjects by developers on 
all supported ArcGIS Engine development environments. 
 
 
ArcSDE for SQL Server Express included in ArcGIS Engine Developer Kit 
 

ArcGIS Engine 9.3 includes the Microsoft SQL Server 2005 Express installation and the ArcSDE geodatabase Post 
Installation wizard. This allows ArcGIS Engine developers to use ArcSDE for SQL Server Express geodatabases as a 
data source. Support for ArcSDE geodatabases using SQL Server 2005 Express was introduced in ArcGIS Desktop at 
9.2 and is included free with ArcEditor and ArcInfo licenses. This allows you to set up and administer your own 
ArcSDE database server and create multi-user geodatabases, with full support for all the advanced features found in 
ArcSDE such as versioning, archival history, multi-generational replication, and advanced dataset-level security. No 
additional software or database administration expertise is required. All database administration is performed using a 
new set of dialogs in ArcCatalog.  
 
 
ArcGIS Engine editing enhancements 
 

Improved programmatic editing capabilities including ability to create edit tasks, set the layer being edited 
(TargetLayer), and access the sketch geometry. 
 

Better incorporation of business rules and logic by listening for editor events: check for digitizing errors, and check 
that a digitized point falls within a particular polygon. 
 
 
ArcGIS Engine's Add Data dialog now supports ArcSDE geodatabases 
 

The Add Data dialog in ArcGIS Engine supports connections to ArcSDE geodatabases (this support was originally 
added in 9.2 Service Pack 2). This enables users of your ArcGIS Engine applications to connect to any ArcSDE 
geodatabase to access data. With the Geodatabases tab on the left hand side of the Add Data dialog selected, choose 
the 'Database Connections' folder from the dropdown list and the two new buttons on the dialog will become enabled, 
the first for making an ArcSDE connection, the second for editing the properties of an existing connection: 
 

 
 
Note: When the ArcGIS Engine Add Data dialog is added into ArcMap or ArcGlobe (by dragging it from the Tools > 
Customize dialog Commands tab > 'Generic' category) we now hide the 'All Types' panel that provides access to the 
full Catalog tree. To restore that panel, change this DWORD registry setting so it has a value of 1: 
HKEY_CURRENT_USER\Software\ESRI\Controls\Commands\Generic\AddData\ShowAllTypesInDesktopApps 

 
For more information about what's new for Engine developers at 9.3, please see the ArcGIS Engine Resource 

Center: http://resources.esri.com/arcgisengine
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Mobile GIS 

ArcGIS Mobile 

With ArcGIS Mobile, organizations can deliver geographic information system (GIS) capabilities and geospatial data 
from centralized application servers to a range of mobile devices over wired or wireless networks, providing access to 
GIS services such as mapping, spatial queries, sketching, GPS integration and editing.  
 
ArcGIS Mobile fits seamlessly into enterprise IT environments supporting services orientated architectures, third party 
security, deployment, and device management systems. ArcGIS Mobile applications can be deployed on to Windows 
CE or Windows Mobile devices with the .NET Compact Framework 2.0, and Windows XP or Vista PCs with .NET 
Framework 2.0. ArcGIS Mobile is part of the ArcGIS Server Advanced Edition at the Enterprise Level.  
 
At 9.3 ArcGIS Mobile extends the reach of ESRI’s ArcGIS Server platform beyond the office with two products, a new 
out-of-the-box ArcGIS Mobile application, and the enhanced ArcGIS Mobile Software Development Kit. We have also 
introduced a new ArcGIS Mobile Resource Center that brings together various online resources for ArcGIS Mobile 
users and developers: http://resources.esri.com/arcgismobile
 
 
 

New out-of-the-box ArcGIS Mobile application  

At 9.3 we introduce the new ArcGIS Mobile application. The ArcGIS Mobile application is a Windows Mobile 
application for deploying mobile GIS data, maps, tasks, and projects. The application targets the Windows Mobile 5 
Pocket PC, Windows Mobile 6 Classic, and Windows Mobile 6 Professional platforms and enables organizations to 
quickly and easily deploy the key mobile GIS capabilities required for a successful deployment. The application is 
centrally managed with ArcGIS Server's rich standards-based platform providing high-performance ArcGIS Mobile 
data, services, and projects throughout an organization: 
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The ArcGIS Server Manager configures the ArcGIS Mobile application designing individual ArcGIS Mobile Projects 
with an intuitive web-based configuration utility for targeting mobile GIS tasks for the day-to-day workflow of mobile 
workers. Through the ArcGIS Server Manager a web-based portal optimized for mobile internet explorers enables any 
organization to host the ArcGIS Mobile application and their ArcGIS Mobile Projects for deployment to Windows 
Mobile-based devices. 
 
The ArcGIS Mobile application provides mobile workers with ability to access their specific ArcGIS Mobile projects 
from a centralized server. They can view and navigate mobile maps, collect new and edit existing GIS features, search 
for GIS features to work with, and manage the status of the application and the device. 
 
The ArcGIS Mobile application has a new user experience designed specifically for the mobile environment with a 
menu-based UI for interacting with their mobile GIS tasks. The new UI ensures a broad range of mobile workers can 
easily use mobile GIS tasks in the field with limited training and a high level of productivity. 
 
Mobile workers often perform a dedicated task using a specific tool or they perform a range of tasks using multiple 
tools. The ArcGIS Mobile application has been designed to be configured to reflect the language and tasks used while 
on the go. A GIS Administrator can quickly create ArcGIS Mobile Projects through configuring GIS data, maps, and 
tasks to meet the needs of their mobile workers. Tasks can be renamed and their capability restricted reducing the 
complexity of the workflow for the mobile worker. 
 
The Collect and Search tasks provide a searchable list-based experience enabling mobile workers to quickly scroll to 
or search for the feature type to create or specific feature to edit. The Collect task supports creation of new features 
using Sketch with stylus, rocker, or GPS to create geometry and a configurable form with auto-generated input controls 
for adding attributes. The Search task supports discovery of features by spatial and attribute queries, along with the 
editing of attributes on any existing feature. 
 
The ArcGIS Mobile application is deployed wirelessly from a centrally hosted web site providing on-demand access to 
mobile projects, services and data. Mobile workers can pull mobile projects to their device and post new edits back to 
the central server over any wireless data service that provides an IP connection. This enables GIS Administrators and 
mobile workers to have continual awareness of work performed in the field or office without the need to be physically 
connected throughout the day. 
 
An administrator can, for example, choose to deploy a mobile data access service from a ArcGIS map document with 
ten layers in it. They can configure the settings of the application using the ArcGIS Server Manager to enable only the 
collect task with one layer flagged as editable. These settings are stored in the specific ArcGIS Mobile Project file on 
the ArcGIS Server. The mobile worker can download the application, run it, and view a list of ArcGIS Mobile Projects. 
From this list when they select a project the application opens it and configures itself based on the settings pre-defined 
by the GIS Administrator. The mobile worker can then use the application to collect new features and post them back 
to the server on-demand using their wireless internet access on the go. 
 
 
 

ArcGIS Mobile Software Development Kit (SDK) 

The ArcGIS Mobile SDK provides key mobile GIS capabilities required for any successful custom mobile GIS 
application, including map, map actions, map cache, web service, spatial query, GPS, and GIS editing components. 
The ArcGIS Mobile SDK adheres to leading Microsoft .NET programming environment, supporting Windows Mobile 5 
& 6, Windows CE 5.0 & 6.0, Windows XP, and Windows Vista operating systems.  
 
Powerful mobile mapping and GIS focused applications can be rapidly developed using the Visual Studio 2005 
Integrated Development Environment. Examples of applications that developers can build for mobile uses include 
asset inspection, incident reporting, land management, mobile resource management, customer service, insurance 
appraisal, and traditional GIS data collection and maintenance. 
 
Organizations can leverage power of ArcGIS Mobile and ArcGIS Server together to deploy applications that include 
additional server-side capabilities, including address location, street routing, network tracing, and range of different 
geoprocessing functions. 
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The ArcGIS Mobile SDK was first released at 9.2. At 9.3 we have enhanced the ArcGIS Mobile SDK to provide: 
 
- New naming convention for map cache as the mobile service cache. 
- Enhanced Map control rendering supporting multiple data source and graphic layers. 
- Improved data storage with support for a new highly compressed background data store. 
- Expanded projections covering all ArcGIS GIS projections other than Grid-based. 
- Improved editing with new sketch tools for manipulating geometries. 
- Increased performance of Global Positioning System (GPS) handling and display. 
- Inclusion of signed cabinet file (CAB) including ArcGIS Mobile runtime components. 
 
 
 

ArcPad 

ArcPad is designed for various industries and organizations wanting to expand the benefits of GIS from the office to 
the field. ArcPad is an out-of-the-box mobile GIS application for field data collection and mapping that provides field-
based personnel with the ability to capture, analyze, and display geographic information on mobile devices.  
 
ArcPad targets small to medium sized organizations looking to deploy a slice of their ArcGIS Desktop-based GIS into 
the field. ArcPad is designed to provide the familiar look and feel of ArcGIS Desktop with a map-centric view and sets 
of toolbars for managing map layers and symbology, GPS and sensor integration, GIS editing tools, and simple query 
and analysis tools. ArcPad is designed to support a range of mobile devices, including those running the Windows 
Mobile, CE, XP and Vista operating systems. ArcPad is easily deployed from any desktop machine running ArcGIS 
Desktop. Tools in ArcGIS Desktop allow users to check out GIS data from the geodatabase for use in the field. On 
return from the field GIS edits can be transferred to a desktop machine and checked back into the geodatabase.  
 
ArcPad 7.1 and ArcPad Application Builder 7.1, the development and customization framework for ArcPad, were 
released in December 2007. 
 

ArcPad 7.1 introduces the following enhancements: 
 
- Out-of-box solution to view and edit geodatabase data in the field, including related tables, using the new AXF format 

built on top of Microsoft SQL Server Compact Edition (SQLCE). 
 
- QuickProject: A simple data template to capture various shapefiles and help both new and experienced users 

become immediately productive.  
 
- StreetMap extension: Includes the most recent North American street map data from Tele Atlas, providing 

geocoding, routing functionality, and a preconfigured basemap for users at no additional cost. 
 
- Enhanced query capabilities: Includes a query builder and query forms that support predefined customized queries. 
 
- ArcPad Data Manager extension for ArcGIS Desktop: This provides a new ArcPad Data Manager toolbar for ArcMap 

and some ArcPad geoprocessing tools. These allow simple automation of field workflows and easier management of 
mobile GIS project deployments. 

 
ArcPad Application Builder 7.1 supports ArcPad database files, custom query forms, and enables users to set read-

only layers. 
 
 

For more details on what’s new in ArcPad 7.1 and ArcPad Application Builder 7.1, please see the following white 
paper: http://www.esri.com/library/whitepapers/pdfs/whats-new-arcpad71.pdf
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Putting GIS on the Web 

ArcGIS Server is a complete server-based GIS that delivers out-of-the-box data management, applications and 
services while also offering tremendous opportunities for developing custom applications and mashups. This chapter 
covers what is new in the ArcGIS Server web functionality at 9.3. For information about what's new in the ArcSDE 
geodatabase functionality in the ArcGIS Server product, see the 'Data Management' chapter of this document. 
 
To find out what is new in ArcIMS at 9.3, please go to the new ArcIMS Resource Center website at: 
http://resources.esri.com/arcims and then click the 'What's New in ArcIMS 9.3' link. 
 
 
 

ArcGIS Server highlights at 9.3 

More resources to help you be successful 
 

New ArcGIS Server Resource Center website 
Visit the ArcGIS Server Resource Center at http://resources.esri.com/arcgisserver for everything you want to know 
about ArcGIS Server. Get the latest news, run live Web applications, read the latest online help, see what the 
development team is up to on the ArcGIS Server Development Blog, view developer code samples, and access the 
ESRI Support site for any technical problems.  
 

Easy access to ArcGIS Online 
ArcGIS Server 9.3 makes it easy to create Web applications that display your content on top of ArcGIS Online 
basemaps. Use of the standard ArcGIS Online basemaps is generally free for use in intranet applications, but requires 
licensing for use in applications that will be served externally. For more about ArcGIS Online, see: 
http://www.esri.com/software/arcgis/arcgisonline/index.html
 

Better documentation 
You asked us for more documentation and we think you will be happy with what 9.3 delivers. You will notice 
improvements in many areas. In the ArcGIS Desktop Help, you will find more information about preparing your maps, 
geoprocessing toolboxes, etc, for publishing to the server. In the ArcGIS Server Help, you will find improved 
conceptual topics, expanded discussions of workflows, and more step-by-step tutorials. Developers will find lots of new 
content describing the new developer options such as the new ArcGIS JavaScript APIs, complete documentation for 
the ArcGIS Server SOAP SDK that describes how to use SOAP to access ArcGIS Server Web services, and more 
thorough descriptions of existing classes and methods in the Web ADFs with numerous code samples. 
 
 
Easier to use applications 
 

ArcGIS Server Manager 
When you run Manager, you will immediately notice several changes at 9.3, with the most visible being the 
reorganization of Manager’s tabbed interface. Many of the changes are a result of adding new features to Manager, 
such as allowing you to more easily configure security for services and Web applications. However, we have also 
spent time improving existing workflows, for instance, the workflow for building a Web Mapping Application. 
 

Web Mapping Application 
While the Web Mapping Application essentially works the same way it did at 9.2, it looks slightly different at 9.3. This is 
because the tools that you use to interact with the map have been rearranged so that you can access them more 
easily, for example, the pan and zoom tools are now positioned on top of the map display. 9.3 also introduces some 
new features in the Web Mapping Application, such as a print option and better highlighting of task results. 

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 110 

http://resources.esri.com/arcims
http://resources.esri.com/arcgisserver
http://www.esri.com/software/arcgis/arcgisonline/index.html
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=welcome
http://support.esri.com/index.cfm?fa=knowledgebase.webHelp.agServer93
http://resources.esri.com/arcgisserver/index.cfm?fa=jsapis


New and enhanced services 
 

New ways to create cached map and globe services 
New workflows at 9.3 make it easier to create and update map and globe service caches in ArcCatalog. For map 
services, you can now build the cache for specific geographic areas and also allow the cache to be created on demand 
through usage. For globe services, the reliance on ArcGlobe is minimized and you can now completely build the cache 
on the server. ArcMap and ArcGIS Explorer also provide new options for clearing any locally stored cache, ensuring 
that the visual display is always up to date. 
 

New image service 
9.3 provides another option for publishing raster data to your GIS server through an image service. The image service 
allows you to deliver large volumes of imagery to your clients. Integration with ArcGIS Image Server allows you to 
reduce the time between collection and publishing of image content and leverage the powerful image processing 
capabilities in a Web environment. 
 

Enhanced geoprocessing service 
The geoprocessing service at 9.3 provides better feedback during publishing, improved performance, and more 
symbolization options for the generated results. Plus, there is lots of new documentation and samples that show you 
how to build your geoprocessing tools. 
 

New geometry service 
The geometry service allows applications  to invoke sophisticated geometric operations such as projection, buffering, 
and evaluating spatial relationships. It can be deployed to support client side JavaScript applications that do not have 
the ability to independently perform such operations. 
  

Matching addresses can now be returned in a specified coordinate system 
At 9.2, geocoding services could only return matching addresses in the same coordinate system as the locator defining 
the service. At 9.3, you can now request that the matching addresses be returned using a specific coordinate system. 
 

Browsing a GIS server with Services Directory 
Services Directory is a Web application that’s part of every GIS server. Services Directory lets you see the services 
running on the GIS server and get information necessary for developing applications that use the services.  
 
 
Improved server management 
 

Enhanced Security 
At 9.3, ArcGIS Server implements a role based security model that allows you to define a set of users in a database, 
operating system or other location, using the new Security tab in Manager. For services and Web applications, you can 
use Manager to assign permissions to users based on their roles.  
 

More detailed logging messages 
Tracking down problems can often be a difficult and frustrating experience. 9.3 makes it easier to track down problems 
occurring on your GIS server by allowing you to turn on more detailed messaging when necessary. For each type of 
service, you will find the log file will record additional information to help you troubleshoot a problem. For example, a 
map service will write information to the log file that indicates whether each layer was drawn successfully or not. 
 

Integration with ArcGIS Image Server 
The power of ArcGIS Image Server can now be integrated with ArcGIS Server. Simply register your ArcGIS Image 
Server with ArcGIS Server in Manager or ArcCatalog. Then you can utilize your imagery through ArcGIS Server client 
applications. 
 
 
Better interoperability  
 

Enhanced KML support 
At 9.2, if you wanted to deliver your map services to people using Google Earth, you used Manager to author a KML 
network link that you could then send out to them. Upon opening the network link, the map service would then display 
over the globe in Google Earth. Now at 9.3, map and image services automatically generate a network link that can be 
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accessed via a URL. People can use the Services Directory Web application to browse all your services and display 
them in ArcGIS Explorer, Google Earth or any other application that directly supports KML. Alternatively, you might 
embed the URLs to your services directly on your organization’s website, providing a more tailored user experience 
than that of Services Directory. As an added benefit, the service metadata gets indexed by search engines (e.g., 
Google, Yahoo) allowing your services to be found simply by doing Web searches.  
 

Support for WCS and WFS, and enhanced WMS support 
9.3 adds support for OGC Web Coverage Service (WCS) and OGC Web Feature Service (WFS). OGC Web Map 
Service (WMS) support has been enhanced to include the ability to serve cached map services as WMS and to utilize 
Styled Layer Descriptors (SLD) to define how layers will be drawn. 
 
 
New and enhanced application development tools 
 

New tools for building Web mashups 
It is now easy for Web developers to create map mashups that overlay content from any GIS server with content from 
ArcGIS Online, Virtual Earth, or Google Maps. The ArcGIS JavaScript API allows you to easily embed maps in your 
Web pages. This API is hosted by ESRI and is available for free use. The ArcGIS JavaScript extension for the Google 
Maps API and ArcGIS JavaScript extension for Virtual Earth allow you to add ArcGIS Server content on top of Google 
Maps and Microsoft Virtual Earth, respectively. No ESRI development or deployment license is required to use these 
APIs. 
 

New Flex API 
The ArcGIS API for FLEX provides FLEX developers with a simple but powerful API to create rich web mapping 
applications. It is fully integrated with Adobe Flex Builder™ 3. At the time of writing, the ArcGIS API for Flex is in public 
beta. Full description, download, samples, and demo at: http://resources.esri.com/arcgisserver/apis/flex. 
 

New ArcGIS Server REST API and Services Directory Web application 
As an application developer, you will use Services Directory to help you build applications that utilize the services 
running on a GIS server. Services Directory is a Web application deployed with every GIS server that allows you to 
browse the contents of the server and get specific information about the services running on the server. Services 
Directory works through the ArcGIS Server REST API. Simply put, the REST API allows a GIS server to reveal 
information about its services through URLs. The JavaScript APIs mentioned above are all powered by the ArcGIS 
Server REST services. The REST API also enables you to do web development in additional environments such as 
Microsoft Silverlight. For more information on the REST API, see ArcGIS Server REST API page at: 
http://resources.esri.com/help/9.3/arcgisserver/apis/rest/index.html
  

Enhanced Web ADF for building Web applications (Microsoft .NET Framework) 
The enhancements for 9.3 in the Web ADF include the following: faster map blending, fully documented WebADF 
JavaScript library, full integration with ASP.NET AJAX, support for Visual Studio 2008, and better documentation. 
 

Build and deploy mobile projects from Manager 
In much the same way as you build and deploy the Web Mapping Application, Manager for the Microsoft .NET 
framework now includes the tools to build and manage mobile projects.  
 
 

For information about moving from ArcGIS Server 9.2 to 9.3, see the 'Introducing ArcGIS Server > Moving to 
ArcGIS Server 9.3' topic in the ArcGIS Server Help: http://webhelp.esri.com/arcgisserver/9.3/dotNet/moving_to_93.htm
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ArcGIS Server Manager enhancements 

General enhancements 
 

A new look 
The most significant visual change to the ArcGIS Server Manager is the repositioning of the main tabs. At 9.2, the tabs 
were oriented horizontally across the top of the application. At 9.3, the tabs have been moved to the left column. This 
change allows Manager to incorporate new features, such as an enhanced user interface for managing security: 
 

 
 

Logging in with administrator privileges no longer required 
The user name you use to login to Manager for the Microsoft .NET Framework no longer requires system administrator 
privileges. If you login without system administrator privileges, you can publish services but you cannot manage your 
Web applications. ArcGIS Server Manager for the Java Platform is not affected by this change because system 
administrator privileges are not needed due to the difference in how Web applications are deployed to the Web server. 
 

Manager supports network domain groups 
At 9.3, Manager now supports logins of domain users that are part of domain groups managed by your network 
administrator. Thus, instead of adding each individual user to the agsadmin user group, you can use a domain group 
and add that to agsadmin. Any user who is a member of the domain group will have access to Manager. 
 

What version of ArcGIS Server am I running? 
Clicking the Help link in Manager (in the upper-right corner of the application) now shows the ArcGIS Server version 
number. 
 
 
Publishing services 
 

Creating and managing folders on the GIS server 
When viewing the services running on your GIS server, Manager at 9.2 displayed all the folders containing your 
services in the left column. However, because Manager’s tabs moved to the left column, the way you browse the 
folders on your GIS server changed as well. At 9.3, folders are accessed through a dropdown menu. To view the 
services in a particular folder, simply choose the folder you want to navigate to: 
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Additionally, you can click Manage Folders to add, remove, view properties, and set permissions on folders: 
 

 
 

Stop and restart services with one button 
To address feedback on how cumbersome it was to stop and start services (i.e., select one or more services and click 
Stop; select the services again and click Start), Manager has a new option to restart services, effectively combining 
stop and start into one step. Look for the Restart button on the toolbar: 
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New context menu provides command shortcuts 
Right-click a service or a Web application to reveal a context menu of commands. (This only applies to the Manager 
for the Microsoft .NET Framework and doesn't apply to the Java platform): 
 

 
 

Securing services 
Manager now allows you to more easily configure security on your GIS services. By first defining a set of users, you 
can then indicate which users should have access to your GIS services. Manager allows you to set permissions on 
folders as well as individual services. Look for the Permissions button  to set security on your GIS services. For 
more details on the new security options, see the section below called Security.  
 
 
Building and managing Web applications 
 

Migrating Web applications from 9.2 to 9.3 in the Microsoft .NET framework 
The Web ADF for the Microsoft .NET Framework has undergone significant changes for 9.3. While the framework 
remains the same, we have incorporated a number of technology and performance enhancements to provide you with 
a more comprehensive platform for building your Web applications. As a result of these enhancements, you will need 
to migrate your 9.2 Web applications to 9.3, including those applications created with Manager. For instructions on 
how to do this, and other information about compatibility and migration, see the 'Introducing ArcGIS Server > Moving to 
ArcGIS Server 9.3' topic in the ArcGIS Server Help: http://webhelp.esri.com/arcgisserver/9.3/dotNet/moving_to_93.htm
 

Deploying Web Mapping Applications from Manager in the Microsoft .NET framework 
One of the first things you will notice when creating a Web application in Manager is that you now have more control 
over how it gets deployed to the Web server. Manager now allows you to: 
 

• Provide a different host name other than the current machine name. 
• Specify a port number. 
• Supports folders in the URL so that the Web application is not at the root directory of the Web server. 
• Supports a different outward facing URL that does not include an explicit machine name. 
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To configure these options, click the Advanced Options link on the Application tab when creating or editing a Web 
application: 
 

 
 

Adding layers to your Web application 
Adding layers to your Web application now centers on one dialog and is similar to the file browsing dialogs of 
ArcCatalog. Like ArcCatalog, there is a root node under which the connected GIS servers are shown. You will notice 
that connections to your GIS server are automatically listed as well as a connection to ArcGIS Online, making it easy 
to display your content on top of ArcGIS Online basemaps. To navigate the catalog, simply double-click the item to 
navigate to it. Click Show Details to see more information about an item. Once you find the service you want to add as 
a layer to your Web application, click Add (or double-click it): 
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Configuring layer properties 
At 9.2, Manager allowed you to configure properties on map service layers, such as setting the transparency for the 
layer. At 9.3, there are a few new properties on layers that allow you to control whether or not the layer is visible when 
the Web application starts and also what type of image to request from the GIS server, which is a useful option when 
working with map services that contain imagery: 
 

  
 
Also new at 9.3 is the ability to configure properties on the sublayers inside a layer, for example set field aliases and 
visibility. When you select a sublayer inside a layer, you will notice three new categories of properties: Symbols, Fields 
and Records: 
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These properties allow you to specify how you want to draw and display attribute information for features in the 
sublayer. The Web Mapping Application uses your configuration when identifying features and displaying task results 
as map tips. The red pushpin symbol and map tip information window are configured through layer properties: 
 

 
 

Defining the initial extent of the map display 
You can now explicitly define the visible area shown in your Web Mapping Application when the application starts. You 
will notice a new option for setting the initial extent under the list of layers that you have included in your application: 
 

 
  

Map preview fully supports pan and zoom 
When adding layers to your Web application, you can now pan and zoom around the preview window and ensure that 
the map display is properly configured. The pan and zoom controls appear in the upper-left corner of the preview 
window. (This only applies to the Manager for the Microsoft .NET Framework and doesn't apply to the Java platform): 
 

 
 

New Print task 
Manager now includes a Print task that enables printing in the Web Mapping Application. People who use your Web 
application can choose to print the map along with any results they want to display. When you configure the Print task 
in Manager you can specify a title, the map size, the output quality, and include map elements like a legend, North 
arrow and scalebar: 
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More symbolization options for drawing task results 
At 9.2, you could only specify the color used to draw your task results. 9.3 provides you with more options for 
controlling symbology. You can now draw point features by selecting a marker symbol from a palette of various types 
and sizes. For line and polygon features, you can now control line and fill colors and line widths: 
 

  
 
 

Task window automatically dismisses upon execution of a task 
Upon executing a task, such as Search Attributes, clicking the button to execute the task will now automatically 
dismiss the task window. To change this behavior, set the HideTaskUponExecution property on each task to false with 
Visual Studio. (This only applies to the Manager for the Microsoft .NET Framework. 
 

Overview Map 
Manager now allows you to configure the Overview Map with any map service layer and is no longer restricted to those 
layers in the Web application. To increase performance, the Overview Map will no longer be interactive by default. 
Thus, you won’t be able to drag or resize the red area of interest box. If you want to change this default behavior, set 
the StaticMode property of the Overview Map to false with Visual Studio. 
 

Copyright text 
You can now specify your own copyright text that you want to display in your Web application. 
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Mobile Projects 
 

Building mobile projects 
Manager now allows you to create and manage mobile projects. For more information, see the 'Mobile GIS' chapter in 
this document. 
 
 
OGC Services 
 

Accessing OGC services 
In addition to WMS services, ArcGIS Server now supports WFS and WCS services. You will also notice that in 
Manager on the Applications tab, WMS Services has been renamed to OGC Services. From here, you can get at the 
URLs for these services. 
 
 
Managing your GIS Server 
 

Registering ArcGIS Image Server 
If you have the ArcGIS Image Server extension, you can register it with ArcGIS Server and publish compiled image 
service definition files (.ISCDef) as image services. Click the Register ArcGIS Image Server link on the GIS Server tab: 
 

 
 

Improved and more detailed messages from the GIS server 
When troubleshooting problems, you can now get more detailed messages from the GIS server: 
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Log messages can vary in their level of severity from errors indicating a problem that requires immediate attention to 
common informational messages generated through regular use of the server. The log level setting determines the 
number and types of messages that get written. Following are ArcGIS Server's logging levels: 
 

• None - No logging. 

• Error - Serious problems that require immediate attention. 

• Normal - Warnings about problems that require attention and errors. 

• Info:Simple - Common administrative messages from the server, including messages about service creation. 
This level also includes warnings and errors. 

• Info:Standard - Common messages from use of the server that are logged at most once per request. This 
level also includes all Info:Simple messages, warnings, and errors. 

• Info:Detailed - Frequent messages from the server that could be logged multiple times per request, such as 
noting that each layer in a map service drew successfully. This level includes all Info:Standard and Info:Simple 
messages, as well as warnings and errors. 

• Verbose - ArcGIS Server developers can use this level to place debugging messages when testing server 
objects or server object extensions that they've developed. Includes all Info-level messages, warnings, and 
errors. 

 
By default, the log level of the server is set to Info:Simple, meaning messages whose severity is Error, Normal, or 
Info:Simple will be logged. 
 
 
Security 
 
The new Security tab in Manager allows you to define users and grant access to services and Web applications. For 
more information, see the section on Security below. 
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Web Mapping Application 

One of the first things you will notice when you create a new Web Mapping Application is that it looks a little 
different. All of the same pieces are there; they’ve just been rearranged to make it easier to use the application: 
 

 
 

Streamlined look provides better usability 
At 9.2, the Web Mapping Application focused most of the user actions in the left column console area. The console 
area contained five panels including the tasks in the application, the task results, the map contents, the navigation 
tools, and the overview map. Displaying all of these panels at once made it cumbersome to get to the particular action 
you wanted to perform. Often, you would have to close one panel just to see another one or alternatively undock a 
panel and allow it to float over the map. 
 
At 9.3, the console area contains only two resizable panels, one for the results and the other for the map contents. 
These panels are permanently docked in the console area so that they do not obscure the map. The tasks are now 
positioned horizontally above the map alongside the toolbar, which has shifted to the right. The navigation tools are 
always available and are now positioned over the upper-left corner of the map, allowing quick access to these 
frequently used tools.  
 

Enhanced map navigation 
To help you navigate the map more easily, the toolbar now includes previous extent and next extent buttons (shown as 
arrows on the toolbar) that allow you to go back and forward through any map displays you have generated: 
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Additionally, the zoom level control (+, -) is always visible now (at 9.2, it only displayed when the Web application 
contained a cached map service): 

 

 
 
If your Web application contains any cached map services, the zoom level control also displays a set of stepped 
intervals that represent the specific scales the map is cached at. 
 

Viewing task results 
Executing a task often yields several results. To help you find the location of a particular result on the map, highlighting 
it in the Results list will also highlight it on the map. Selecting Tyler Elementary School in the Results list highlights it 
(by drawing a larger symbol) on the map: 
 

    
 
To get more details about a particular result, just click on it to display an information window or map tip: 
 

 
 
The application developer has full control over the contents of the map tip window. 
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Identifying features 
When using the Identify tool at 9.2, identified features were always written out as results. At 9.3, the Identify tool pops 
up an information window, just like that shown above for task results. If you want to, you can add a particular feature 
you have identified into the Results list. 
 
By default, Identify displays feature attributes as a simple list of field names and their values. However, you can use 
the same formatting applied to tasks results here as well. The figure below shows the default information display (left) 
and a formatted one (right): 
 

  
 

Using the Overview Map 
The Overview Map can be toggled on and off from the toolbar and displays over the upper-right corner of the map: 
 

 
 
To increase performance, the Overview Map is no longer interactive by default. Thus, you won’t be able to drag or 
resize the red area of interest box. If you want to change this default behavior, set the StaticMode property of the 
Overview Map to false with Visual Studio. 
 

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 124 



Printing the map 
A new Print option in the Web Mapping Application allows you to generate a simple printed page that displays a title, 
map, legend, scale bar, North arrow and any selected task results.  
 

  
 
 
 

GIS Services 

New services 
 

Image services 
At 9.2, if you wanted to publish raster data, you added it to a map document and published the map as a map service. 
At 9.3, you now have another option for publishing raster datasets directly to the server as image services provided by 
the ArcGIS Image Server extension for ArcGIS Server. Which one should you use? The answer really depends on 
what you need to do. A simple way to think about the difference is a map service gives you a picture whereas an 
image service gives you the data too. For most applications that simply require drawing imagery as fast as possible, 
cached map services are still the best option. However, if your application requires access to the raster data itself, for 
example, you have a raster dataset that contains elevation values that you want client applications to be able to 
access, or you want client applications to be able to perform image analysis and processing, you would use the  
ArcGIS Image Server extension to publish ArcGIS image services. 
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The image service supports all ArcGIS raster datasets including TIFF, MrSID®, IMG files, and geodatabase raster 
datasets. You publish each raster dataset as one image service using ArcCatalog or ArcGIS Server Manager. 
Additionally, if you have ArcGIS Image Server, you can publish a compiled image service definition file (.ISCDef) as an 
image service as well. This allows you to take advantage of ArcGIS Image Server's on-the-fly server side mosaicking, 
and image processing, and make it available to the additional clients that ArcGIS Server supports—for example, web 
map services (WMS) or web coverage services (WCS) clients. For more information, see the 'ArcGIS Image Server' 
chapter in this document. 
 

Geometry service 
The geometry service provides access to sophisticated geometric operations such as projecting data, calculating 
buffers, and determining spatial relationships. The geometry service can be deployed in order to support client side 
applications that do not have the ability to independently perform such operations. For example, a developer building a 
JavaScript application might utilize the geometry service to create a 1000 meter buffer polygon around the user's 
current location and then find out what businesses fall within that buffer.  
 
 Unlike a map service, a geometry service has no data or state associated with it and thus, it would never be added 
directly to a map. Because of this, the geometry service is only visible when connecting to the GIS server as an 
administrator and not through a user connection in ArcCatalog. Additionally, the service is always called "geometry" 
and there may be only one geometry service running on your GIS server. 
 
 
Map service enhancements 
 

More functionality through internet connections 
• Draw nicer looking scale bars in your Web applications by exporting a scale bar from the map service 

(ExportScaleBar). 
• If the layers in your map service have relates set up, you can now access the related information through 

identified features. 
• You can now get information on how a map service is configured, for example, the maximum image height and 

width that you can request and the maximum number of records that can be returned by queries.  
 

Enhanced query support 
• Map services can now return generalized or densified geometries through a new object, LayerResultOptions, 

and through new methods: QueryFeatureData2, QueryFeatureIDs2 and QueryFeatureCount2 and existing 
methods: Identify, Find and QueryHyperLinks. This allows for improved query performance (less geometry & 
less information being passed through the network) and allows for the display of curves in web applications.  

• LayerResultOptions has two properties, FormatValuesInResults and ReturnFieldNamesInResults, that can be 
used with Identify and Find functions to get field names or field aliases and values as string or as in original 
data type.  

• Queries (using new function QueryFeatureData2) sent to the map service can be returned as KML. This allows 
you to display the results from a query in clients that support KML. 

• Identify now works with raster layers in the map service. 
• Find results now support domains and subtypes. 

 
Support for transparent backgrounds on map surrounds 

Map services can now export map elements with transparent backgrounds: scale bars, North arrows and legends. 
 

KML capability enabled by default 
When publishing a map service, the KML capability is enabled by default. This allows people to easily integrate map 
services with clients that support KML such as Google Earth. 
 
 
Improved map service caching 
 
Map caching is a very effective way to make your map services run faster. While it can take more time to author your 
map and build the cache, the performance benefits are well worth the additional time investment. At 9.3, the caching 
options have been greatly improved, making it easier for you to configure, build, and maintain your cached map 
services. Here’s a look at how the improvements help you successfully deploy cached map services. 
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New workflow makes it easier to create and manage map service caches 
At 9.3, we have addressed several workflow challenges that many people reported experiencing with 9.2. The result is 
a more streamlined workflow with the additional tools you need to help get the job done. One of the first things you will 
notice is a redesigned Caching tab in ArcCatalog. From here, you can enable caching and define the tiling scheme. 
Once defined, click Create Tiles to start building your cache: 
 

 
 
You can alternatively enable caching and define the tiling scheme from ArcGIS Server Manager. However, Manager 
does not support creating the tiles; you will still need to use ArcCatalog to do this: 
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Creating caches that work with ArcGIS Online, Microsoft Virtual Earth, and Google Maps 
Getting your data to display over ArcGIS Online, Microsoft Virtual Earth, and Google Maps base maps is now easier 
because the tiling schemes for these common base maps are now integrated into ArcCatalog and Manager. Simply 
load the desired predefined tiling scheme and build your cache. (Note: Your map must match the coordinate system of 
the online service, WGS 84 for ArcGIS Online and WGS 84 Web Mercator for Virtual Earth and Google Maps. WGS84 
Web Mercator is also a supported projection in ArcGIS Desktop): 
 

   
 
You can also load tiling schemes from existing map services or from a tiling scheme saved as a file. This makes it 
easy for you to create cached map services that need to share the same tiling scheme so they can be displayed 
together. 
 

Partial caching: building caches for specific areas of interest 
Building a cache that covers a wide range of scales and a large geographic area is a time consuming process that can 
sometimes take days to complete and require significant computing power and disk space. At 9.3, you do not have to 
pre-build the entire cache all at once; you can instead build tiles for specific areas of interest. You define your areas of 
interest based on where you think your users are most likely to visit, for instance, large metropolitan areas. So how do 
you specify your areas of interest? Just create a feature class, such as a shapefile, that contains the outlines of the 
areas you want to create tiles in. Using a feature class to build or update tiles allows you to precisely define your area 
of interest (at 9.2, you could only define rectangular areas of interest). For example, if you only wanted to create tiles 
within California, your feature class would only contain the polygon outline of California: 
 

 
 

Caching on demand: on-the-fly caching as your service is accessed 
With the cache on demand option, tiles are generated and stored on the server as users access your map service, 
instead of being precreated before the service is accessed. With on-demand caching, the first visitor to a specific area 
will have to wait for the map to draw and be added to the cache, but subsequent visitors will then take advantage of 
the cached tile. You can enable creating tiles on demand from the caching tab in ArcCatalog and Manager. Caching on 
demand avoids the overhead of precreating cache tiles and automatically focuses caching on the most heavily visited 
geographic areas in your service, but it does impose a performance penalty on the initial users of your service.  
 
An effective caching strategy is to combine partial caching and caching on demand by precreating tiles for areas on 
your map that will likely be visited heavily, and using cache on demand for less heavily visited areas. The diagram 
below shows how you could apply this strategy to the prairie provinces of central Canada. Most of the population lives 
in the southern parts of the provinces, as evidenced by the roads and towns there. You can precreate these tiles so 
that most users will immediately get the benefit of the cache. The tiles for the rest of the map can be created on 
demand, since fewer users are likely to navigate there. The cost of creating, storing, and maintaining the cache for 
these vast uninhabited areas would outweigh the benefit of fast navigation for the first visitor: 
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Keeping the cache up to date 
The set of tiles that comprise your cache are a snapshot of your data at the time the tiles were created. Over time, you 
will need to update the cache to reflect changes to your data. You update tiles from ArcCatalog in the same way you 
initially create them. And because you can now create tiles for specific areas of interest, you can easily update a 
region that has undergone a change; for example, you need to update the tiles to reflect a new housing subdivision in 
the local community. 
  
9.3 also allows you to more easily add or remove scales from your existing cache. Use the Manage Map Server Cache 
Scales tool to do this. 
 

Keeping client applications, like ArcMap and ArcGIS Explorer, in sync 
ArcMap, ArcGIS Explorer, and ArcGlobe all maintain local caches of the tiles that you have visited. This allows the 
application to draw faster because it does not need to go back to the server and get the tiles. However, it also means 
these applications may be displaying tiles that are no longer up to date. If you plan to update your cache frequently, 
you may want to prevent client applications from storing cache tiles locally by using a new option introduced in 9.3. 
This will ensure that users of client applications will always see the most up-to-date map when they access your 
service. To use this new option, uncheck the setting that allows clients to store tiles locally. This setting is checked by 
default: 
 

 
 
At 9.3 ArcMap has a new Cache tab in the Layer Properties dialog for layers referencing cached map services. This 
tab contains options that let the end user choose whether the cache tiles will be saved locally between sessions, just 
for the duration of the session, or not saved at all. (See the 'Mapping' chapter of this document for a screenshot). If you 
uncheck the 'Allow clients to cache tiles locally' option when you create a cached map service, the options that ArcMap 
users see in the Cache tab when they add that service into ArcMap allowing tiles to be saved locally are disabled.  
 

Getting the properties of a cache 
For people who write scripts to help manage their map caches, a new GetCacheDescriptionInfo method returns all of 
the cache properties in one call, including cache type, tiling scheme and image information. 
 

Improved performance for WMS  
Cached map services are now supported when you serve WMS, so WMS can now take advantage of the performance 
benefits of caching. Previously map services accessed as WMS were always returned as dynamic services. At 9.3. the 
WMS service will use the cache tiles for cached map services instead of generating an image dynamically. However, 
use of the cache tiles is of course limited to the appearance of the map with which it has been cached. If the end user 
of the WMS service, or a client application accessing the WMS, changes the coordinate system, layer visibility, layer 
order, background color, etc of the WMS, that request is satisfied by returning an image dynamically, bypassing the 
cache on the server.  
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Geocode service enhancements 
 

Get matched address locations in the requested coordinate system 
At 9.2, a geocode service was only able to return a matched address location in the coordinate system of the locator 
the service was created from. Now at 9.3, you can request that the geocode service return matching address locations 
in any coordinate system supported by ArcGIS Server. This will allow you to, for example, create a Web application 
that displays its layers in one coordinate system yet uses a geocode service referencing a different coordinate system. 
 

Display address locations in Google Maps or Microsoft Virtual Earth 
The geocoding service can now return results as KML which allows the result to be displayed in clients like Google 
Earth, Google Maps and Microsoft Virtual Earth. 
 
 
Globe service enhancements 
 

Improved globe service caching 
Several improvements to the globe service caching workflow make it easier for you to create and manage your globe 
service caches. At 9.2, vector data had to be cached using ArcGlobe then deployed to the server. At 9.3, the server is 
now able to perform all globe caching. On the Globe Service Properties dialog, click the new Update Tiles button to 
build your globe service cache with this new dialog: 
 

    
 
You can now also specify the levels of detail for each individual layer and choose to recreate all or just empty tiles.  
 

Update the cache for specific areas of interest 
Just like map service caches, you can incrementally update portions of your globe service cache by specifying a 
feature class that defines the areas you want to update. 
 

Easier to deploy caches to production servers 
You no longer need to use layer files (.lyr) or the Globe deployment wizard. Instead, just copy the globe document and 
caches to the production server. 
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On demand vector data support 
Vector data now behaves in a similar manner as other data types. You can display vectors on demand as well as 
generate the full data cache on the server. 
 

Downsampling improves performance 
Globe services are now able to use texture downsampling on textured objects to improve performance.  
 
With no texture downsampling; 638k building size: 5% texture downsampling; 214k building size: 

                
 
 
Geoprocessing service enhancements 
 

Enhancements for authoring maps and toolboxes you publish to the server 

• Tool layers – The creation of tool layers has been improved in 9.3. After creating a tool layer in ArcMap, you 
can open the tool layer and add features (if you are using a feature set parameter). Additionally, input feature 
classes are not automatically added as sublayers.  

• Feature and record sets – In ArcGIS Desktop, the feature set and record set data types commonly used by 
tasks have been improved. You can now enter existing feature classes or tables rather than just interactively 
entering features or records. The user interface controls display feature and record attributes as columns in a 
table as opposed to an entry form for each individual feature or record.  

• Script tools – Creating a script tool is easier and more intuitive. For example, it is easy to set up choice lists. 
You can also provide symbology for script tool outputs. 

• More symbolization options – 9.3 includes new options for symbolizing the output geoprocessing results. 
For feature layers, you can now set transparency on the symbolize features. For raster layers, you can 
symbolize using unique values, classified or stretched. Raster layers also support setting transparency, 
contrast and brightness. 

 
Publishing geoprocessing services 

At 9.2, you could inadvertently publish an invalid geoprocessing service. For example, this could happen when you 
published a map document with a layer that didn’t exist, or included an unsupported data type as a parameter. 
Although the GIS server caught such errors and wrote messages to the server log files, the messages would not be 
written until after the service was published (or in some cases, used for the first time). At 9.3, the server checks for 
errors at the time of publishing and immediately displays them to you if any occur. This prevents you from publishing 
services with errors. 
 
Additionally, you now have the option to suppress execution messages returned by the geoprocessing service. These 
messages can sometimes include sensitive information, such as the internal pathnames to data sources, that you do 
not want people who use your service to see. At 9.3, the messages will be suppressed by default. To change the 
setting, edit the service in ArcCatalog or Manager and toggle the Show Messages parameter on the Parameters tab. 
 

Improved performance 
Here are some of the performance improvements made for 9.3: 

• Large record sets load and save much faster. Transferring 100,000 features to/from a server went from 40 
minutes down to 2 minutes. 

• Tools execute faster with feature sets and record sets. 
• Tools execute faster with SDE (9.2 SP4) because the SDE connections are now cached. 
• Python script tools can now execute in-process, yielding faster performance. 
• Faster synchronous tool execution. 
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Get geoprocessing results in the requested coordinate system 
GIS 

lts in client applications that display data using a different coordinate 
ystem than the geoprocessing service. 

 

At 9.3, you can request that the geoprocessing service return its output in any coordinate system supported by Arc
Server. This allows you to display your resu
s

Display geoprocessing results in Google Maps or Microsoft Virtual Earth 
The geoprocessing service can now return results as KML which allows them to be displayed in Google Maps and 

 
Virtual Earth. 

Better documentation with more samples 
For 9.3, almost all of the help topics on geoprocessing in ve been rewritten. You 
will find better conceptual topics as well as practi ap documents 
with tool layers inside them, how to create and publish ce. One of the 
main goals was to provide you with numerous sample es you 
will now find in the Help system are: 

• Buffer points, lines, or polygons. 
• Generate a stream network from flow an ation data. 
• Compute a watershed polygon. 
• Find nearby features. 

O
 

the ArcGIS Desktop Help system ha
cal topics that explain, for example, how to author m

 models, and tips for getting the best performan
s that you could look at and learn from. Some of the sampl

d accumul

• Clip and download data. 
 
 

ther service enhancements 

To h
idle time tances—down to the minimum instances set—when they 
hav o
 

elp keep the GIS server running optimally, a new property on the Pooling tab of a service allows you to set the 
out. This property will allow the server to remove ins

e n t been used in the last 30 minutes (by default), thereby reducing the load on the server: 

 
 

At 9.3 ArcGIS Server now supports the ArcGIS Schematics extension and the ArcGIS Geostatistical extension. 
 

If your organization is publishing web-based services with ArcIMS or ArcGIS Server, you can now provide GIS 
professionals using ArcGIS Desktop with easy access to your services by simply including map, layer or globe files  

MXD, .LYR, .3DD files) on your organization's web pages. Desktop users can click on these files to launch them (.
ins  way ArcGIS Desktop users don't have to make connections to servers in 

vice names in order to use your services. Another 
ces is that you can also easily include other third 

party se ta 
you are an ArcGIS Online basemap to provide the background.  
 

ide ArcMap or ArcGlobe. In this
ArcCatalog or the Add Data dialog and deal with often cryptic ser
advantage to creating map, globe or layer files containing your servi

rvices in the file you create. For example, you could create an MXD file containing a layer referencing the da
 serving and a layer referencing 

For ips about putting files made with ArcGIS Desktop on the web, please see the 'GIS servers  t and services > 
Cre ' topic in the ArcGIS Desktop 
Hel t ndex.cfm?TopicName=Distributing_maps,_globes,_and_layers_on_the_Web   

ating and publishing web maps > Distributing maps, globes, and layers on the Web
p: h tp://webhelp.esri.com/arcgisdesktop/9.3/i
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Security 

Ar s and Web applications. ArcGIS 
o 

ured security on your services and Web applications by working with these various security 
omponents using the standard configuration tools they provide. At 9.3, ArcGIS Server implements a role based 

se users, assign permissions to them based on the role they assume, 

 
Bef  y s, you need to define where to store the set of 
use an  In Manager, you do this on the Security Tab: 
 

cGIS Server has always allowed you to prevent unauthorized use of your service
server utilizes existing security mechanisms provided by operating systems, Web servers, hardware devices, and s
on. At 9.2, you config
c

curity model that allows you to define a set of 
and grant access to particular services and Web applications. To make it easier for you to configure security, all of 
these activities are now centralized in Manager.  
 
 
Managing users and roles 

ore ou can begin granting access to services and Web application
rs d roles your system will support.

 
 
Depending on what platform you are running on, you have several options for storing users and roles. 
 
ArcGIS Server for the Microsoft .NET Framework 

• Windows users and groups – users have accounts on the local Windows server or on the domain server to 
which the local server belongs. 

• Microsoft SQL server – you may use the Express version of SQL Server, included with ArcGIS Server, or your 
own install of SQL Server. 

 • Custom provider – this may include other types of databases and XML files. This option uses an ASP.NET
custom membership provider. 
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ArcGIS Server for th

• Default stora
• External data

e Java Platform 

ge location – deployed with the Java Manager (Apache Derby). 
bases – support for any database accessible via JDBC driver, for example, SQL Server, Oracle, 

and DB2. 
 • LDAP Servers – supports standard directory servers (LDAP v3), for example, Sun One Directory Server, IBM

Tivoli® and so on. 
• Active Directory – Microsoft’s directory server. 

 
Once you have defined the storage location, you can add users and assign them particular roles: 
 

 
 
 
Securing GIS services 
 
You control access to services from the Services tab in Manager. You can set permissions on folders as well as 
individual services. Setting permissions on a GIS service secures access to it via all supported Web interfaces: SOAP, 
REST, OGC and KML: 
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Securing Web applications 
 
You n  
conf r
Jav E
 

 co trol access to Web applications from the Applications tab in Manager. While Manager provides an interface for
igu ing security, it’s simply automating the standard security configuration of Web applications in ASP.NET and 

a E  (for example, editing the contents of the web.config file of an ASP.NET Web application). 

      
The ArcGIS Token Service 
 
The ArcGIS Token Service provides a simple way for desktop (e.g., ArcGIS Desktop and ArcGIS Explorer) and Web 
applications to access and use secured ArcGIS Web services. The ArcGIS Token Service, installed with ArcGIS 
Server, is a Web service that can validate a user and return a token that can then be used to access secured GIS 
services. A token is simply an encrypted string that contains the user name, an expiration date, and an identifier, such 
as a URL or IP address that the secured GIS services will be accessed from. Client applications include the token with 
any requests sent to the GIS server and the GIS server reads the token and grants access to GIS services based on 
the user’s role. The use of tokens is transparent to end users of applications. ArcGIS Desktop, ArcGIS Explorer and 
the Web ADFs automatically obtain and use tokens. Client applications, such as those built with the JavaScript APIs, 
will require the application developer to explicitly obtain a token and incorporate it into their applications. Developers 
can access the GetToken Web page to generate a token: https://<your server>/arcgis/tokens/gettoken.html: 
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Interoperability 

Enhanced KML delivery 
 

Authoring KML enabled services 
9.3 introduces several new features that allow you to control how your map services display in KML client applications. 
 

• The KML Description for a feature is no p configured for the feature layer in 
ArcMap.  

• Point features are no longer automatically labeled. Additionally, you can now control the label size and color by 
defining these properties in ArcMap: 

• Any legends authored in the layout view of ArcMap will be exported for Network Links authored in Manager 
and the Generate KML option in Services Directory: 
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Legends authored in ArcMap can be viewed in KML 
clients like Google Earth. 
     

lishing KML enabled services 
ends the GIS server’s ability to support KML client applications. 

The KML capability is enabled by default for map services, allowing you to display the service in KML client 
applications. Additionally, queries against map services can be returned as KML, for example, finding all cities 
in a layer with a population greater than one million. 

Geocoding and geoprocessing services can now return their results as KML. 

Image services can display in KML client applications. 

Map and image services can return their footprint (the center point of the extent of the data). 

ove functionality is supported by the new ArcGIS Server REST API (described below). The 9.2 URL for the KML 
ity (KMLServer) continues to be supported for backward compatibility. 

suming KML services 
a GIS server can provide a direct URL to a KMZ file representation of a particular service or output from a 
 (through the ArcGIS Server REST API). This allows you to share your services by simply sharing the URL to 
or example, you might send the URL in an email or incorporate it on a Web page. The figure below shows a 
ge that has embedded links to services. When you click on a link, the GIS server returns a KMZ file that can be 
 directly in an application like Google Earth: 
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As a We use the Services Directory to examine the contents of 
a GIS serve  your Web page. The Services Directory is described in 

 
 

 
Open G GC) Web services provide ay that you can make your maps and data available in 
n open, internationally recognized format over the Web. The OGC has defined specifications for making maps and 

da  a supported client application. 

b developer building a page like the one above, you can 
r and get access to the URLs that you will embed in

more detail below.  

Expanded OGC support 

eospatial Consortium (O  a w
a

ta available on the Web to anyone with
 

New support for WFS and WCS 
At 9  A
Service
as raste overages). When you publish your GIS resources in 
Manage s which service types can 
exp  
 

.2, rcGIS Server supported the WMS (Web Mapping Service) capability. 9.3 adds support for Web Feature 
s Transactional (WFS) for serving data as vector features and Web Coverage Services (WCS) for serving data 
r coverages (not to be confused with ESRI's ArcInfo c
r or ArcCatalog, you can enable these OGC capabilities. The table below show

ose OGC capabilities: 

 WMS WFS WCS 
Ma sep rvices X X X 
Geodata services  X X 
Image services X  X 

 
Support for Styled Layer Descriptor in WMS 

n. Styled Layer Descriptor (SLD) is an OGC specification that describes how layers in a WMS service should be draw
At 9.3, ArcGIS Server WMS services support SLD. Through SLD, a WMS service publisher can create and advertise 
multiple styles for each layer. WMS users can switch between different styles published by the server, or they can 
create styles in SLD at client-side and request the WMS server to render the map in their own style. 
 

Support for cached map services in WMS 
As mentioned above, WMS services now support cached map services, greatly improving the performance of WMS 
served using ArcGIS Server.  
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Web developer tools 

Web ADF for the Microsoft .NET Framework 
 
In general, the 9.3 Web ADF is built on the same framework provided with 9.2. However, 9.3 contains numerous 
updates that enhance and streamline the usability and performance of the product. The new features include: 
 

Microsoft Vista support 
Make sure you consult the ArcGIS Server Installation Guide, included on the installation media, when installing ArcGIS 
Server on a machine running Windows Vista or Windows Server 2008. The Installation Guide lists the prerequisites for 
installing ArcGIS Server on a machine running either of these operating systems. Specifically, there are some 
instances when the Web Applications feature (e.g., Manager) will not be installed because IIS does not have the 
necessary features enabled. You can avoid this scenario by ensuring that the appropriate features are enabled as 
described in the Installation Guide before installing. 
 

Microsoft Visual Studio 2008 support 
 

Microsoft .NET Framework 3.0 and 3.5 support 
 

Microsoft ASP.NET AJAX support  
Microsoft ASP.NET AJAX provides a comprehensive AJAX solution for both client and server solutions. 
The ASP.NET script callback framework on which 9.2 was built will still work and be supported in 9.3. However, the 9.3 
roduct requires ASP.NET AJAX to support an enhanced JavaScript API and the use of Web ADF controls in p

an ASP.NET AJAX partial postback solution. Note, 9.3 Web ADF controls are already ASP.NET AJAX enabled 
and thus do not need to be included in an UpdatePanel. 
  

Map control 
he following changes have been made to the Map control: 

er.ashx, is provided as a light-weight map drawing solution. As a result, 

 
to define a tiling scheme. A resource item 

se the tiling scheme defined by the cache. Cached services with 

on makes zooming the map in and out more visually pleasing.  

• The “show pendi solution,” added in 9.2 sp2 using the JavaScript map.pendingTiles property, is no 
alid. In 9. ap co contai al activity indicator (progress bar).  

 

T
 

• A custom HTTP Handler, MapHandl
the page lifecycle will not be traversed for a map draw operation. 

• The map-centric tiling scheme has been removed. Instead the tiling scheme can be defined for each resource
item. A resource item that generates dynamic maps may choose 
that works with cached image tiles will u
different properties can reside within the same map. 

• A new progress bar indicates the status as map content is retrieved and displayed. 

• A new Extent property allows you to define the initial extent that displays when the map first draws. 

• New zoom animati

ng tiles 
3,  Mlonger v  the ntrol n  interns an

Toolbar contr
he toolbar conta

ol 
ins two ne ap navigation option ne displays the previous extent and the other the next extent. T

 
w m s: o

MapTips control 
HeaderFormatString and BodyFormatString properties are obsolete. Use LayerFormat instead. 
 

OverviewMap control 
o optimize performance, the overview map will, by default, only request a single image from the servT

w
er at startup and 

i sociated Map changes. You can change this behavior by setting the ll no longer update as the map extent in the as
StaticMode property. When the overview map is in static mode, the area of interest box is non-interactive as well.  
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ZoomLevel control 
At 9.2, the ZoomLevel control only appeared wh
the map contains only dynamic services. If your

en the map contained cached services. At 9.3, it is also available when 
 Web application contains any cached map services, the zoom level 

control will also display a set of stepped intervals that represent the specific scales the map is cached at: 
 

 
 

Scalebar control  
At 9.2, the scalebar displayed differently when connecting to map services via an ArcGIS Server local vs. internet 
connection. At 9.3, there will be no difference and the scalebar will look like this: 
 

 
 

New controls  
The following new controls have been added at 9.3: 
 

image. 
n be used to select a color. Available colors include all the 

rs in the .NET System.Drawing.Color structure. 
ly invoked by right-clicking a control. 

• MapCopyrightText – Displays copyright text on its associated Map.  
• PrintTask – Enables users to print a map and task results, along with a legend, scalebar, and North arrow. 
• DockExtender – Allows a control to be docked to the Map. 
• HoverExpandExtender – Allows a control to have a minimized state, represented by a semi-transparent 
• ColorPicker – Provides a runtime dialog which ca

named colo
• ContextMenu – Displays a context menu and is typical

 
Tasks 

Sev l
 

•  

stom icon that will appear 

pport custom task 

d ensure they are 
properly configured and return detailed error messages when appropriate. 

era  enhancements have been made to how tasks work: 

• Hovering over a task result in the TaskResults control will now highlight the associated feature in the map. 
This helps people associate a particular result with its location on the map. 

Tasks have a new property called HideTaskUponExecution that will dismiss the task window automatically
upon execution of a task. The default value is true. 

• When creating a custom task and incorporating it into Manager, you can specify a cu
next to your task in Manager. 

• Two new interfaces, IDefaultWebConfiguration and IWebConfiguratorValidation su
developers. If a task can be configured without user interaction (like the Print Task), IDefaultWebConfiguration 
allows the task to provide default markup. Previously the recommended way to do this was to use the 
ToolboxData attribute. IWebConfiguratorValidation can examine all required properties an

 
MapResourceManager  

apResources now expose layer definitions to define query results. This allows you to set a drawing symbol, field M
visibility and aliases, and format the record display on any task results. For example, the SearchAttributes and 

ontrol and Map QueryAttributes tasks use the layer formatting when displaying their results in the TaskResults c
ontrol. c

 
Web Mapping Application template  

The Web Mapping Application has a new look and feel for 9.3. ASP.NET AJAX is enabled by default. As a result, a 
ScriptManager is included and partial postbacks are utilized for asynchronous communication. For more information 

bout the user interface changes, see the section above describing the Web Mapping Application. a
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New method enables
The DisplaySettings class has a new property, EnableDynamicTiling, that allows you to control whether or not a 
MapResourceItem should draw using dynamically generated tiles. When EnableDyanamicTiling is set to true, the 
MapResourceItem will appear to pan seamlessly, as it did in 9.2. When set to false, a single image will be requ

 or disables seamless panning  

ested 
om the server whenever the map is panned. You set this property inside of Visual Studio through the Map Resource 

Display Settings Editor shown below: 
 

fr

          
 

Web 
The e
MapTip
 

ADF JavaScript Library  
 W b ADF JavaScript Library enables interaction with the following in a script environment: Map, Graphics and 

s, and dynamic data sources. This library is now fully documented in 9.3. 

W b
se f d with the Web 
D in C:\Inetpub\wwwroot\aspnet_client\ESRI\WebADF\JavaScript) but cannot be altered and used with a Web 

y to interact, extend and customize portions of the Web 

e  controls 
De aultWebResources, WebResourceLocation only apply to images. JavaScript files are includeU

A F (e.g., 
ADF application. Instead, use the Web ADF JavaScript Librar

DF via client side scripting. A
 

C lb
Use JSO rmat. The CallbackResult class 
has F 
controls (e.g., Toc is buddied to a Map control). 
 

al ackResults  
N (JavaScript Object Notation) strings instead of custom Web ADF string fo

static methods to create custom Web ADF callback results. Copying or adding callback results between Web AD
 that maintain a property relationship is not required 

Loc lization  
tains full support for localizing t
a

9.3 con he Web ADF and Manager in non-English locales  
 

S A
The We
value ob n 
embedd
ttp://res

O P API  
b ADF ArcGIS Server library contains new GeometryServer and ImageServer proXY classes and supporting 
jects corresponding to the new ArcGIS Server service types available in 9.3. A new token service provides a
ed security solution. Refer to the ArcGIS Server SOAP SDK documentation for more information: 
ources.esri.com/help/9.3/arcgisserver/apis/soap/index.htm h

 
 
Web ADF for the Java Platform 
 

Updated Developer IDE support 
eveloper plug-ins support for Eclipse 3.3.x and NetBeans 6.x. These are the most up to date release of the two most 
o des support for Java EE 5, a graphical HTML/JSP/JSF editor, and quick 

D
p pular Java developer platforms and inclu
access features to enhance IDE navigation.  
 

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 140 



 
 

Java 5 support 
The Java Web ADF takes advantage of many new features offered in Java EE 5. Java EE 5 simplifies development 
and is the industry standard for developing portable, scalable, and secure server side Java applications. For more 
information about the Java EE platform and how to get the specification, see http://java.sun.com/javaee. 
 

Visualization of Query Results 
The introduction of new callout window technology provides a rich visualization mechanism for results to be displayed 
in your Java Web ADF map application: 
 

 
 

Print Task 
A ox Print Task allows you to print a web page with a map, legend, and results ready for browser new out of the b
printing.  
 

Clustering S
Clustered Java Application Server support that allows Java Web ADF applications to be deployed in an enterprise 
clustered environment.  
 

upport 

Graphics Resource 
he new Graphics Resource feature allows features to be added to aT  Java Web ADF map, toc, and overview controls. 
hese features, when added to a Java Web ADF map application, also support queries by identify.  T

 
Updated Java Help System and JavaDoc API Reference Documentation 

 
Updated Web ADF JavaScript Library 

 
SOAP API 

The Web ADF ArcGIS Server library contains new GeometryServer and ImageServer proXY classes and supporting 
alue objects corresponding to the new ArcGIS Server service types available in 9.3. A new token service provides an 

embedded security solution. Refer to the ArcGIS Server SOAP SDK documentation for more information: 
http://resources.esri.com/help/9.3/arcgisserver/apis/soap/index.htm 

v
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New ArcGIS Server REST API for working with published services 
 
REST, an acronym for Representational State Transfer, is an architectural style utilized by networked systems, such 
as the Web, to access resources. The ArcGIS Server REST API provides a simple, powerful, and open Web interface 
to GIS services hosted by ArcGIS Server. It is easy to program against GIS services using the REST interface. All 
resources and operations exposed by the REST API are accessible through a URL for each GIS service published 
with ArcGIS Server.  
 
When using the REST API, you typically start from a well-known URL endpoint, which represents the server catalog, 
and from there you can navigate through the list of services, folders and operations on a server. You do n
enerate URLs to services by hand. Each ArcGIS Server comes with a web-based Services Directory that provides 
o y to browse a GIS server. To get to the root directory of your GIS server, the URL is: http://<your 

ot need to 
g
y u with a simple wa
server>/arcgis/rest/services. For example, here's the Services Directory page for ESRI's ArcGIS Online server: 
 

 
 
You can access this at: http://server.arcgisonline.com/ArcGIS/rest/services. In addition, here are the Service 
Directories for the two ArcGIS Server 9.3 sample servers: 
http://sampleserver1.arcgisonline.com/ArcGIS/rest/services
http://sampleserver2.arcgisonline.com/ArcGIS/rest/services
 
Fr URL, you can traverse to any of the listed services and resources and operations associated with the 

o do 
opment in additional environments such as Microsoft Silverlight. For more information on the REST API, see 

rcGIS Server REST API at: http://resources.esri.com/help/9.3/arcgisserver/apis/rest/index.html

om the base 
service. The REST API supports responses in several formats such as HTML, JSON, and KMZ, and enables you t
web devel
A
 

ith the new ArcGIS JavaScript APIs 

Su  embed a map into a web application or create a simple overlay of your data on an online 

 code (ASP.NET, 
tc.) is required, although it is possible to use server-side logic for additional functionality.  

 
he ArcGIS JavaScript APIs use online JavaScript libraries that are hosted by ESRI, which makes it easy for you to 

de vaScript API application without installing any ESRI software. The 
avaScript APIs utilize the ArcGIS Server REST API to access information about your services. There are three 

dif cript APIs that you can use: 

 
Building mashups w
 

ppose you just want to
base map. You can now build these kinds of applications, sometimes called mashups, with the new ArcGIS JavaScript 
APIs. These applications consist of client-side JavaScript and related dynamic HTML. No server-side
e

T
ploy your applications. You can build a Ja

J
ferent JavaS

 
• ArcGIS JavaScript API 
• ArcGIS JavaScript Extension to Microsoft Virtual Earth 
• ArcGIS JavaScript Extension to the Google Maps API 
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ArcGIS JavaScript API  
he ArcGIS JavaScript API offers a simple browser-based experience for building mappinT g applications and doing 

, analysis. You can fuse data sources from different servers, perform identify and find operations, add points of interest
and add markup graphics. Here is an example application where you select a point of interest and the map then 
displays the demographic information for the area around that location: 
 

 
 

ArcGIS JavaScript Extension for Microsoft Virtual Earth  
The ArcGIS JavaScript Extension for Microsoft Virtual Earth allows you to display your ArcGIS Server maps over the 
Microsoft Virtual Earth base map. You can perform query and geoprocessing tasks on your services and work with the 
results (as VEShapes). You can also perform geocoding operations and view the results on the base map. Here is an 
example that allows you to enter a year and displays the path  of hurricanes for that year: s
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ArcGIS JavaScript Exten
The ArcGIS JavaScript Extension for the Google Maps API allows you to integrate your maps with the Google Maps
base map layers. You can perform query and geoprocessing tasks on your services and work with the results as 
features. You can also publish your content as Google Mapplets for use inside the Google Maps 'My Maps' tab. H
is an example that finds the route between two points and displays the te
 

sion for the Google Maps API 
 

ere 
rrain profile of the route: 

 
 
 
 

For full information about these new APIs, please see this page in the ArcGIS Server Resource Center: 
http://resources.esri.com/arcgisserver/index.cfm?fa=jsapis
 
 
New Flex API for creating rich web-based user interfaces 
 

The ArcGIS API for FLEX provides FLEX developers with a simple but powerful API to create rich web mapping 
applications. It is fully integrated with Adobe Flex Builder™ 3. At the time of writing, the ArcGIS API for Flex is in public 
beta. Full description, download, samples, and demo at: http://resources.esri.com/arcgisserver/apis/flex. 
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Extensions 

ArcGIS 3D Analyst 

ArcGlobe 

Improved default layers 
You can now use the same default online globe in ArcGlobe that is provided in ArcGIS Explorer. This default globe 
uses free ArcGIS Online services. To turn this on, go to the ArcGlobe Tools > Options dialog > Default Layers tab: 
 

 
 

Improved support for free ArcGIS Online services and support for new ArcGIS Online Premium Services 
Please see the 'Adding web data into your maps' section in the 'Mapping' chapter in this document 
 

More realistic background display 
rcGlobe now has options to include stars and an atmospheric halo in its background display. To turn these options 
n, go to the View > Globe Properties dialog Background tab: 

A
o
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Improved Pan functionality that w
The Globe Pan tool (and the middle-mo
same elevation as the camera moves. 
made with gesturing, so that if animate

orks like ArcGIS Explorer 
use button of the Navigate tool) will now keep the observer position at the 

This is the same experience as in ArcGIS Explorer. Improvements were also 
d rotations are enabled then you can 'throw' the view and 'drift' across the Globe 

as though flying. Again, this is the same experience as ArcGIS Explorer. 
 

Ability to use images as billboarded marker symbols (ArcGlobe and ArcScene) 
e an image file as a symbol. The image is added as a texture on to a flat 

rker symbol. The image file types supported include: png, jpg, jpeg, bmp, 

 

3D Marker symbols can now directly consum
piece of geometry and is added as a 3D Ma
tif, gif, cel, tga, rgb, rgba, int, and inta: 

 
 

Two new marker symbol styles 
Two additional sets of PNG-based images to use as marker symbols are now provided for use in ArcMap, ArcGlobe 
and ArcScene: '3D Billboards' and 'ArcGIS Explorer' These are particularly effective for large point feature classes: 
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New tutorial exercise on building realistic 3D views (eg: virtual cities) 
d Exercise 9 in the 3D Analyst tutorial shows a standard workflow for creating a realistic 3D view using symbology an

display options. 
 

Display improvements in ArcGlobe 
There have been many general improvements to the stability and performance of the ArcGlobe display, particularly for 
ele e line and the north/south 45 

 as 'halos', particularly around tree symbols: 

vation layers. Improvements have also been made to handle data that crosses the dat
latitudes. Support is provided for multiple caches for raster catalogs, to better support time animations for overlapping 
data. ArcGlobe also now supports a minimum transparency threshold manipulation for textured 3D objects with partial 
transparency, which is sometimes seen
 

 
 

KML improvements in ArcGlobe 
t rcGlobe has been improved to include support for KML 2.0 and 2.1 tags, screen 

extured COLLADA:            Screen overlays: 

 
 

A  9.3, support for accessing KML in A
overlays, auto-refresh behavior in KML network links, and support for embedded COLLADA models in KML. Many 
other improvements and fixes in how KMLs are displayed have been made: 
 
T
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COLLADA support  
ArcGIS 9.3 includes support for the Collaborative Design Activity (COLLADA) file format. Using these new capabilities
ArcGIS users wil

, 
l be able to leverage COLLADA files for a variety of purposes in ArcGIS Desktop and ArcGIS Server 

s well as display more realistic 3D models. COLLADA files can be used as 3D point symbology in ArcGlobe and 
Ar LLADA files can also be served via the ArcGIS Server 3D extension. In 
a

cScene. Features symbolized using CO
addition, users can import COLLADA files into the geodatabase as multipatch features and directly display them in 
ArcGlobe if they are embedded inside KML files. 
 

Globe graphics improvements 
These include improved access to setting default graphic properties, auto-calculated sizes for adding text elements 

ased on distance), the ability to pin graphics to the Globe surface, and the addition of draped and billboarded text 
graphics: 
 

 
The 3 options for text elements (3D, draped and billboarded) 
 

(b

New perimeter-based extrusion option for lines / polygons in ArcGlobe and ArcScene) 
ArcGIS 3D Analyst now supports a new perimeter-bas d extrusion option for lines and polygons, where the exterior of 

e line is extruded on a per-vertex basis, creating an exterior wall that is stitched together such that it follows the 
le imeter. The top of the extruded polygon is then calculated using opposing 

e
th
e vation (or z-aware profile) of the per
vertices, creating a best-fit top that does not necessarily match the underlying elevation surface for the interior of the 
polygon. This extrusion option is supported in both ArcGlobe and ArcScene. The option is exposed as the ‘adding it to 
each feature’s base height’ item in the ‘Apply extrusion by:’ combobox on the Globe Extrusion tab of the Layer 

roperties dialog: P
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Support for the Tracking Analyst extension in ArcGlobe 
This enables you to create 3D visualizations and applications that incorporate time-based tracking. 
 

Support for HTML popups in ArcGlobe and ArcScene 
The new HTML Popup tool added to ArcMap, has also been added to ArcGlobe and ArcScene. Defining HTML pop
is particularly useful in ArcGlobe when preparing data to be converted to KML. See the Mapping chapter of this 
document for more information. 

ups 

 
Improved bookmark support in ArcGlobe and ArcScene 

rk 
or 

mation. 

Like in ArcMap, ArcGlobe and ArcScene now have a separate Bookmarks pulldown menu and an improved Bookma
Manager dialog that allows bookmarks to be loaded and saved as files. See the 'Mapping' chapter of this document f
more infor
 

Cache management 
The location of the cache for a layer added into ArcGlobe is now 
dialog.  
 
 
 

3D Analyst functionality 

shown on the Cache tab of Globe Layer Properties 

New Window size pyramid type for terrain datasets 
The window size pyramid type thins point data for each pyramid le
(windows) and selecting just one or two points from each wind
based on one of the following: point with the minimum z-value, poi
and maximum, or the point closest to the mean z-value. Building a

vel by partitioning the data into equal areas 
ow as representatives of the surface. Point selection is 

nt with the maximum z–value, both the z minimum 
 terrain with the Window Size pyramid type is 5 to 10 

ti  to the performance gain the window size pyramid 
 (i.e., tree canopy, vegetation, buildings, etc.). The Z 

o as the only pyramid 

times faster than the Z Tolerance based pyramid type. In addi
ype is more effective at dealing with all/first return LIDAR data

on
t
T lerance pyramid type works best with bare earth data. The Z Tolerance pyramiding algorithm w
type available at ArcGIS 9.2, allowing ArcGIS to handle mass amounts of clean bare earth data extremely well. In this 
latest release, a Window Size pyramiding algorithm is provided to generate surfaces that include features such as 
buildings and vegetation. A new panel has been added to the Terrain Wizard in order to specify the appropriate 
pyramid type for terrain datasets: 
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Support for terrain datasets in Interpolate Shape and Line Of Sight tools 
 datasets as an 

put surface. Previously these geoprocessing tools would perform such analysis on only either a raster or TIN surface. 
At rrain datasets as an input surface: 

The Interpolate Shape and Line Of Sight functional surface geoprocessing tools now support terrain
in

 ArcGIS 9.3, these tools now have the capability to use a te
 

 
 

 
New Point File Information tool 

A new Point File Information geoprocessing tool scans folders of 3D point files and outputs a polygon feature class 
containing one record in the attribute table for each 3D file present in the selected folders. Folders containing LAS 
and/or ASCII files can be used to generate a polygon feature class. The feature class includes a bounding box extent 
as a polygon or 3D multipatch for each 3D file encountered. The attribute table contains valuable statistical information
for each 3D point file found. The statistical information provided includes: the file name, the number of points, the 
estimated point spacing, and z minimum and maximum values for each file. The point file information tool allows yo
get an overall understanding of each 3D point file for QA/QC purposes before loading the 3D point files into the 

eodatabase. The average point spa

 

u to 

cing of a 3D point dataset is the basis for the tiling scheme of a terrain dataset.  
sly, you would have to rely primarily on a vendor's descriptions of the dataset. You can now use the Point File 

Information tool to confirm the average point spacing of the data prior to building a terrain dataset. The Point File 
information tool can be found in the 3D Analyst toolbox, under Conversion, and then in the From File toolset: 

g
Previou

 
 

Support for LIDAR intensity attribute 
The LIDAR intensity attribute commonly contained within ASCII LIDAR files is now supported. This new functionality is 
focused on importing ASCII LIDAR data into the geodatabase using the ASCII 3D To Feature Class geoprocessing 
tool. XYZI format (I represents the LIDAR intensity) is a new Input File Format found on the ASCII 3D To Feature 
Class geoprocessing tool. The LIDAR intensity attribute is automatically stored as BLOB attributes and accessed only 
through Arc Objects.  

 
Better support for decimal delimiters 

Decimal delimiters (. or ,) in a text file can now be declared in the ASCII 3D To Feature Class and Feature Class Z to 
ASCII geoprocessing tools. This enhancement is a significant improvement for international users. Previously users 
requiring a comma delimiter in text files had to convert the text file to a decimal delimiter: 
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Profile Graph tool can now profile multiple lines in one graph 
Previously the Profile Graph tool would generate one profile graph for only one line at a time. More detailed analysis 
can now be completed with several lines shown in one single profile graph: 
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Profile Graph tool can now graph line of sight results. 
In ArcGIS 9.3, line of sight results can now be plotted using the Profile Graphic tool, including multiple lines of sight: 
 

 
 

New Contour with Barriers tool 
3D Analyst and Spatial Analyst have a new surface contouring tool in 9.3, the Contour with Barriers geoprocessing 
tool. This tool compliments the Spline with Barriers tool added in 9.2 by allowing you to intelligently contour an 
interrupted surface. The Contour with Barriers tool has many advantages over the existing Contour tool: 

•  Smoother contours 
• ntelligent default rendering 

•  No 2GB size limit  
 

 I
•  Cartographic labeling with Maplex 
•  Honors barrier features, snaps contour geometry to the barrier 
•  Write output directly to geodatabase 

Improved Spline with Barriers tool  
The tool has been updated in 9.3 by making the barrier feature class optional. Now you can use it without barriers as a 
smooth spline algorithm. We have also improved the tool validation and user experience, and improved performance 
by running it in-process. 
 

Create 3D features from graphics in ArcMap 
The new Drawing > Convert Graphics To Features command in ArcMap can be used to create 3D (Z-aware feature 
classes) from any 3D graphics drawn or pasted into ArcMap. The heights of 3D point graphics added to ArcMap with 
the Interpolate Point tool, and 3D line graphics added with the Create Contour tool, in the 3D Analyst toolbar is now 
stored in the Element Name field in the Size and Position tab of the graphic property dialog. In this way if you use the 
Convert Graphics To Features command to convert these graphics to 3D features, the height of each graphic is 
automatically used to populate the Name attribute in the output 3D feature class. 
 

Easy to find the heights of 3D points drawn in ArcMap 
You can find the height of any 3D point graphic drawn in ArcMap by looking in the new Location tab in the graphics 
properties dialog. This height is based on the surface that was active when the graphic was added and is in the same 
units as that surface: 
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New 3D geometry COM interfaces have been added for developers for 3D analysis 

R

oint if 
pty. Two geometries intersect if disjoint is "false". 

 
IPro m
3D x ware geometries or the distance from a given 
poin o
 

D 
eometry to the input point in 3D space. Depending on the method of 

rest point, in 3D space, on a z aware geometry to the input point. Depending on the 
n also be found on an extension of the geometry. 

oints. A curve can be composed of a 
in  containing many paths of segments. The properties 

• GetSubCurve3D 
Gets the subcurve between the specified points along the original curve and creates a new curve. The 
elements in the new subcurve are the same type and have the same properties as the elements of the original 
curve. 

 
I elationalOperator3D 
This interface provides a method to determine whether two z aware geometries intersect in 3D space.  
 

• Disjoint3D 
Determines whether two z aware geometries intersect one another in 3D space. Two geometries are disj
their intersection is em

xi ityOperator3D 
pro imity operators are used to find the 3D distance between two z a

. t t  the nearest point on another geometry

• QueryNearestPoint3
Queries the nearest point on a z aware g
segment extension, the nearest point can also be found on an extension of the geometry. 

 
• ReturnNearestPoint3D 

Finds and returns the nea
method of segment extension, the nearest point ca

 
• ReturnDistance3D 

Returns the minimum distance between two z aware geometries in 3D space. If the geometries intersect, the 
minimum distance is 0. Only returns the distance, and not the nearest points. 

 
ICurve3D 

 curve is an abstract one-dimensional geometry between specific From and To pA
s gle Segment, a Path of connected segments, or a Polycurve
and methods of the curve allow the user to query information about the entire curve or points along the curve. The 
distance along the curve can be specified in a fixed unit of measure or as a ratio of the Length of the curve. The user 
can obtain information about Tangents, Normals, Subcurves, and Points along the curve. 
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• IsClosed3D 

Indicates if 'from' and 'to' points (of each part) are identical. 
 

• Length3D 
Returns the 3D length of the entire curve. The length of the curve is the sum of the lengths along each 
parameterized Segment between vertices along the curve.  

 
• QueryPoint3D 

Returns the Point at a given 3D distance along the curve or extended curve. If the distance is less than the 
length of the curve, then the returned point is the point at that distance along the curve. If the distance is less 
than zero, or greater than the length of the curve, then the returned point is on the curve specified by the 
extension method. The distance may be specified as a fixed unit of measure or a ratio of the 3D length of the 
curve. 

 
• QueryPointAndDistance3D 

Finds the Point on the specified extended curve nearest to the input point and the distance between those 
points. Also returns information about the side of the curve the input point is on as well as the distance along 
the curve that the nearest point occurs. The operation is performed in 3D space. 

 
IPolycurve3D 

 polycurve is a collection of many curves that form a single curve. can be composed of single segments, 
onnected paths, closed rings, or a combination of various curve types. The paths and segments within a polycurve do 

no ath. 

ength (or less) 
that are within maxDeviation of the original polycurve. If maxDeviation = 0, maxDeviation is ignored and Line 

 length maxSegmentLength are constructed with vertices laying on the original curve. All of the 

 
• Generalize3D 

h part of a Polycurve into a generalized collection of Line segments. Generalize3D performs a 

 segments, the Generalized output is a subset of the original input 
vertices. For non-Linear segments, the Generalized output contains points along all parts of the curve, not 

es. 
 

• 
Converts the Polycurve into a Polycurve containing only BezierCurve segments. If the maxAllowableOffset 

gment of the input Polycurve becomes a separate Bezier curve. If 
 

e 
created BezierCurve polycurve is an approximation of the original polycurve. At each vertex, the adjoining 

mplementary tangents which creates a continuous (smooth) transition between 

 
• Weed3D 

ed Generalizes each part of a Polycurve into a generalized collection of z aware Line segments. Weed 

 
e 

olume 
Use
 

• 
 the bounded 3D area of a closed multipatch. 

A  A polycurve 
c

t need to be connected to each other. A polycurve may also contain a single segment or p
 

• Densify3D 
Converts Polycurve into a Polycurve composed of Line segments with 3D length maxSegmentL

segments with
segments in the final polyline will be 3D Lines. 

Generalizes eac
Douglas-Poiker Generalization algorithm, extended to operate in 3D space, with a specified maximum offset 
tolerance, given in 3D, as input. For Line

necessarily only the vertic

Smooth3D 

parameter is zero, each se
maxAllowableOffset if greater than zero, the polycurve is generalized first by the Douglas-Poiker method using
the maxAllowableOffset value. Bezier curves are then created for each of the remaining segments. Th

BezierCurves have co
segments. 

We
performs a Douglas-Poiker Generalization algorithm, extended to operate in 3D space, with a specified 
multiple of the internal tolerance given as input. For Line segments, the Generalized output is a subset of the
original input vertices. For non-Linear segments, the Generalized output contains points along all parts of th
curve, not necessarily only the vertices. 

 
IV

d to calculate volume. 

IVolume 
Returns
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ArcGIS Data Interoperability 

At 9.3 th n 
Engine  includes improvements to the existing software 
s well as new functionality for improved usability and productivity.  

 
 
Forma
 

e ArcGIS Data Interoperability extension has been updated to FME 2008, the latest Feature Manipulatio
(FME) developed by Safe Software. This new version of FME

a

ts and transformers 

The 
advanta e new rich geometry model in FME or have been updated to support the current version of the format. 

everal new formats have been added to Data Interoperability. New formats include Industry Foundation Class STEP 
File SS, Trimble JobXML, Autodesk 2007 (DWG/DXF) and Aeronautical Information 
Exchan
 
ArcGIS ench application that can be 

tilized in existing or new ETL (Extract, Transform and Load) processes.  

new release provides improved format support for existing formats; for example some formats now take 
ge of th

S
s (IFC), CityGML, LandXML, GeoR

ge Model (AIXM).  

Data Interoperability 9.3 includes 35+ additional transformers added to the Workb
u
 
 
Workbench improvements 
 
 Many usabilit cements have been made to the Workbench application, which is the graphical authoring 
env uild ArcGIS Data Interoperability ETL processes. A new Overview window lets you view your 
entire E
 

y enhan
ironment used to b

TL workspace at a glance and provides easy navigation to different parts of the workspace: 

 

ows displayed in the Workbench interface can now "float" independently of each other and the Workbench 
 frame: 

 
All wind
window
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The transformer gallery is also now customizable. You can create your own folders and store your favorite 
n share them with other users in your organization: transformers for quick access. These folders are saved so you ca

 

 
 
An "Update Feature Types" option has been added to easily update Source and Destination data schema. This is ve
helpful when data changes during or after the creation of a Spatial ETL tool. Using this option updates the entire 
workspace at once, rather than making the changes manually throughout the workspace: 

ry 

 

 
 
 
Other 
 

The Data Interoperability extension now includes an animated tutorial. 
 

At 9.3 we also introduce a new 'WFS to Feature Class' geoprocessing tool that lets you load features from OGC 
WFS directly into the geodatabase, and incorporate these steps into geoprocessing models and scripts. You can find 
this tool in the Conversion toolbox. It requires an ArcEditor or ArcInfo license. This tool does not use the Data 
Interoperability extension, and so does not require that the Data Interoperability extension is installed: 
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ArcGIS Geostatistical Analyst 

New tool for performing simulations 
 

A new Gaussian Geostatistical Simulations (GGS) geoprocessing tool has been added to the Geostatistical Analyst 
Toolbox. This tool creates surfaces that reproduce local variability better than the smoothed surfaces kriging produces.  

 
The GGS tool produces multiple surfaces that are all equally probable. These surfaces can be used in risk analysis 
(e.g. calculating the probability that an environmental threshold is exceeded) or as input to a model in order to evaluate 
variation in the model’s output (e.g. produce a distribution of economic results for a resource exploitation plan). The 
GGS tool is capable of performing conditional or unconditional simulation, creating predicted surfaces, and generating 
summary statistics for the entire region or for areas of specific interest.  
 
 
We have gone parallel! 
 

Several steps in the calculation of geostatistical layers can now take advantage of multiple CPUs in order t
crease performance. This enhancement includes all Kriging and Inverse Distance Weighting models that are created 

 Geostatistical Wizard, as well as cross-validation and the validate and predict functions for geostatistical 
dditionally, the following tools in the Geostatistical Analyst Toolbox take advantage of multiple-CPUs: GA 

a s. 

c

 

o 
in
within the
ayers. Al
L yer to Grid, GA Layer To Points, and Gaussian Geostatistical Simulation
 
In reased processing speed is most noticeable in complex models (e.g. involving data transformations, large 
neighborhoods, etc.), and in repeated use of the tools (as in models and scripts). For example moving window Kriging 
is 28 times faster. 
 
 
Other 

The Geostatistical Analyst tutorial now includes an animated tutorial. 
 

The Geostatistical Analyst extension is now fully supported by ArcGIS Server. 
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Input points Geostatistical model 

Geostatistical Simulation Interpolation 

Multiple surfaces that  
represent local variability 
better than kriging. 

ArcGIS 9.2 

ArcGIS 9.3 

One single smooth surface. 
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Maplex for ArcGIS 

ArcGIS 9.3 introduces new point, line and polygo
onflict resolution strategies. These enhancement

n label placement options, new label fitting strategies and also new 
s help to eliminate the need to convert labels to annotation and edit 

by

 

 

c
 hand. 

 

Label placement options 

Point placemen  Strike and dip labeling - Geological maps that display strike and dip symbols require the 
label to be ro  t g the Additional Rotation option, the user can rotate the label to match the 
rotation of the dip symbol: 
 

 
 

t options:
tated with he symbol. Usin

Line placement options: Street Addressing/Street Placement improvements - Labeling street addresses has been 
improved to account for missing address numbers an  the odd and even street addresses on the 
correct side of the street. Street placement has had l ed to place the label horizontally and centered 
on the street, to reduce the leading of the stacked labels that overrun the end of the street, and to place the primary 
name under the street ending when the label is stacked: 

 

d to also maintain
abeling options add

 

 
Contour labeling: Places the labels in ladders along the contour slopes. The user has the ability to align the labels 

to the page and also in an uphill direction: 
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River placement:
feature. In previous versions the label woul
along the centerline of a polygon representing a river. 

 This new line placement option curves the river label multiple times to fit the meandering river 
d curve only once with the feature. It can also be used to curve the label 

The spread characters option is available with this placement 
option: 
 

        
 

Polygon placement options: Fixed placement positioning (internal zones) - Places the labels in fixed zones within 
the polygon. In particular this option allows the placement of a label fixed in the center of a polygon or in the corner of 
a polygon. The user can rank the zones for placement and also block zones from having labels placed in them: 
 

 
 

External zones: Places the labels in zones around the polygon. The user can rank the zones for placement and 
ock zones from having labels placed in them: also bl

 

 
 

Boundary labeling: Has 
 

been enhanced to allow the repetition of labels along coincident boundaries of polygons: 

 
 

Minimum feature size: The minimum feature size property has been enhanced to include the option of area in 
addition to the existing length option. 
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Anchor points: You can now control where the anchor point for a leader line or callout snaps to the feature: 
 

 
Additional placement options: Label offset – There is now the option to specify that the offset be measured from 

the feature geometry or the symbology. This prevents overlap of labels and symbology for features. 
 

Align label to graticule: Allows horizontal labels to be aligned to the latitude graticules in the data frame: 
 

 
 
 
Label fitting strategies 
 

Control over placement strategy order: You can now control the order in which the label fitting strategies are 
attempted in label placement. In previous versions the Maplex Label Engine would attempt the strategies in the same 
order that they were presented on the dialog. 
 

Abbreviation truncation: The Abbreviation option has been enhanced to include the ability to truncate labels. This 
option will shorten a label that would otherwise go unplaced and place a full stop (.) at the end: 
 

 
 
 
Conflict resolution strategies 
 

Background label: The background label option has been changed to allow the style of a watermark. The labels 
from the label class will be drawn first and other labels will be allowed to draw overtop: 
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Label buffer hard constraint option: In previous versions the label buffer was only applied if space was available 
nd applying the buffer would not result in unplaced labels. With version 9.3 the hard constraint option has been added 

the class regardless of available space. 
a
to apply the label buffer to each label in 
 
 
Additional improvements 
 

East Asian vertical text placement: For fonts with vertical text metrics, the labels can now be displayed vertically. 
The CJK character orientation check box is available on the Symbol Selector dialog: 
 

 
 

Auto leadering of unplaced line and street labels: In crowded areas an unplaced label may be added to the map 
by placing it horizontally in an area of free space near the feature with a leader line connecting it to the feature. 
 

Support for holes in polygons when placing labels: When labeling polygons with holes Maplex will avoid the 
sland’ polygons and restrict the label to the polygon. ‘i

 
Map units and Page units

feature size, repeat labels alon
 added for measurement: Additional unit options have been added to the minimum 
g line, label overrun, and remove duplicates placement options. 

 
 

Documentation 
 

New 'Common Labeling Tasks' section in Desktop Help: This includes several key labeling scenarios with the 
steps for how to set them up.  
 

In the Desktop Help, see 'Extensi
 
 
Performance 
 

ons > Maplex > Common Labeling Tasks'. 

The drawing of text halos has been improved for both the Maplex label engine and the Standard label engine. 
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ArcGIS Network Analyst 

New vehicle routing problem (VRP) solver 
 

The vehicle routing problem solver provides the ability to generate routes for a fleet of vehicles. This solver assigns 
and sequences orders on routes, taking into consideration multiple constraints and objectives, such as time windows, 
ehicle capacities, route zones, and operating costs. This solver can be used to generate routing solutions for 

pickup/delivery, paratransit, or other applications that require optimizing the routes of multiple vehicles servicing a set 
of orders: 
 

v

 
 
 

For more information on the VRP solver, open the following ArcGIS Desktop Help topic: 'Extensions > Network 
Analyst > Performing network analysis > Solving a vehicle routing problem'. Also exercises 8 and 9 have been added 
to the Network Analyst tutorial to help you understand how to solve Vehicle Routing Problem scenarios. 
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New evaluators for network dataset attributes 
 

Function Evaluator 
The function evaluator is a new option for calculating network attribute values that exist among the constant, field, and 
VBScript evaluators. The function evaluator calculates values by performing a multiplicative or logical function on 

Fo

meter 

sed on the VehicleHeight attribute parameter.  

another attribute value and a parameter value.  
 

r numeric attribute types, the values are derived from an expression that multiplies the value of another attribute by 
a parameter or constant; for example: “DriveTime * 1.25” would slow drive-time values by a constant of 25 percent. For 
Boolean attribute types, the values are derived from an expression that compares an attribute value with a para
value; for example: “MaxHeight > VehicleHeight” could be used to restrict edges that a vehicle is too tall to safely 
traverse ba
 

Global Turn Delay Evaluator 
The global turn delay evaluator adds turn penalties to left, right, U-, and straight turns when a time-based cost attribute 
is used. It applies the penalties to all two-edge transitions that are not modeled by a turn feature. You can specify the 
amount of additional time to incur based on turn types, which are specified by the turn angle, the road classes of the 
from- and to-streets, and the street that is being crossed. The new Global Turn Delay Evaluator dialog box is shown 
below: 
 

 
 
 
New query builder for finding network locations 
 
With previous versions of Network Analyst, you could specify which source feature classes to search (for example, 

nly search roads and not metro lines) when you added or moved a network location. With ArcGIS Network Analyst 
.3, new functionality is available that lets you create a query expression to only search through a subset of features 

within the source feature class. So instead of finding any road feature, you can build a query so network locations are 
only associated with local roads or roads with certain speed limits. One of the benefits is that you can avoid placing 
network locations on non-traversable elements. 

o
9
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he query builder is accessed in the Analysis Layer PropertieT

c
s dialog box under the Network Locations tab by right-

li inding Network Locations panel and selecting Build Query. The Query Builder dialog box cking a source in the F
functions like the Select by Attributes dialog box. 
 
 
New geoprocessing functions 
 

Using Python scripts, you can get descriptive information about a particular network dataset or network analysis 
layer.  
 

Network Dataset properties - provides information about the network dataset that is used to model a 
transportation network, such as the type, attributes, and source feature classes of a network dataset. 

 

 
Network Analysis Layer properties - provides information about the inputs and parameters used in the analysis 
of a network problem, such as the name, impedance attribute, and search tolerance of the network analysis layer.
 

 A new tool, Make Vehicle Routing Problem Layer, helps solve vehicle routing problems in the geoprocessing 
framework. It is in the Analysis toolset of the Network Analyst Tools toolbox.  

 
 
Other 
 

The Network Analyst tutorial now includes an animated tutorial. The tutorial also has two new exercises for the VRP 
solver: Exercise 8, ‘Servicing a set of orders with a fleet of vehicles’, and Exercise 9, ‘Finding best routes to service a 
set of paired orders’. 
 

The OD Cost Matrix solver has been improved to solve at an order of magnitude faster than before. 
 

At 9.3 the Spatial Statistics toolbox includes a new Generate Network Spatial Weights analysis tool that generates a 
spatial weights matrix file modeling the spatial relationships among all the features in a network dataset. See the 
'Visualization and Analysis' chapter of this document for more information.  
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ArcGIS Publisher and ArcReader 

 Export ArcReader markups into ArcMap 
 in ArcReader so that they can be loaded into ArcMap. Markup tools were 

ng and adding notes and updates to maps, especially in the field when 
o o 

r in 
 to help you work with markups imported from ArcReader: 

You can now export ink markups created
dded into ArcReader at 9.2 for annotatia

w rking on Tablet PCs. With 9.3 your ArcReader users can create markups which can then be loaded into ArcMap s
that data can be edited to reflect the changes noted in the markup. Tools have been added into the Publisher toolba

rcMapA
 

 
 

 Enhanced markup tools in ArcReader 
h wn above at 

he
T e Markup toolbar in ArcReader has additional color and width options, and the same three controls sho

 right end of the Publisher toolbar for working with different markup graphics. t
 

Use your standard ArcMap address locators in ArcReader's Find dialog 
ArcReader users can now access standard address locators (file-based locators and locators stored in geodataba
in ArcReader when they use the Find dialog. This has been frequently reque

ses) 
sted so that your ArcReader users can 

work with same custom address locators that you use in ArcMap. The address locator is not added into the published 
map by the map publisher. Instead, ArcReader users can simply browse to the address locator they wish to use 
directly from the Find dialog, and ArcReader remembers which locator(s) they chose: 
 

 
 

Usability improvements in ArcReader 
It is now easier to access bookmarks in ArcReader: The bookmarks pullright has been moved out of the View pulldown 
menu and is now a separate Bookmarks pulldown menu. There is a new Clear Temporary Graphics command in 
ArcReader's Edit pulldown. This lets you delete graphics you have added to the map such as points representing 
places and addresses you have found with the Find dialog.  
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ArcGIS Schematics 

New Expand Links rule 
 

The new Expand Links rule takes an attribute from the original edge feature and uses that to determine how m
schematic link elements will be displayed on a diagram: 
 

any 

 
 
Layout Tasks 
 

The Square Links layout task has been enhanced to avoid overlaps and better handle situations where more than 4 
in

 

l ks connect to 1 node: 
 

The new Label Placement Optimizer algorithm has been added to help with the layout of schematic labels: 
 

Properties Form 

 

Schematics Configuration Designer 

With Rule Without Rule 

Geography Schematics 

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 166 



Schematic geoprocessing tools  
 

Five new geoprocessing tools have been added for working with Schematics: 
 

- Convert Diagram to Features – converts a schematic diagram into features 
s a schematic diagram 

- Update Diagrams – updates many diagrams at once based on certain criteria like folder location, time since last 

- Create Diagram – create
- Create Schematic Folder – creates a schematic folders 
-  Update Diagram – updates a single diagram 

update etc. 
 

 
 
 
Find Related Diagrams 
 

The new Find Related Diagrams tool allo
isting diagrams that contain that feature. 

ws you to select a feature in the map and then find out if there are already 
ex You can also select an element in an open diagram and find out if there are 
other diagrams that contain the same element: 
 

 
 
 
XML Builder 
  

The new XML Builder allows for diagram generation from XML files or XML streams. This allows for very open 
integration with outside systems. Data is presented to Schematics following the schematic XSD format, and 
Schematics then creates and displays the diagram. 
 
 
Improved layout algorithms 
 

New layout algorithm: Geo-Partial Overlapping Links. As shown in the figure below, this new layout algorithm is 
used when links are organized in a set of parallel routes and the offsets are too small, resulting in a lack of readability. 
(This enhancement was originally introduced in 9.2 Service Pack 3): 
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   Before After   
 

The Geo-Linear Dispatch la
diagrams, the layout is enhanc

yout algorithm has been enhanced by moving leaves with one link. To get the clearest 
ed to include the leaves having one link in the repositioning process. This function is 

seful to manage secondary networks in the field of water, gas and electrical distribution: (This enhancement was 
or
u

iginally introduced in 9.2 Service Pack 3): 
 

    
            Before      After (9.2)  After (starting at 9.2 SP3) 
 
 
Improved diagram to feature export  
 

When you export a schematic diagram as shapefiles or feature classes, it will now automatically export all the 
atures. Previously it only exported a small subset of attributes for Schematics to track internally. This 

 the exported diagram features back to the original geographic features to access other field 

Map 

attributes of the fe
lows you to linkal

information. (This enhancement was originally introduced in 9.2 Service Pack 4). 
 
 

orking with schematic diagrams in ArcW
 

As described in the 'Mapping' chap
tarting in 9.2 Service Pack 2 so that

ter of this document, the viewer windows introduced in 9.2 have been enhanced 
 you can use them to work with the contents of inactive data frames side-by-side 

n  

e displayed inside a viewer window: 

s
o -screen with the active data frame shown in the main ArcMap window. This enables you to work with a schematic
diagram side-by-side with the geography it represents without having to work in Layout view. In the example below, 
two schematic diagrams have been created to represent the features in the data frame called Geography shown in the 

ain ArcMap window. Each schematic is in its own separate data framm
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The Schematics commands and tools have been updated in 9.2 Service Pack 2 so that you can use them to perform 
operations on schematics displayed inside inactive data frames in viewer windows.  
 
To work with geography and a schematic side-by-side, first activate the data frame containing the data you want to see 
in a viewer window. Now choose the Viewer command from the Window pulldown menu to open a viewer window. 
Finally, activate the data frame you want to work with in the main ArcMap window. The viewer window you opened will 
remain on-screen, allowing you to work with both data frames.  
 

In the Desktop Help, see: Extensions > Schematics > Working with ArcGIS Schematics > Viewing schematic 
diagrams > Viewing schematic diagrams

ip: There are two shortcuts that make it easy to work with multiple data frames: CTRL + TAB switches between the 
ata frames making each one active in turn. (If you want to be able to do the same thing by pressing a button on-

and into any toolbar from the View category in the Tools > Customize 
 in the Table Of Contents activates that data frame. 

 in ArcMap. 
 
T
d
screen, add the Activate Next Data Frame comm

ialog). ALT + click on the name of a data framed
 
 
Other 
 

The Schematics extension is now fully supported by ArcGIS Server. 
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ArcGIS Spatial Analyst 

New Zonal Histogram 
 

The new Zonal Histogram command in Spatial Analyst in 9.3 is accessed from the Spatial Analyst toolbar. This is 
very useful as a data exploration and visualization tool. It allows you to investigate frequency/distribution of one 
dataset within classes of another dataset. For example, the distribution of slope values within Landuse classes, rainfall 
within elevation classes, or crime distribution by police beat. 
 

 
 
 
New Contour with Barriers tool 
 

Spatial Analyst and 3D Analyst have a new surface contouring tool in 9.3, the Contour with Barriers geoprocessing 

•  Smoother contours 

•  Write output directly to geodatabase 

tool. This tool compliments the Spline with Barriers tool added in 9.2 by allowing you to intelligently contour an 
interrupted surface. The Contour with Barriers tool has many advantages over the existing Contour tool: 

•  Intelligent default rendering 
•  Cartographic labeling with Maplex 
•  Honors barrier features, snaps contour geometry to the barrier 

•  No 2GB size limit  
 

 
 
 
Improved Spline with Barriers 
 

The Spline with Barriers tool has been updated in 9.3 by making the barrier feature class optional. Now you can use 
it without barriers as a smooth spline algorithm. We have also improved the tool validation and user experience, and 
improved performance by running it in-process. 
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New Snap Raster environment 
 

The Snap Raster setting is used to perfectly align raster outputs by anchoring the cell registration, and minimizes 
future resampling steps that could reduce data quality. At 9.2 it was part of the Extent control. At 9.3 it is its own 
environment setting, which provides greater flexibility in setting the environment dynamically from ModelBuilder or 

pts, it will continue to work, but we 

proved Extent parameter 

scripting: 
 

 
 
You can still use the old SnapRaster as part of Extent on the command line or in scri
recommend changing to use the new SnapRaster Environment 
 
 
Im
 

We have standardized on a common E
se it to set their extent to be the same as

xtent parameter throughout Spatial Analyst that allows all functions which 
 the extent of a layer or dataset. This helps to maintain the floating point 

r

  Raster 
•  
•  re
•  re
 

 
 
 
Performance improvements 
 
There have been several significant performance improvements in some of the Spatial Analyst algorithms. 

u
p ecision of the extent. The following tools have been updated: 
 
•  ExtractByRectangle 
• TopoTo

CreateConstantRaster 
C ateNormalRaster 
C ateRandomRaster 

 
The Combine tool is now 40 times faster. Running Combine on a dataset with 250 thousand combinations 

te in 1.5 minutes. Additionally the algorithm has been improved to now work on 
ents to Combine first appeared in 9.2 SP2. 

previously ran in 1 hr, now it will comple
millions of combinations. The improvem
 

The Fill tool is now 45 times faster. Previously running Fill on a 350 mb DEM with 2 million sinks would take 9.5 hrs, 
now it will complete in 12 minutes. 
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Improved large data processing 
 

Viewshed now works better on much larger input data, no more MSEEK fatal error. 
 

IDW has been enhanced to work with up to 50 million points. 
 

Combine now works on millions of combinations. 
 
 
Improved error messages and status 
 

Along with core geoprocessing framework improvements there has been significant work in Spatial Analyst on error 
messages and reporting of status. Now the Spatial Analyst can report multiple, cascading error messages, providing 
more insight into the root of a problem. And all error messages are documented and linked to the help system. 
Additional work has also been done to improve the reporting of progress during tool execution, such as the percent 
complete, and informative statements about what the software is currently doing. 
 
 

xtract Values to Points improvements E
 

The Extract Values to Points now honors the Spatial Reference and Extent environment settings. Data will be 
rojected if necessary. Previously a value of No Data was returnp ed if inputs had different projections. The output 
ature class will have the same Spatial Reference as the input features (or as specified in the environment setting). 

 get the correct cell value for a point (fixes a bug). During analysis, any internal 
correct cell value for a point. This fixes a bug due to the extent and cell size 

iff

ovements 

fe
Internal resampling now ensures you
resampling now ensures you get the 
d erences and the need to set the snap raster environment. Because of these changes, your results may differ from 
9.2, in such cases, the previous result was incorrect. 
 
 
Reclass By Table impr
 

When using a table as inpu
The From value field for dbf, IN

t to Reclass By Table, it is no longer necessary to have in the From Value field sorted. 
FO, geodatabase reclass tables can now be unsorted. Values should not overlap. Text 

e sorted in ascending order. file-based tables still need to b
 
 
Improved usability of Conditional Toolset 
 

The Expression parameter of the Con and Set Null tools has been mo
in the tool dialog, to clarify the relationship between the parameters.  
 

ved next to the input raster to which it applies, 

int raster. The input conditional raster to the Con tool can now be a floating po
 
 
Improved ModelBuilder experience for Overlay tools 
 

Weighted Overlay and Weighted Sum tools now set the output extent properties in a model without executing. This 
h as Extract By Rectangle, is populated with the extent. Additionally, the Load 
tool will now maintain connections in ModelBuilder wherever possible.  

O

means the next tool in the model, suc
able option of the Weighted Overlay t
 
 

ther enhancements 
 

The height of a line graphic added to ArcMap with the Create Contour tool in the Spatial Analyst toolbar is now 
tored in the Element Name field in the Size and Position tab of the graphic property dialog. In this way if you use the 

Co
ame attribute in the output 3D line feature class. 

s
nvert Graphics To Features command to convert these contours to line features, the height of each contour is 

automatically used to populate the N
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ArcGIS Survey Analyst 

New Cadastral Editor introduced with 9.2 Service Pack 3 
 

The goal of the Survey Analyst extension is to improve the spatial accuracy of GIS data and to provide information 
bout the accuracy of this data. At 9.2 Service Pack 3 we introduced a major enhancement to this extension: the 

w cadastral fabric data model, new workflows, and a completely 
ew set of cadastral tools. The Survey Analyst extension includes the existing Survey Editor, but now also includes the 

Ca

d tools 

The Cadastral Editor includes the functionality, standard data model, and common workflows you need for building 
a cadastral fabric). 

a IS. 
te 

a
Cadastral Editor. The Cadastral Editor introduces a ne
n

dastral Editor. 
 
- The Survey Editor is the same technology as was available at 9.2. The Survey Editor includes a set of focuse

for defining and maintaining accurately measured coordinates based on field observations from total station 
equipment. 

 
- 

and maintaining a cadastral land records system (
 
M ny geographic information systems use cadastral records to build the base map for the other layers within the G
Parcel and cadastral databases are built through coordinate geometry and plan data entry. The accurate coordina
data available from new technologies and techniques can be combined with recorded land descriptions to improve 
spatial accuracy in the geodatabase. The new Cadastral Editor provides a framework and data model for efficiently 
performing these workflows.  
 

The Survey Analyst product license covers both the existing Survey Editor and the new Cadastral Editor. They can 
e installed separately or together, and can also be ub sed separately or together as complementary survey 
chnologies. You will see the name of the editor(s) you install listed under the Survey Analyst entry in the Tools > 

 the Survey Analyst extension in that dialog enables whichever editors 
 both editors have been installed: 

te
Extensions dialog. Checking the box next to

ave been installed. In the example below,h
 

 
 

The Cadastral Editor work
continuous integrated surfac

s with a new type of parcel dataset, called a cadastral fabric. A cadastral fabric is a 
e of connected parcels, representing the complete survey record for an area of land.  

Di lit 

inal 
xample, connection lines across 

ads. Because each and every parcel is either linked or connected, a seamless network of connected parcel 

 
mensions in the cadastral fabric are edited in response to a change in the survey record, for example, a parcel sp

or resurvey. Parcel boundary line dimensions in the cadastral fabric match the dimensions on the survey record. 
Parcels that are edited or replaced by new survey records are retained as historic, thus always preserving the orig
survey record. Parcel polygons are also linked to each other by connection lines, for e
ro
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boundaries, or cadastral fabric, is formed. Parcel lines have endpoints, which are the parcel corners. Parcel corner 
blishing connectivity and maintaining topological integrity 

rangement that defines how point, line, and polygon features 
share coincident geometry. 
 

points are common between adjacent parcel boundaries, esta
in the network. In the geodatabase, topology is the ar

Cadastral fabrics are stored in feature datasets: 
 

 
 

he cadastral fabric acts as a basemap for overlying GIS feature classeT
a

s. Feature classes such as building polygons 
nd utility lines are constructed in relation to parcel boundaries. The result is that GIS features are correctly aligned 

with the cadastral fabric. 
 

Here are the key elements of the new cadastral technology: 
 
 Provides a base-map for pa-

 
rcels as recorded by cadastral surveyors through deeds and subdivisions. 

Extensible data model familiar to ArcGIS users.  
 
- Provides a COGO coverage equivalent in the geodatabase. 
 
- Tracks the lineage of parcels based on their legal record end & start dates. 
 
- Manage subsets of the data as cadastral jobs.  
 
- New set of interactive tools, including parcel construction tools: 
 

- Improves the spatial accuracy of the fabric by processing the legal record information from parcels using a least 
squares algorithm designed by surveyors.  

 
- Spatially update GIS feature layers that coincide with the fabric on demand. 
 
- 
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In the Desktop Help, see: Extensions > Survey Analyst > Cadastral Editor 
 

Cadastral Editor enhancements introduced at 9.3 
 

Performance has been improved in feature adjustment processing when using feature linked annotation.  
 

Improved performance when finishing a job, and the progress bar now better reflects the database activity when 
saving the changes when finishing the job.  
 

You can now over-write the bearing and distance values reported when using the connection tool, to make the 
values match the survey record.  
 

There is improved support for representing unclosed parcels, such as for representing street centerlines. 
 

The line point tools now report a perpendicular offset.  
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There is a new Point reporting tool on the Cadastral Editor toolbar that provides reporting on the cadastral fabric 
while working within a cadastral job. There are a few features in this tool. It provides scale factor and 
rgence values, based on the projection, at a point’s location. You can also get a bearing and distance between 

any 2 points in the cadastral job, and also a perpendicular offset from a point to a straight line, defined by any other 2 
points in the job: 

points 
conve

 

 
 

There is a new Parcel renaming tool that can be accessed through Tools -> Customize, and clicking the Cadastral 
category.  
 

Support for domains and subtypes is now implemented in the user interface editing environment.  
 

There is better support for NULL values in nullable fields when using the cadastral editing environment.  
 

The adjustment report text file has been improved so that units are explicitly stated for values reported on parcels.  
 

Extended attributes added to the lines fabric class are now editable in the lines grid.  
 

Parcel Explorer items are sorted by name.  
 

A new planarize method has been added to the Parcel Construction toolbar. If you have lines in your construction 
a   th t cross each other, you can use the planarize method to create a point and break the lines at their intersections.

 
There is improved graphical representation of break points and construction points.  

 
You can import traverse files saved using the Advanced editing toolbar traverse utility.  
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Importing of control points allows updating of existing control with new points coming in by name and/or by 
proximity: 
 

 
 

The importer now calculates a parcel’s legal area and provides a formatted text value in the StatedArea field based 
on your choice of units. 
 

There is a new context help button on parcel lines page, providing useful tips explaining how data can be entered 
very quickly by primarily using the numeric keypad.  
 

The control point dialog has a new Adjust button added providing another way to quickly launch the least squares 
adjustment, saving mouse-clicks.  
 

Appending a Cadastral XML file to an empty Cadastral Job will automatically join it to it’s control points, if there are 
control points in the file.  
 

You can activate Job tracking by adding an optional BLOB field called CommittedObjs to the Jobs table. This 
provides an audit trail on jobs after they have been committed.  
 

You can add a BLOB field called LocalControl to the Jobs table to make sure that control points continue to be 
as

d.  
sociated with unjoined parcels when you finish a job and are saving parcels in their unjoined state. This is an 

optional fiel
 

When joining parcels into the fabric, you can now join directly to control points.  
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ArcGIS Tracking Analyst 

Tracking Analyst enters the third dimension 
 

You can now display and analyze your real-time and historical data in 3D Analyst’s ArcGlobe using your favorite 
Tracking Analyst tools and commands. Make your analysis more immersive by using 3D models to symbolize your 
data. Keep tabs on your planes in the air, subway trains under ground, or automobiles on the roads. Using the 
Playback Manager you can pause and rewind time. 
 
The data in the ArcGlobe screenshot below was recorded from the Minneapolis airport, and shows flights arriving and 
departing. The current location is highlighted in red, but the path over the last 5 minutes is also visible: 
 

 
 
 

New Purge Rule support 
 
The purge rule defines how real-time data is stored in the geodatabase. Tracking Analyst stores real-time data 
completely in-memory in order to eliminate the performance bottleneck of reading and writing data to disk. In order to 
limit the maximum amount of memory consumed data must be removed, or purged, from the geodatabase periodically. 
The mechanism for specifying which data is removed and how often is called the purge rule. 
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the oldest records in the in-memory database, but now you 
ery entity you might be tracking. This is great for situations 

where you have thousands of separate tracks coming in and you want to see where they all currently are.  
 

 

You have always had the ability to purge a percentage of 
have the option to keep only the most recent record for ev

 
’s dynamic It

You can now accelerate your 2D Tracking Analyst data with dynamic display in ArcGIS Engine applications. 
Dynamic display support allows you to display more features on the screen while using less processing power. 
Dynamic display is not supported in ArcGIS Desktop applications. 
 
 
Real-time data statistics 
 

Developers should be sure to check out the new temporal statistics features in the Tracking Analyst API. Use the 
statistics to monitor data rates, total message counts, track counts, and connection status.  
 
 
Service actions now accessible to developers 
 

Service actions for the client can be accessed, edited and defined via ArcObjects, enabling developers to 
implement a control to interact with the actions directly from within the application.  The actions changes can take 
affect instantly and no longer require a restart of the application. 
 
 

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 179 



Server extension: ArcGIS Image Server 

ArcGIS Image Server 9.3 is a complete, enterprise imaging solution provided by ESRI. It allows you to manage and 
umes of raster data, and provide enterprise-wide access to the data from GIS, CAD, imaging, and 

eb applications. Unlike simply serving imagery as map services, ArcGIS Image Server lets you serve image services 
tha e 

lly 
ilable to end users.  

rcGIS Image Server 9.2 was first released in December 2006. Subsequent service packs were released to resolve 
nd improvements. ArcGIS Image Server 9.3 focuses on improved quality and better 
IS Server. It provides improved image service editing capabilities, performance, and 

n d 

process huge vol
W

t allow image processing and analysis operations to be performed directly by client applications. ArcGIS Imag
Server reduces data storage costs and manpower required for data processing and maintenance, and dramatica
shortens the time between image capture and making imagery ava
 
A
issues and to add new features a
ntegration with ArcMap and ArcGi
e hanced automation and developer features. This chapter describes the new key features and capabilities introduce
in ArcGIS Image Server 9.3. (Some of these features were added in 9.2 service packs). 
 

At 9.3 we have also introduced a new resource center for ArcGIS Image Server users and developers that brings 
s.esri.com/arcgisimageservertogether various useful resources from ESRI: http://resource

 
 

Integration with ArcGIS Server 9.3 

Image services in ArcGIS Server 9.3 
 

ArcGIS Server 9.2 was capable of serving different GIS services such as the map, globe, and geodata service. 
Typically a map service was authored using ArcMap, and then the map document (.mxd) was published using 
ArcCatalog or ArcGIS Server Manager. Image services are a new feature of ArcGIS Server 9.3 allowing you to publish 
single raster datasets or compiled image service definitions as image services using ArcCatalog or Server Manager. 
All ArcGIS supported raster datasets can be served, including TIFF, MrSID, IMG files, or a geodatabase raster 
dataset. Each raster dataset is published as one image service. It is now much easier to publish an image service from 
ArcGIS Server because you no longer have to create and publish the map document. You may still want to use a map 
document and publish a map service when you need to publish the image service and vector data, because you 
cannot publish vector data as an image service. 
 
Image services can be published with additional capabilities to serve them as Open Geospatial Consortium (OGC) 
web map services (WMS) or web coverage services (WCS). They can also be accessed using Simple Object Access 
Protocol (SOAP) and Representational State Transfer (REST) for mashups and Keyhole Markup Language (KML) 
support. Image services have inherited some of the features of ArcGIS Image Server 9.2, including the ability for the 
client to define the sampling method used during reprojection and a changeable compression used for the 
transmission of imagery. 
 
 
ArcGIS Image Server as an extension to ArcGIS Server 
 

In 9.3, ArcGIS Image Server is available as an extension to ArcGIS Server. Similar to ArcGIS Image Server 9.2, 
image service definitions are authored using the Image Service Definition Editor to create a compiled image service 
definition (.ISCDef). The ISCDef defines an image service consisting of large numbers of individual rasters and the 
processing to be applied to them on the fly. When using ArcGIS Image Server as an extension to ArcGIS Server, the 
.ISCDefs can be published as image services using ArcCatalog, or ArcGIS Server Manager. The process of publishing 
an .ISCDef is exactly the same as publishing a raster dataset and also has additional web capabilities such as WMS, 
WCS, REST and SOAP. 
 
ArcGIS Image Server is still available as a standalone server application for users who do not want to serve image 
data over the Web (e.g. WMS, WCS & REST) or require only direct connections to ArcMap or 3rd party GIS, CAD and 
imaging applications. 

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 180 



Integration with ArcGIS Desktop 9.3 

In 9.2, the use of imagery from ArcGIS Image Server, in any client application, required the installation of an ArcGIS 
Image Serve
se

s 

nnection using the RPC 
rotocol between the client and ArcGIS Image Server, bypassing ArcGIS Server. 

r client. With ArcGIS 9.3 (ArcGIS Desktop, ArcGIS Engine, ArcGIS Server), the capability to add image 
rvices as a raster dataset layer from ArcGIS Server has been added. You can connect to an image service served 

by ArcGIS Server using the Add Data dialog box. This is similar to connecting to other GIS Servers such as map 
services or WMS. These connections go through ArcGIS Server and can be Web (HTTP) or direct (DCOM) and can 
also make use of the ArcGIS Server security features. The separately installed Open Image Service button in 9.2 ha
been renamed to Add Image Server Connection. This is still available from the Customize dialog box, but no longer 
requires a separate install. This Add Image Server Connection button makes a direct co
p
 

Client: Connections to Image Service 
 

 
 
In ArcMap 9.2, the image service layer was a custom layer limited to one or three band 8-bit images and could not be 
used for any analysis or other processing. In ArcMap 9.3, image service layers have similar features to raster dataset
layers. The image service can have more than three bands and have higher bit depths (such as 16-bit multi-ban
satellite imagery). Additionally, image services used to serve elevation models can be directly used as an elevation 
source in ArcGlobe. 
 
 

 
d 

age Service Layer  Im
 

The image service layer has layer properties similar to raster dataset layers in ArcGIS. You can control all aspects 
of a image service layer using its properties. The Image Service Layer Properties dialog box has been redesigned to 
make it consistent with raster datasets.  
 
Source Tab: The Source tab displays the data source as ArcGIS Image Service. It shows the bounding extent of the 

ata along with its source and coordinate system: d
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Display Tab: The Display tab controls the display settings of a 
methods and other display effects such as transparency along with the comp

layer. It provides options for defining the resampling 
ression method for transmission. The 

resample during display method controls the resampling method performed by the server. The Cubic convolution 
method has been added (in 9.2 SP4): 
 

 
 
NOTE: The JPEG2000 transmission method has been removed as it was found to be of no benefit for small requests. 
 
Symbology Tab: The Symbology tab controls the rendering of the image service. Using this tab, you can change: 

 The renderer, which defines how a single-band or multi-band image will be displayed. 
 Band combinations, which define the band combinations transmitted by ArcGIS Image Server. 
 Stretch type, which defines how to stretch the pixel values along a histogram. 
 Gamma Stretch defines a non-linear enhancement that is very useful for the enhancement of satellite imagery. 

 

 
 
Mosaic Tab: When the source of an image service is an .ISCDef the Mosaic tab is added to the Layer Properties 
dialog box. It allows you to change the mosaic method used by ArcGIS Image Server: 
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Metadata Tab: When the source of an image service is an .ISCDef the Metadata tab is added to the Layer Propertie
dialog box. It enables access to the metadata information associated with the image service and each of the raster 
datasets within the image service. 
 

s 

Transmission of Pixel Values 
 

 

Support for the types of pixel values that can be transmitted has been improved. It is now possible for ArcGIS 
applications, such as ArcMap, to access an image service that has more than three bands and more than 8-bits. This 
allows image service layers to be used as the input to geoprocessing tools and image services that represent elevation 
to be used as surfaces in ArcGlobe. It also allows the source data can be exported, not just the rendered image.  
 
 
Export Formats 
 

Within ArcMap when you export data from an image service layer, you are presented with the standard ArcMap 
dialog box. The following export formats are supported: 

 TIFF – As uncompressed, JPEG (New  LZ77 
 JPEG 

 PNG 

 
One of the features of this export is the ability to clip the image to a graphic during export and include the spatial 
reference system in the TIFF header. The 9.2 ArcGIS Image Server client-based export is still available in the ArcGIS 
Image Server Developer Kit. 
 
 

Client Applications 

),

 JPEG 2000 

 GIF (New) 
 Grid (New) 
 Imagine (New) 
 BMP (New) 

Improvements have been made in the communication between the Client and Server, which has resulted in speed 
improvement of about 30% over the original version. 
 

Support for 3rd Party CAD and GIS applications to make direct connections to ArcGIS Image Server has remained, 
with the following additions and modifications: 

 AutoCAD – Version 2008 support has been added. Versions 2000 to 2008 are supported. Support for rotated 
views has also been added. 

and 

 GeoMedia – Professional 6 is supported 
 MapInfo – Support for versions 8.0 and 8.5. 

 
 

Tiled Rasters 

 Microstation – XM version support has been added. Versions 8.05 and 8.09 are supported. Rotated views 
high quality printing are also supported. 

When adding raster data to an image service definition, a new group of raster types called Tiled Rasters has been 
added, which enable large numbers of rasters to be referenced by a single record in the source table. Tiled Rasters 
can substantially speed up the addition and simplify the management of such datasets. Tiled Rasters are raster 
datasets that have been clipped to a grid, such as map sheets. The tiles can be butt-joined or overlapped. Partial tiles 
that do not cover the full extent are also allowed. The format of these raster datasets are any of the standard formats 
that ArcGIS Image Server supports.  
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Examples include SRTM, NAIP, DOQQ, and the product of a number of different data providers. In 9.2 these could be 
added, but each raster dataset was added as an individual record in the database which could make loading and 
compiling slower and difficult to mange. 

hen adding Tiled Rasters the tiling scheme and location of the images needs to be defined and a new tiled raster 
hat includes references to each of the files. Associated with a .TRDef is a 

es ArcGIS Image Server to quickly access any tile. Tiled 
Ra

 

 
W
definition (.TRDef ) file will be created t

RCDef, which is a compiled and optimized form that enabl.T
sters can also include overviews that may be included with the source raster datasets.  

 
The limitations to Tiled Rasters are that only one set of metadata can be associated with a set of tiles. All tiles must be 
of the same format and the pixels must align when mosaicked together. 
 
 

Raster Types

Raster types define how imagery with associated metadata is imported into ArcGIS Image Server.  
 

Th ypes have been added at 9.3: e following t
 

he *.jpx extension. 
led QuickBird Standard. 
Socet Set - SUP with standard frame and RPC sensors. 

 

00 - T JPEG 20
 QuickBird - Ti
 BAE Systems 

S  types has been improved at 9.3: u wingpport for the follo
 

 Intergraph ISAT - Support for importing project files created by TerraShare has been improved. 
 

The following types were added in 9.2 Service Pack 4: 
 

 Landsat-7 1G - The Fast format (*.mtl.fst). Previously only the orthorectified format (.met) was supported. 
w. 

 for V5 project files has been added. 

 

 SPOT - Support of Level 2A and SPOT Ortho Vie
 Inpho Match-AT - Support

 

Raster Formats 

Raster formats define how the pixels from a raster dataset are read.  
 

The following format has been added at 9.3:  
 

he higher dynamic range required by newer sensors, while 
ich is fast to read and provides good compression. Although the 

lf of JPEG 2000, it can be read much faster. 

 TIFF12 - This is a version of TIFF that stores the data as JPEG compressed using 12-bits per channel. The 
advantage of TIFF12 is that it maintains t
compressing the imagery using JPEG, wh
compression quality of JPEG is only about ha

 
Support for the following format has been improved at 9.3: 

e speed of reading JPEG 2000 has been substantially improved. 
 
NO

 
 JPEG 2000 - Th

TE: ECW is still not allowed as a raster format in ArcGIS Image Server or ArcGIS Server. This is a restriction 
placed by Leica on use of this proprietary format by 3rd party server applications. 
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Image Service Definition Editor 

The authoring of image services has been improved using the revised Image Service Definition Editor. 
 
 
Toolbar 
 

The toolbar has been renamed to Image Service Definition Editor and provides access to some new features, such 
as the Edit Raster Properties Wizard: 
 

 
 
 
Ima eg  Service Definition Layer 
 

The menu options in the image service definition layer have been updated to provide access to new features for 
nes as described below: recomputing footprints and seamli
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Preview Layer 
 

The Preview Layer is added as part of the image service definition group layer as long as the image service has 
d it is no 

nger necessary to run Build to add it. 
been built and contains a boundary. When adding an .ISDef to ArcMap, the Preview layer will appear an
lo
 

The prev
eflected in

iew has become more responsive to changes, therefore, when altering or adding processes they will be 
 the preview without having to close the dialog box. 

uild 

r
 
 
B
 

The Build dialog has been updated with the following: 
 

 The default build options update to reflect those options that are likely to be required. 
 Additional validations of the image service definition are performed that can often resolve common issues. 
 Generate derived images – This option is used to create derived images such as service overviews. This has 

been improved to better handle very larger datasets. Partial pyramiding support has been added. This is 
synonymous to partial pyramid construction in ArcSDE. If new rasters are added or if the processing 
parameters are changed, the service overviews affected by the changes will be regenerated. A Derive Image 
Tool has also been added as part of the automation components of the Developer kit that can be used to 
speed up the creation of derived tiles. (Added in 9.2 SP4). 

 Compute average image spacing – This is no longer an option, but is automatically computed as part of 
Compute output pixel properties. 

 Validate raster sources – Improvements have been made in its detection and reporting of potential issues. 
 Compile option – This has been added to the Build dialog box. It enables you to build and compile an image 

service definition in a single step. The compile will run as a background process, hence, the ArcMap user 
interface is not locked and lets you preview or work on other image service definitions.(Added in 9.2 SP4). 

 
 
Compile 
 

When changes are made to an image service definition, it is necessary to recompile it prior to publishing. Although 
en 

 
Edit Raster Properties Wizard 
 

this process was fast in 9.2, it took a long time for services with thousands of images. The compilation speed has be
increased by a factor of about 10x. (Added in 9.2 SP4). 
 

Edit Raster Properties is a new option using a wizard that enables the properties of multiple raster process 
definitions (.RPDefs) to be edited simultaneously: 
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In 9.2, there was no
dited individually or by usi

 simple method to edit parameters in multiple raster process definitions. Each raster had to be 
ng 3rd party editing tools to search and replace text in the .RPDef XMLs. In 9.3, the Edit 

o: 

 Change the properties of rasters such a NoData values, transparency settings, or edit the minimum and 

tion at a specific level in the process chain. 
rs. 

ronize Raster Dataset 
 

e
Raster Properties Wizard can be used to modify specific aspects of all the rasters or a selection set. It can be used t
 

 Change the path to the location of the raster datasets. 

maximum pixel sizes. 
 Add a process such as convolution filter or band extrac
 Search and replace specific XML nodes in a selection of raste

 
 

ynchS

The raster process definition (.RPDef) files define the source of a raster dataset as well as the metadata and the 
proc  recommended that you 
use es) 
info a
 
 
Defini
 

essing to be applied. You may wish to use the same .RPDefs in other image services. It is
the synchronize raster dataset option to update the .RPDef files with any updated footprint or attribute (pixel siz
rm tion in the service table. 

ng Service Overviews 

The  
serv  edges 
of a r
 
 
Re
 

definition of service overviews has been improved (9.2 SP4). Service overviews can now be clipped by the
ice boundary. This reduces the possibility of compression artifacts on the edges of services and enables the 
 se vice to be fully transparent when image services overlap with other data, for example in ArcGlobe.  

compute Footprint 

All ra
at are not to be seen such as the marginalia on scanned sheets or frames from scanned aerial imagery can be easily 

lipping the raster based on their footprint geometry is much more efficient than the more traditional 
editing the rasters to set NoData values or defining a separate image mask. This is especially true when 

si

there were no automated methods to recompute the footprint. 
t 9.3 new automated methods of recomputing the footprint have been added: 

ad been previously reprojected or mosaicked together along irregular features 
such as pipeline, has borders of NoData pixels. Using the Recompute footprint by Radiometry feature, the image is 

By Geometry: Typically when orthorectifying satellite or aerial imagery, the footprints provided as part of the 
metadata are inaccurate, especially in mountainous areas. This can result in NoData values appearing near the 
edge of images. The Recompute Footprint by Geometry feature can be used to accurately determine the extents of 
such imagery. If footprints have been modified or the geometry of the raster has changed due to an added geometric 
process, the recompute footprint by geometry feature can be used to reset the footprints to their correct extents. 
 
By Related Geometry: When images are rotated or reprojected prior to being added to ArcGIS Image Server, 
NoData areas are often created along the edges of the images. Instead of analyzing the pixels using Recompute 
Footprint By Radiometry method to determine the extents the geometry, if a shap file exists that defines the revised 
footprints they can now be imported. The Recompute Footprint By Related Geometry enables the geometry from a 
shapefile, which has been linked to the service table, to be extracted and used as the footprint. 
 
By Clipping to Boundary: The Clip Footprint to Boundary feature enables the extents of a service to be quickly 
modified to exclude unwanted areas. When a service is created the boundary of the service is generated as the 
extent of all imagery. This boundary polygon can be easily edited to define only the required areas and then using 
this feature, all or selected footprints are clipped to the boundary. 

 

sters within ArcGIS Image Server are clipped to their footprints. By modifying the footprint, parts of a raster 
th
excluded. C
methods of 
u ng overlapping images.  
 
The default footprint for a raster is defined when the raster is added and is determined from the metadata of the raster 
type. At 9.2, the footprints could be edited manually, but 
A
 

By Radiometry: Often imagery that h

analyzed and the footprint shape is modified to lie just outside the NoData areas. 
 

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 187 



Seamline generation 
 

With ArcGIS Image Server, seamlines are used to blend together multiple images along irregular lines with the 
option of feathering, which smoothes the transition. Such seamlines are generally used to create a seamless image 
serv  
com on
boun a and then 
man l

ice from overlapping imagery. Typically seamlines should be defined in built-up areas along the roads or other 
m  terrain features. Similar to a footprint, seamlines are defined as polygons where the blend occurs at the 

ry of the polygon. In Arcd GIS Image Server 9.2, seamlines can be created by exporting the footprints 
ua ly editing the seamlines. Seamlines can also be imported from another source by overwriting the seamline 

sha
 

pefile: 

 
 
In 9.3, a new seamline generation feature has been added that automates the process of determining the optim
location for seamlines between overlapping images. The process works by analyzing the imagery to determine the 
optimum location for a seam

um 

line, such that the transition is least noticeable. This process can greatly reduce the time 
ken to create such seamless image services. 

 how much feathering is required 
etween the images. For imagery that is not orientated North/South or East/West, the general orientation of the 

im
 

ta
 
Seamlines can be generated for the complete service or for selected rasters. The seamline generation process takes 
input parameters that define to what detail the seamlines should be created and
b

agery can also be defined to optimize the process: 
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The seamline mosaic proce
.3, the blending has been improve

ss has also been improved. In 9.2, artifacts could occur if seamlines were butt-joined. In 
d to correctly handle butt-joined seamline polygons. The output of the Seamline 

e
s, 

e 

Other Image Service Definition Editor improvements 
 

 Save As – Now works with selection sets, enabling extracts of an image service definiton to be easily created. 
 Remove Raster Datasets – Now prompts for parts of an image service definition that need to be removed, 

such as the derived images or raster process definitions. This makes it easier to delete the derived image files 
without removing their definitions. 

 Apply button – When changes are made to a raster process definition an apply button enables the changes to 
be directly seen without closing the dialog box. (9.2 SP4). 

 Variable support – The support for variables in raster process definitions has been improved, which enables 
the use of templates that simplifies data management in advanced workflows. (9.2 SP2). 

 Linked tables – Attributes and variables used within image service definitions can be imported from linked 
tables enabling better integration to existing database tables. 

 
 

Processes 

9
G neration process is also butt-joined polygons that are simpler to visualize and edit than the previously used 
overlapping polygons. Overlapping polygons are still supported and are useful when using seamlines to exclude area
such as clouds. 
 
NOTE: In ArcGIS Image Server 9.3, the licensing has been changed to include the seamline feature as part of the cor
ArcGIS Image Server product. 
 
 

One of the many advantages of ArcGIS Image Server is the ability to apply processing to a raster dataset on the 
r while they are being accessed. The following improvements have been made to the processes: 

defined using the Developer Kit.  (9.2 SP5). 
 

efine what datum transformation should be applied in cases 
where the service definition and the client request are in different datums. (9.2 SP3). 

 
The Developer Kit has also been expanded to enable 3rd party developers to add their own processes (see below). 
 
 

Server Manager 

serve
 

 Orthorectification – The orthorectification process, previously part of a separate extension to ArcGIS Image 
Server, has been incorporated into the core product. Therefore no separate license is required for 
orthorectification. Orthorectification of imagery can be performed using the standard frame and RPC sensor 
models or using custom sensor models 

 Cubic convolution – This sampling method has been added and can be set by the client application. (9.2 SP4).
 Adaptive stretching – The Stretch process can take values derived from the histogram of the request as 

parameters. This enables dynamic range adjustment depending on the AOI. (9.2 SP4). 
 Datum transformation – It is now possible to d

In 9.3, it is not necessary to use ArcGIS Image Server Manager to publish .ISCDefs, because this can be done in the 
ArcGIS Server Manager. Serving .ISCDefs as image services using ArcGIS Server has the advantage of providing 
extensive web capabilities, such as access by OGC WMS, WCS as well as through a REST API and SOAP. 
 
The ArcGIS Image Server Manager ha been revised and can be used by users who require only direct ArcGIS Image 
Server connections. The ArcGIS Image Server Manager enables control of the distribution of services over multiple 
service providers, and provides detailed statistics on the number and size of the requests made to each service and 
service provider. 
 
 

s 
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ArcGIS Image Server Developer Kit 

ArcGIS Image Server is designed to be open, thereby enabling developers to expand its functionality and integrate 
different applications. The Developer Kit is included in the install media and has been enhanced at 9.3: 

rameters and metadata. The documentation on 

 
Ra r
 
The cap
rast fo
for A
 
 
Pro

 custom interface has been added for developers to write their own processes (9.2 SP4). Such processes can be 
pplied on all pixels as they pass through the server. The samples provided include the Sultans process that aids in 

 

ock Multi-image tool is a sample client application that enables users to view an attribute table of all the raster dataset 
in th
individu ons. The 
source 
extract 
 
 
Clie
 
The r 

rocessi

s 
been improved. It is now possible for the client application to directly request images to be streamed in 
different formats such as JPEG and PNG. Image masks used to define transparent pixels beyond the footprint 

. 
sing – Developers can add additional service processes to the .ISRef XMLs, which are 

used to make a direct image service connection. This enables additional requests, such as computation of an 

ible for 
the client to return the footprint and seamlines for a specified client request. (Added in 9.2 SP4). 

for imagery can also be made through ArcGIS Server as WMS, WCS, using a REST API, and using 
OAP requests. For SOAP and REST properties such as mosaic method and compression for transmission can be 
ontrolled. 

 
 

aster types R
 
Raster types are used to add data sources by defining processing pa

ow to create such raster types has been improved. h
 

ste  formats 

ability for developers to add their own readers for proprietary pixel formats has been added (9.2 SP4). Such 
er rmats can be added by using GDAL drivers or by using custom raster formats that are optimized specifically 

IS Image Server. rcG

cesses 
 
A
a
classification. 
 

Lock Multi-image tool 
 
L

e image service that are contained within the display extent, and choose the rasters datasets that will be added 
ally into a group layer in the table of contents. The user can also export the footprint or mosaic polyg
code for the application is included and can be used to assist developers in writing clients to view imagery or 
metadata. 

nts 

 client connection allows applications to make requests to ArcGIS Image Server to extract imagery for display o
ng. Improvements made to the clients include: p

 
 Access to additional codecs – The codec used to transform the request prior to transmission to the client ha

can also be returned
 Client defined proces

NDVI, to be made directly from multispectral image services without the need to make additional image 
services. (Added in 9.2 SP4). 

 Improved metadata – The metadata returned to a client application has been improved. It is now poss

 Linux and Solaris – Versions of the client library exist that can be used from Linux and Solaris applications as 
used by ArcGIS Server. 

 
NOTE: Requests 
S
c

 WHAT'S NEW IN ARCGIS 9.3 - PAGE 190 



Derive Images tool 
 
The Derive Images tool has been added to aid in automation. It enables users to create a list of all derived images 

 
allel to the 

erver, enabling the full power of the server to create the required images rapidly. This tool can be used to increase 
e speed at which all types of derived images can be created. 

Commands are calls that can be made by developers using API calls or by using the ISCommand scripting engine to 
utomate tasks of authoring or publishing image service definitions. A number of new ISCommands are added in 9.3 

ws: 

yRadiometry – Recomputes footprint by radiometry 
 GenerateSeamlines – Generates seamlines 

sterHistogram – Creates a histogram for specified areas 
 ServerManager – Functions to publish, start and stop services 

 GenerateDIDef – Generate DIDef file from image service definition 
 GenerateDerivedImages  – Create derived images based on a DIDef file. 

from an image service definition. The derived images can be service overviews, derived tiles, or derived rasters that
need to be generated for an image service. The tool then allows multiple requests to be submitted in par
s
th
 
 
ISCommands 
 
IS
a
and they are as follo
 

 ClipToBoundary – Clips footprints to a boundary 
 ComputeFootprintByGeometry – Recomputes footprint by geometry 
 ComputeFootprintB

 GenRa

 EditRasterDatasets – Edits multiple raster process definition files 
 TestPerformance – For automation of performance testing 

 
 

General Improvements 

The following are some general improvements that have been made to ArcGIS Image Server in 9.3: 
 

 64-bit OS Compatibility – All components of ArcGIS Image Server will work on 64-bit Windows operating 
stems. Though it should be noted that there is no added benefit in running 32-bit ArcGIS Image Server 
plication on a 64-bit operating system. It is very conservative in its memory use and 2GB of memory per 

system. 

 

 cGIS 9.3, the licensing model has changed and is now based on the total number of 

sy
ap
service provider is sufficient even when using many large services. (Added in 9.2 SP3). 

 Vista compatibility – All components of ArcGIS Image Server will work on the Windows Vista operating 

 Linux and Solaris – Although the Server and Service Provider works on Windows based operating system, the
Image Server client that is used within ArcGIS Server will work on Linux and Solaris operating systems. 

Licensing – As with Ar
cores on which the service provider runs versus the number of sockets. (Added in 9.2 SP4). 
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Summary of map navigation shortcuts in ArcMap 

Panning  
Click mouse wheel: Center map at location you clicked 
Hold down mouse wheel: Pan map 

Hold down  Temporarily switch to Pan tool. Single click centers. Drag pans 

 
Page map left / right / up / down 

 
Scroll map left / right / up / down 

S g on you clicked in le-click with any pan tool: Center map at locati
 

Z oo ming  
R ll irection can be customized in Tools>Options dialog. o mouse wheel: Zoom in / out. D
C RT L + roll mouse wheel: Zoom in / out at finer rate 
C R n you clicked T L + click mouse wheel: Center map and zoom in at locatio

C RT L + drag mouse wheel: Zoom in on box you define 

H ld  Temporarily switch to Zoom In or Zoomo  down  or  Out tool 

H ld  
Temporarily switch to Continuous Zoom / Pan

o  down 
 tool. Drag up / down 

with left mouse button to zoom in / out. Right mouse button pans 

 
Zoom out / in 

 
Other  
Right-click map in Data View: Access new context menu of shortcuts to commands 
Hold down SHIFT while in 
L o

Apply map navigation with mouse wheel, Z X C B keys, or 
ay ut view: Continuous Zoom/Pan tool to data frame instead of layout page 

 Put keyboard focus onto map from Table Of Contents 

 Put keyboard focus onto Table Of Contents from map 

 Refresh map 

 Toggle between Zoom In, Zoom Out, & Pan tools when one is active 

 Toggle Pause Drawing mode 

 Activate selected data frame in Table Of Contents 

 Full extent 

 Previous extent / next extent 

CTRL + TAB: Switches between data frames when there is more than one 
CTRL + click check box in TOC: Turn all layers on and off 
ALT + click check box in TOC: Turn this layer on and all others off  *New* 
ALT + click layer name in TOC: Zoom to this layer's extent  
ALT + click data frame in TOC: Activate this data frame 
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Summary of ArcMap table window shortcuts 
  
Opening and closing tables 

C r table able window for the layer or table you clicked in Table Of Contents. 
CTR  e window for currently selected layer/table(s) in Table Of Contents.  
C tab  window  
CTRL + SHIFT + T  Toggle all tables between displayed and minimized state (show/hide all). 
CTRL + SHIFT + TAB   ou currently have open.  
CTRL + SHIFT + F4  Close all currently open tables.  

 

Working with fields 
Right-click fi d name Get context menu of field commands. 
C ng it in the Layer Properties Fields tab. 
CTRL H
C T + double-click  Hide this field (same as dragging its column so it has no width). 
D r  
C New* 
A e *Ne  for field (lets you set the alias, number format, etc). 
C
C *New on/off for all fields in the table. 
CTRL + SHIFT + N *New* Toggle showing aliases on/off for all fields in the table. 
C T *N w* ld. 
CTRL + SHIFT + G *New* 

 
Navigating around a map fro

Right-cli k grey cell Get context menu of navigation and other commands. 
D lick grey cell Zoom to this feature and select it exclusively. 
C
C
C
C
CTR  + I 
CTR  + SHIFT + = 
 

Navigating around inside a ta

TRL + double-click layer o
L + T or CTRL + ENTER 

Open t
Open tabl

TRL + T in le Minimizes the window.  

Toggles between the tables y

el
TRL + double-click field name 

+  *New* 
Turn field off. Same as unchecki
Turn the current field off. 

TRL + SHIF
ouble-click column divide
TRL + SHIFT + A *

Reveals hidden field if the divider is next to a hidden field.  
Run Options > Restore Default Column Width command. 

LT + double-click field nam w* Open properties dialog
TRL + SHIFT + P *New* Open properties dialog for the current field. 
TRL + right-click field name * Toggle showing aliases 

TRL + SHIF  + F e Open Field Calculator dialog for the current fie
Open Calculate Geometry dialog for the current field. 

m a table 
c

ouble-c
TRL + double-click grey cell  
TRL + 8  

Pan to this feature and select it exclusively. 
Flash current feature. 

TRL + =  
TRL + P 

Zoom to current feature. 
Pan to current feature. 

L
L

Identify the current record. 
Zoom to selected features. 

ble 
  Go left or right. Wrap back to start of same record at end of row. 
 or NTER  E Go to the cell below. 
 or + ENTER  

HOME or END urrent row. 
CTR  +

SHIFT Go to the cell above. 
Go to the first or last cell in the c

L   or  Go to the first or last cell in the current row. 
TAB  to the right. Wraps around to next record below at end of row. 
SHIFT + TAB   cell to the left. Wraps around to next record above at start of row. 
CTRL +

  Go to the cell
Go to the

  or  Go to the first or last cell in the current column. 
CTR  or END 
C
C    
A

L + OME
TRL + F  

 H Go to first cell in first row or last row in last row.  
Launch Find dialog. 

TRL + G Go to a record number.
pplication key  Open the row context menu.  

CTRL + Application key  Open the Options menu. 
R
 

ight-click bottom part of table Open the Options menu. 
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Copying data from a table 
CTRL + C or CTRL + INSERT  Copy the value in the current cell to clipboard. 

Copy selected records to clipboard. 

S
 Z. Double-click again to sort Z - A. 

 field name *New
*  

ew*  vanced Sorting dialog and set all to <None>. 
 

cting records 
rd if it is already selected). 

lick. 
AR or

CTRL + SHIFT + C 
 
orting records 
Double-click field name Sort on table on field A -
SHIFT + double-click * Opens Advanced Sorting dialog so you can sort table on up to 4 fields. 
CTRL + SHIFT + S *New Opens Advanced Sorting dialog. 
CTRL + SHIFT + U *N Unsort a sorted table (or open Ad

Selecting and unsele
CTRL + click on a reco Add it to the selected set (or remove it 
SHIFT + click on a record Extend the selection from currently selected record(s) to the record you c

  or  Make block selection. SHIFT + SPACEB
CTRL + TAB  Switch between Show All Records and Show Selected Records mode. 

hts if in Show 
 + SPACEBAR. 

ed Records mode. 
egan on if it was 
ecting each record. 

  d Records). 
SHIFT + click top left corner  Select all records. 

lection. 
E  

 
E  table 

IFT + E 
gain to finish editing cell. 

SC Cancels editing the current cell and restores the original value. 
ish editing cell and go down to the next cell below in same field. 

TAB cord. 
row.  

C elects the next record too so you can see it on map.  
ERT  urrent cell.  

L + Y 
L + D 

E *New* 

 

SPACEBAR Select or unselect the current record (highlights or unhighlig
Selected Records Mode). In editing mode shortcut is CTRL

BACKSPACE Unselect the current record. (Works in editing mode if not editing a value). 
CTRL + SHIFT + R *New* Reselect highlighted records in Show Select
CTRL + ENTER Go to next record and select it. Unselects the one you b

selected. Lets you work sequentially through a table sel
CTRL + SHIFT + ENTER  Go the previous record and select it. 
Click top left corner of table Clear the selected set (highlighted set in Show Selecte

CTRL + click top left corner Switch se
CTRL + BACKSPAC Clear the selected set. 
CTRL + A Select all records. 
CTRL + SHIFT + A Clear the selected set. 
CTRL + U Switch selection. 

diting the data in a
CTRL + SH Start or stop editing . 
F2 Edit contents of current cell. Press a
E
ENTER Fin

Finish editing cell and go across to next cell to the right in same re
 record below when you get to the end of the Wraps around to next

TRL + ENTER Same as ENTER but s
IFT + INSCTRL + V or SH Paste the contents of the clipboard into the c

 CTRCTRL + Z and Undo/Redo edits to a record. 
E or CTRDELET Delete currently selected record(s). *CTRL + D changed from 9.2* 

CTRL + DELET Delete currently highlighted record(s) in Show Selected Records mode. 
 editing it (for example, to SHIFT + ENTER Inserts a line feed into a text string when you are

use as stacked text for labeling or annotation).  
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